Ecommerce Templates

User Manual

Version 6.0 – July 2010

© Ecommerce Templates – July 2010
# Table of Contents

Chapter 1  
Getting Started and Security Issues  3

Chapter 2  
Admin Settings, Multi-languages and Payment Providers  28

Chapter 3  
Categories, Products, Product Options and Discounts  54

Chapter 4  
Admin Orders, Affiliates, Dropship and Customer Login  82

Chapter 5  
Shipping Methods  109

Chapter 6  
Design Issues, CSS, CSS Menus, CMS, Tabbed Panels  125

Chapter 7  
Tweaks, Cross selling, Product Reviews, Gift Registry  187

Chapter 8  
F.A.Q. and Troubleshooting  206

Chapter 9  
Search engine information  220
Chapter 1
Getting Started

Welcome
Requirements
Installing the template
Opening the template in Dreamweaver
Opening the template in Frontpage
Opening the template in Adobe GoLive
Opening the template in Expression Web
Using an FTP program to upload your store
Using Dreamweaver to upload your store
Publishing your store via Frontpage
Making the database connection
  ASP version
  PHP version
Files and folders
Security Issues
Welcome

Thank you for purchasing our ecommerce template software. Our shopping cart software is designed to get your store up and running with minimum cost and hassle whilst providing a powerful solution to your ecommerce needs.

We have tried to do as much as the work for you, through the design, payment processor integration, shipping options etc. which will leave you to personalize the store, add your categories and products and get up and selling as soon as possible.

Please take time to read through the notes provided here to get the most out of your online store. Please also pay particular attention to the security issues involved with running an online store and contact us if you have any concerns.
Requirements

You will require one of the following HTML editors:

- Macromedia Dreamweaver 3 or above
- Microsoft Frontpage 2000, 2002 or 2003
- Adobe GoLive 5, 6 or CS
- Expression Web
- The CSS and Generic versions can be edited in the program of your choice.

You will need a hosting company where your store will reside; the minimum requirements are as follows:

**ASP version**

- Microsoft Windows Server
- Support of ASP pages
- Database (Access)
- ASUpload for image upload
- ASPEncrypt for offline credit card processing (Capture card method only)

**PHP Version**

- Unix / Linux Server
- Support PHP version 4.1 or above
- MySQL Database
- Mcrypt for offline credit card processing (Capture card method only)
- cURL component installed for UPS shipping
Installing the Template

You should have downloaded a .zip file to your hard drive following purchase; this will be the id of the template you have purchased with the .zip extension e.g. 0003fe00bkg0021.zip

Double click on the file to unzip the content to where you would like to work from on your hard drive

**Note**

We strongly recommend that you keep the .zip file in a safe place in case you need to run it again at a later date and to prevent loss of data in the event of a computer crash.
Opening the Template in Dreamweaver

In Dreamweaver you must define the site before making any changes to the template. Please note, there are slight variations between the different Dreamweaver versions, but the basic principle remains the same.

1. Open Dreamweaver
2. Select Site
3. Click on New Site

4. Ensure the **Advanced Tab** and in the **Site Name Section** give the template site a name

5. In the **Local Root Folder Section** and select the yellow folder to browse to the folder you extracted the template to.
To get started you won't need to fill in any other information. Click on **Done**

Please see our tutorial here [www.ecommercetemplates.com/tutorials/](http://www.ecommercetemplates.com/tutorials/) for more help and other versions.
Opening your Template in Frontpage

1. **Open** FrontPage
2. **Select** File
3. **Choose** Open Web
4. **Browse** to the location where you extracted your ecommerce template

**NOTE**

We would strongly recommend you following the above instructions whenever you edit the template in FrontPage as this will open the complete site. If you choose File > Open, this will only open one individual file and when you make changes such as changing the location of a Hyperlink it will not establish the Cache for the whole site.

Please see our tutorial here [www.ecommercetemplates.com/tutorials/](http://www.ecommercetemplates.com/tutorials/) for more help and other versions.
Opening the Template in Adobe GoLive

1. **Open** Adobe GoLive
2. **Select** File
3. **Choose** Open
4. **Browse** to the location where you extracted your ecommerce template

![Adobe GoLive - untitled.html](image)

5. Locate the .site file

![Open Document](image)

6. This will open the list of files and folders that make up your GoLive store
7. Double click on any of the file names will bring up the page in design view. Items that are repeated on several pages such as the company name, news section, menu etc. have been set up as GoLive components so the whole site can be updated from the one file. Double clicking on any of the components will bring it up for modification. Components are shown with a change in cursor:

8. After making the modifications you should be prompted to update all files that use that component
9. Agree to update all files and move on to the next one

10. To set up a new page, the easiest way is to take an existing page and save it under a new name.

11. If you see the green bug icon rather than the tick next to a file in the site list then you will probably have a broken link in that file or one of the components included on that page. Bug icons in the vsadmin or inc folders can usually be ignored.

**NOTE (for CS2 users)**
If you receive a message that the site file was created in an unsupported version then in GoLive CS2 go to New > Site > Create Site > Site from Existing Content > From a Local Folder of Existing Files. Navigate to and choose the sitename folder, make sure it finds the index page of the site (or navigate to that as well). Continue with the site wizard. This will create a new CS2 site file for the store.

**Opening the template in Expression Web**

Once you have downloaded your zip file you'll need to double click on it and extract the contents of the download to where you want to work from on your hard drive.
Then open Expression Web and go to File > Open Site and browse to where you unzipped the download to.
Browse to where you sunzipped the download to and select “Open”.

You should see a list of files and folders that make up your store.

Extras - this is where the original png files and blank gifs can be found
Fpdb - (ASP version only) this folder contains your Access database
Images - the default images used in the design
Prodimages - the product images used on the product pages
Templates - this contains the dwt file which will be used to make global updates to the design of the store
Vsadmin - this contains all the admin files and when uploaded to your server, will be the location of your store control panel.
Global changes to the design can be made through the dwt file. This can be found in the Templates folder. Global elements are typically the header section, menu, news and footer. When you open the dwt file by double clicking on it you may see a box appear like this:

![Folder List]

Even if this box doesn't appear you should go to Site > Site Settings and in the tab labeled General, make sure you have checked the box labeled Manage the Web site using hidden metadata files:

![Site Settings]

Once you have checked the box and clicked "OK" at the bottom of the window you may get another box like the one below. Click on yes:

![Add Expression Web Information to the Folder]

You can now start making changes through the dwt file. Open the dwt file and make a small change. On saving the file you should receive a prompt like this:
Select "Yes" and the change you made will now be applied to all the files that are attached to the template. You can now go on and make all the global design changes you need to.

You will also need to make some design changes on a page by page basis. When you open the page you should see code that is editable with a white background and the code that is governed by the dwt and is not editable page by page has a yellow background.

```html
<! -- #BeginTemplate "Templates/project.dwt" -->
<head>
<! -- #BeginEditable "doctitle" -->
<title>Online Store</title>
<! -- #EndEditable -->
<meta http-equiv="content-type" content="text/html; charset=iso-8859-1" />
<meta http-equiv="content-style-type" content="text/css" />
<link rel="stylesheet" type="text/css" href="style.css" />
</head>
</<! -- #BeginTemplate "Templates/project.dwt" -->
```

In design view the editable region is outlined in orange with the name of the editable region in a tab at the top.
Uploading the store to your server

You may want to make some design changes before uploading the store to your host or alternatively start adding products and categories straightaway to the online admin section and leave the design elements to later.

Using an FTP program to upload your store

You may already have a FTP program installed – if not, you can download a copy from one of the popular download sites like www.download.com or www.tucows.com - search for “FTP Utility” and you'll get a large choice of programs. Popular utilities including WS_FTP Pro and Cute FTP

Alternatively both Dreamweaver and FrontPage have their own built in FTP programmes.

- Using Dreamweaver to upload your store
- Using Frontpage to publish your store

Note.

Your hosting company should have provided you with the details for logging onto your server – the three key items are:

- FTP address
- FTP user name
- FTP password

With that information you should be able to connect to your server. The usual set up when using a FTP program is to have your local files on the left window and the server files on the right so you can send the files and folders from your local hard drive to your server. The hosting company will often have a number of folders already set up and you may need to check their instructions to find out where the store pages need to go but this will usually be in a folder called “htdocs” public html” or “www”

With that information you can now transfer the files from your hard drive to the host server. It is best to upload all the files and folders from your extracted template – do not upload the main folder eg. DW Virtual Tones Ecomm Plus but rather the files and folders included within that folder ie. /vsadmin/ /prodimages/ /images/ categories.asp, cart.asp etc.

Once you have the entire site uploaded you can then go on to make your database connection and log in to the admin section.
Using Dreamweaver to Upload your Store

Dreamweaver has an inbuilt FTP utility, which you can use to upload your files and folders. When you first defined the site you may have only set up the local information. If you want to use Dreamweaver to upload your store you will need to add some details to the remote window:

1. Select Site
2. Click on Define Site
3. Double Click on the Template Site to Define
4. Ensure the Advance Tab is selected and choose Remote Info
5. Enter the Remote Host Details
6. Select Done and close and dialogue boxes that may be open

Your host should have given you these details when you signed up for your hosting account. Once you have entered the information above, make sure you are connected to the internet and hit the test button to make sure your connection is correct.

7. Select Site
8. Choose Site Files
9. Select the Put Icon to upload all files and folders to your web host

The “Templates” folder doesn’t actually have to reside on your server as it is only used for making changes locally but it won’t harm anything if it is uploaded. Once you have the entire site uploaded you can then go on to make your database connection.
Publishing your Store via FrontPage

If you have a Frontpage version and your host has Frontpage extensions installed it is possible to use Frontpage to transfer your site from your hard drive to your server.

1. **Open** your site in FrontPage - **File > Open Web**

2. Click on the **Publish Icon**:

3. Next give the URL of the site you are publishing to:

4. And finally type in the Frontpage **Username** and **Password** that were supplied by your hosting company:
Once you have the entire site published you can then go on to make your database connection.

Making the Database Connection

There are two ways of setting the database connection depending on the type of Template you have purchased. Please choose the appropriate section to set your database connection.

- **ASP version**
- **PHP version**

Now that all the files and folders are on your host server, it’s necessary to make the connection between the store and the database that dynamically generates the store functions. The set up is different for the ASP and PHP versions:

**ASP Version**

The easiest way to set up your connection is by preparing a quick test file and then copying the contents into your db_conn_open.asp file in the vsadmin folder - here’s how to do it:

1. **Open Notepad** and **Copy** and **Paste** the following lines of code:

   ```html
   <HTML>
   <BODY>
   sDSN = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=<%=server.mappath("vsproducts.mdb")%>;"
   </BODY>
   </HTML>
   ```

2. **Save** the file as **test.asp**

3. **Upload** this file to your **fpdb** **folder** (the one where your database resides)

4. Now **Open** this page in your browser, the URL should be something like [www.yourdomain.com/fpdb/test.asp](http://www.yourdomain.com/fpdb/test.asp)

5. **Copy** the contents of that page - it should look something like this

   ```
   sDSN = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:\web\database\vsproducts.mdb;"
   ```
6. Open the file **db_conn_open.asp** (located in the vsadmin folder of your template) in notepad and replace the current content with what you have copied from test.asp - just make sure that you don't delete the opening and closing `<% %>` tags so your code in `db_conn_open.asp` should look something like this:

```vbnet
<%
DIM sDSN
sDSN = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:\web\database\vsproducts.mdb;"
%>
```

7. Upload your new **db_conn_open.asp** to your server, overwriting the original in the **vsadmin folder**

**Note**

That should be working fine now and you can check the connection at the following URL: [www.yourdomain.com/vsadmin/admin.asp](http://www.yourdomain.com/vsadmin/admin.asp) and you can login with the default username **mystore** and password **changeme**.

If when you login and you get a message saying your Database Connection needs to be set then try following the above steps again checking everything carefully.

If you get an error message saying that your database is not writeable then this will indicate that your connection has been set correctly but you will need to contact your host to get write permissions set to your database folder.

We would also recommend making a back up of the **db_conn_open.asp** file just in case it gets overwritten at any time.

If you receive this error when trying to add new products or categories: *Operation must use an updateable query.*

...then it means that your database doesn't have write permissions. You can contact your host and ask them if there is a special folder on the server where the database should reside or if they could apply the correct permissions (writeable but not browseable) to the fpdb folder.
SECURITY TIP
The best place for your database is outside the web root. Most hosts provide a special folder for this with the database permissions already set. Using a folder outside the web root will make it difficult for anyone to download your database and gain access to your username and password. Otherwise you must set the permissions on your database folder so that your database cannot be downloaded. More information is available [here](#).

SECURITY TIP
Rename your database from vsproducts.mdb to a name of your choice, (keeping the .mdb extension of course). Examples would be (though don't use ours) yourstore591.mdb or database2221.mdb. This will make it harder for anyone to find your database if your database folder permissions are set incorrectly.

Important
The folder where the database resides should be non-browsable. This means that nobody will be able to download your database by typing in www.yourstore.com/fpdb/vsproducts.mdb - it's worth running a check. If you can download the database then ask your host if there is a special folder under the root of the site where your database can be placed, if they can set non-browsable permissions on the database folder, or in Frontpage, right click the database folder, choose properties and uncheck the "allow files to be browsed" box.
PHP Version

To set the database connection, open the file vsadmin/db_conn_open.php in a text editor such as Notepad. You need to fill in the details in the spaces provided. The 4 pieces of information that you need to provide are the username and password for database access, the name of the database and the address of the database. If you are in any doubt about these, please ask your host who will provide you with the information. Then fill in the gaps between the quotes as shown.

$db_username = "loginname"; // Your database login username
$db_password = "loginpassword"; // Your database login password
$db_name = "databasename"; // The name of the database you wish to use
$db_host = "localhost";

The last parameter $db_host is normally "localhost". However, it can also be a URL like

$db_host = "db.myhost.com";

You host should have given you access to a hosting control panel where, amongst other things, you can set up the mySQL database connection. Here’s an example using “cpanel”

1. Log into to your hosting control panel, this will typically be the URL www.yoursite.com/admin/ or www.yoursite.com/cpanel/ and after entering your username and password you should see a screen with the mySQL icon:

2. Click there and choose your user name and password, then click “Add User”
3. When the screen refreshes you’ll need to give your database a name and click on **Add db**:

![MySQL Account Maintenance](image)

4. Finally **choose the database** you have just set up from the **drop down** and choose “**Add User to Db**”

![MySQL Account Maintenance](image)

5. You will then be presented with details of your connection string that you can **copy and paste** into **db_conn_open.php**.

![MySQL Account Maintenance](image)

**Note**

Make sure you include the **underscore** in your user name and database name

6. **Upload** the **db_conn_open.php** and **replace the file** in your **vsadmin directory**
Once this information has been correctly entered and uploaded, you can **install the database tables and data**.

7. To do this, just open the file `createdb.php` in a browser by entering the address for instance:

```
http://www.yoursite.com/createdb.php
```

Replacing "www.yoursite.com" with whatever is the URL of your site.

The following screen will appear, please see following page:

8. Then click on the button to **Install Ecommerce Plus** and your database will be created. Please remember to delete this file from your web after running it, as otherwise others could use it to destroy your information.

The store should be working fine now and you can check it at:

```
www.yourdomain.com/vsadmin/admin.php
```

and you can login with the default user name `mystore` and password `changeme`.

Files and folders

Now the store is on the server it may be an idea to become familiar with the files and folders that make up the store itself. Below is an overview of what each folder includes and its function:

**Fpdb:** This is where your database resides. *(ASP version only)*

**Images:** This folder contains all the graphics that are used in the design of the site – it should also contain a folder called “extras”, where you can find the .png files and/or blank graphics.

**Prodimages:** This is the default folder for placing your product images. You’ll see that at the beginning it contains the dozen or so images used in the default store.

**Vsadmin:** This is where all the admin pages, scripts and images are kept. You don’t need to make any design changes here but there a couple of files that you may need to edit once you have all the files published to your server.

**Includes:** This folder contains the include pages. If you’re not familiar with includes, these are files that are used on several or all of the pages on the store – updating these pages will cause all pages that “include” them to be updated at the same time. They are typically news sections, headers, menu and footers. *(Frontpage only)*

**Templates:** This folder should contain the .dwt file, usually called Main.dwt. This is where you should make the global changes to your site. Once you’ve made the changes to this file, save it and you'll be prompted if you want to update all the files using this template - agree to the prompt and you should be able to see the modifications you've made on subsequent pages. *(Dreamweaver only)*

**Library:** Some of the templates use library items for the news sections or menus. These can be inserted or deleted from the editable sections and like the .dwt file, any changes made to the .lbi file will be made on all the pages containing the library item on saving. *(Dreamweaver only)*

The other files are the ones that make up the site and store itself and will have a .html, .php or .asp extension.
Security Issues

At Ecommerce Templates we take security very seriously and have put some measures in place to maximize the integrity of your online store. We strongly recommend keeping up with the updater releases available from www.ecommercetemplates.com/updaters.asp - apart from the new features we are adding they also include additions to improve on performance and security.

Please take some time to go through the following steps once you have your store published and database connection set.

**Make sure your database isn't downloadable (ASP Version)**
You can test this yourself by typing in the address eg www.yourstore.com/fpdb/vsproducts.mdb. If you receive an option to download the .mdb file then it probably means that people can access your database.
Please check with your host if you have any doubts at all. Most hosts will provide you with a directory below the root of your web with the correct permissions already set.

**Change the name of the file vsproducts.mdb (ASP Version)**
This is quite simple but do back up the database first just in case.
Rename vsproducts.mdb to whateveryoulike.mdb and in db_conn_open.asp change the instance there of vsproducts.mdb to whateveryoulike.mdb
No other changes are necessary

**Change the name of the vsadmin folder**
This again is quite simple. Download the vsadmin folder, rename it outside of your HTML editor and upload it to the server again.
In the old vsadmin folder (the one that is still called vsadmin) open includes.asp and add these two lines:
`disallowlogin=TRUE
notifyloginattempt=TRUE`
For the PHP version, open includes.php and add these two lines

```
$disallowlogin=TRUE;
$notifyloginattempt=TRUE;
```

When updating, remember you will need to upload the updater files to both the new and old folders.

**Change the default password / login**
This is the second thing you should do after making sure your database is not downloadable. Also be sure to use DIFFERENT username / password combinations for your control panel, FTP, bank etc etc.
Back-ups
Do make sure that your host has a system in place for backing up your site. You can also make regular back-ups yourself but if there is any problem with your local copy, it's important to be sure the host has a good recent copy.

Check again
Check the above points at regular intervals in case permissions get changed or files get overwritten.

Read our files on fraud and checks
http://www.ecommercetemplates.com/help/fraud.asp
Chapter 2

Main Settings & Payment Providers

- The control panel
- Change admin username and password
- Main admin settings
- Country settings
- Currency converter
- Email confirmation
- Email object
- Store URL
- Products per page
- Handling charge
- Shipping type
- Pack products
- USPS / UPS
- Stock management
- Delete orders
- Delete credit card numbers
- Admin tweaks
- Multiple languages
- Edit payment providers
- Supported payment providers
- Email
- Custom
- Setting up a secure server
The Control Panel

Once the site is uploaded to your server and the database connection has been set, it's possible to connect to the admin area. Depending on the version your admin area will be here:

**ASP Version**

www.yourstore.com/vsadmin/login.asp

**PHP Version**

www.yourstore.com/vsadmin/login.php

The default username is - mystore
The default password is - changeme

Once you have logged in you will be presented with links to the various sections that make up the control panel, the main admin settings are detailed below.

---

**SECURITY TIP**

You can change the name of the vsadmin folder to make it more difficult for people to find your admin section.

Download the vsadmin folder, rename it outside of your HTML editor and upload it to the server again.

In the old vsadmin folder (the one that is still called vsadmin) open includes.asp and add these two lines:

```
disallowlogin=TRUE
notifyloginattempt=TRUE
```

For the PHP version, open includes.php and add these two lines

```
$disallowlogin=TRUE;
$notifyloginattempt=TRUE;
```

---
Change Username and Password

This should be your first change as all the templates come with the same combination. It’s best to choose an alphanumeric combination and make sure you write them down and save in a safe place. If you forget the combination later on it is possible to retrieve them, there is help in our troubleshooting page.

1. To change the Username and Password click on the Change Password link.
2. Key in your Username
3. Key in your Password and repeat this process for the Confirm Password option

Click on Submit

<table>
<thead>
<tr>
<th>Please enter your new username and password.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username: [Username]</td>
</tr>
<tr>
<td>Password: [Password]</td>
</tr>
<tr>
<td>Confirm Password: [Password]</td>
</tr>
</tbody>
</table>

From version 5.4 you can also set up secondary logins thus restricting access to specific admin pages depending on login.
Main admin settings

This page contains some of the crucial settings for your Ecommerce Template store and we have detailed the various options below.

Store Settings

<table>
<thead>
<tr>
<th>Which country settings do you wish to use for currency symbols etc?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country Settings: United States of America</td>
</tr>
<tr>
<td>The Store URL should be the base URL of your store, including directory name if you have placed your store in a sub directory</td>
</tr>
<tr>
<td>Store URL: <a href="http://www.yourstoreurl.com/">http://www.yourstoreurl.com/</a></td>
</tr>
<tr>
<td>How many products you would like displayed on each page?</td>
</tr>
<tr>
<td>Products per page: 11</td>
</tr>
<tr>
<td>Default Product Sort Order: Sort Alphabetically</td>
</tr>
</tbody>
</table>

Country Settings

This is where you specify where you are selling from and the currency on your store will adjust accordingly. It will also affect such things as the date display format, tax settings and the shipping estimator. The currency format can be overwritten on your store if necessary.

Store URL

This is a very important setting as it is used widely on the store. Make sure the URL is the full URL of your store, this would normally be [http://www.yourstore.com/](http://www.yourstore.com/) but if you have placed your files in a separate folder then you would need to change the setting accordingly. There is a suggestion above the box that should help you. Do not add a page name such as index.php or categories.asp to the setting here.

Products per page

This is where you specify how many products you would like to appear on your products page. Too many products will cause the page to load more slowly, too few and your users may have to click through many pages to get to what they are looking for so a value of perhaps 6 to 12 is a happy medium.

Default product sort order

Here you can choose how your products are listed on the products page, whether you want them ordered alphabetically, by price, date etc.
This feature will appear on your products page and allows customers to filter the product listings by Manufacturer, Price, Keyword etc. To turn the feature on you will need to check one or more of the checkboxes. There are css classes included for formatting the look.

### Allow Filter by Manufacturer
This will give you a drop down menu of the manufacturers that you have defined in the manufacturers admin page.

### Allow Filter by Search Criteria
This allows you to group products together using your own criteria. You will first need to create your groups by clicking on the link in the admin home page for "Edit Search Criteria". For example you might want to create groups for brand new products, nearly new and second-hand so the label you might want to enter here would be "Condition". Once you have set up those groups, you will then want to assign your products to each group through the product admin pages.

### Allow Filter by Price
You can provide a drop down of pricing bands to your customers so they can filter the product listing by price. By default price bands are of $100 but you can set your own thresholds in vsadmin/includes.asp with for example

`filterpricebands=150`

or in vsadmin/includes.php

`$filterpricebands=150;`

### Allow Customer Defined Sort
This allows you to choose between the 10 different sort methods so a customer can choose to have the product listing sorted alphabetically, by price, by most recent etc.
The customer can choose how many products will appear on the page. The multiples come from the main products per page setting.

**Allow Filter by Keyword**
The customer can enter their own search terms to find the product they are looking for. The search will be based on the product name, id, description and additional search parameters.

**Order Management**

<table>
<thead>
<tr>
<th>Would you like to use stock management?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stock Management:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>On</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Would you like to delete uncompleted orders?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete after:</td>
</tr>
<tr>
<td>2 days</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Would you like to delete stored Credit Card numbers automatically?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete after:</td>
</tr>
<tr>
<td>1 week</td>
</tr>
</tbody>
</table>

**Stock Management**

If you want to use the Stock Management feature then it can be turned on here by choosing "On" from the drop down.

**Delete after (uncompleted orders)**

Set the time period you would like uncompleted orders to be deleted from your database. You will need to hit the Purge Deleted button in the orders admin page to completely get rid of all deleted orders from your database.

**Delete after (credit card details)**

If you are using the Capture card method, set the number of days that credit card details are stored in your database when using the Capture Card method. We strongly recommend setting this to a workable minimum to minimize the risks of storing sensitive data on your server.

**Email Settings**

Following a successful order on your store you will be notified by email if you have checked the Email confirmation box. The email will be sent to the address specified below that. It's important that the email is valid for the domain so you@yourdomain.com would be correct, you@anotherdomain.com would not. For the PHP version that should be all the information that is required. For the ASP version you will see the extra fields outlined below.
### Email Settings

**Would you like to receive a confirmation email when orders come in?**

| Email confirmation: | ☑ |

**The email address to which confirmation emails should be sent.**

| Email address: | you@yourstoreurl.com |

There are several “standard” email objects that can be used to send emails on a Windows server. Those available are listed here. Please note, CDONTS does not require you to set the mailhost. CDO May require this depending on your host’s configuration. Other email objects DO require the mailhost to be set. More information setting the mailhost is available here. General email help is available here.

**Email object:**

| CDO |

If using CDONTS (above) as your email object you do not need to set this. CDO **may** require this to be set.

**SMTP Server:**

You only need to set this if your SMTP server requires authentication to send email from an ASP page. If in doubt just leave it or ask your host.

| Username: |
| Password: |
Shipping & Handling Settings

Select which method you wish to use to calculate shipping.

**Shipping Type:** U.S.P.S. Shipping

Would you like to show alternate shipping rates apart from your primary shipping carrier?

**Use Alternate Shipping rates:** [Show all shipping carriers together]

Select the alternate shipping methods you wish to show:

<table>
<thead>
<tr>
<th>Method</th>
<th>Rates</th>
</tr>
</thead>
<tbody>
<tr>
<td>UPS Shipping</td>
<td>UPS Rates</td>
</tr>
<tr>
<td>FedEx Shipping</td>
<td>FedEx Rates</td>
</tr>
<tr>
<td>U.S.P.S. Shipping</td>
<td>USPS Rates</td>
</tr>
<tr>
<td>Weight Based Shipping</td>
<td>Weight Based Rates</td>
</tr>
<tr>
<td>Flat Rate Shipping</td>
<td>Flat Rate Shipping</td>
</tr>
<tr>
<td>Price Based Shipping</td>
<td>Price Based Shipping</td>
</tr>
<tr>
<td>Canada Post</td>
<td>Canada Post</td>
</tr>
</tbody>
</table>

Select which method you wish to use for international shipping.

**Shipping Type:** Same as domestic shipping

Select how you pack products for shipping calculations. (Only affects UPS, FedEx, USPS, Weight and Price based shipping)

**Pack Products:** [Pack products together]

If using USPS shipping method, please enter your USPS username. Please note, for UPS shipping, you have to use the registration form here.

**Username:** [Blank]

If using Canada Post for shipping, please enter your Retailer ID here.

**Retailer ID:** [Blank]

Also, if using UPS / FedEx / USPS / Canada Post shipping method, please enter the zip / postal code of the shipping origin.

**Zip:** [Blank]

Please select the units used to specify products weights and dimensions.

**Shipping weights:** LBS

**Dimensions:** IN

- Some shipping carriers may be restricted as to available shipping units and some may vary by country of origin.
- If you specify units for dimensions you will have to enter dimensions for all products. But most of the time it will make no difference to shipping.

If you wish to have a handling charge applied to all orders, please enter it below.

**Handling Charge:** [Blank]

**Handling Charge (Percentage):** [Blank]

**Shipping type**

Here is where you can specify the shipping method you want to employ on your store for domestic and international customers.
**Use alternate shipping rates**
If you don't want to give your customers a choice of shipping methods on checkout, select "Don't use alternative rates". Selecting "Show alternate carriers in menu" will give the customer the choice of selecting the shipping carrier from the ones you select and then choosing the method they want the purchase to be shipped by. Choosing "Show all shipping carriers together" will present rates for all the shipping methods you select on the same screen.

**Alternate shipping**
Use the arrow to set the order of the shipping methods presented to your customers. Select which methods you want to support by checking the box next to each carrier, the first is for domestic shipping, the second for international. Use the text field to label each of the methods.

**Pack products**
Selecting Pack products together will add all the product weights together and take the shipping cost on this total. Pack products separately will take the shipping cost for each item and then add these together.

**Username**
If you are using USPS shipping on your store then after registering for a user name with USPS you would enter it here.

**Retailer ID**
This is only required if you are using Canada Post as the shipping method

**Zip**
This is the zip (postal) code of where you are shipping from. Only one zip code can be used in the process of calculating shipping costs.

**Shipping weights / Dimensions**
This is where you can choose between the metric and imperial systems. Do note that some shipping carriers may restrict the available shipping units and some may vary by country of origin. If you specify units for dimensions you will have to enter dimensions for all products. But most of the time it will make no difference to shipping.

**Handling charge**
The value specified here will be added to the order total to cover handling costs. It is possible to add a per payment provider handling charge, a handling charge as a percentage of the order total and add tax to the handling.
Language settings

How many languages will this store support?

| Number of languages: | 1 |

What parts of the store would you like in multiple languages? This setting is only relevant if the Number of languages above is not equal to 1.

<table>
<thead>
<tr>
<th>Language settings:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Name</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Long Description</td>
</tr>
<tr>
<td>Country Name</td>
</tr>
<tr>
<td>Option Name</td>
</tr>
</tbody>
</table>

Number of languages

If you are going to run more than one language off the same database then this is where you specify the number, maximum of three.

Language settings

This is also used with the multiple language settings and here you can choose which fields you want to appear in your alternative languages.

Currency Conversion

If you would like to have up to 3 currency conversions, please enter the rates and currency symbols below. (If you don’t want to use currency conversions, just leave these blank. If you are using the auto system, just choose the currency symbols you require and the rates will update automatically.)

<table>
<thead>
<tr>
<th>Conversion 1:</th>
<th>Rate</th>
<th>EUR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conversion 2:</td>
<td>Rate</td>
<td>GBP</td>
</tr>
<tr>
<td>Conversion 3:</td>
<td>Rate</td>
<td>CAD</td>
</tr>
</tbody>
</table>

(This login and password setting are only if you wish to use the Ecommerce Templates Auto Currency updater system.)

| Username: | testuser |
| Password: | testpw |

It is possible to show your product prices in up to three other currencies other than the default. The alternative prices will be shown on your product and product detail pages below the main default price. Sales will always be processed in the default currency but it does provide a guide for international purchasers regarding the approximate price in their local currency.
If you are going to implement the Cardinal Commerce 3D Secure system to provide Verified by VISA, Mastercard SecureCode and J/Secure functionality, enter the details here.

Remember that any changes you make on this page will only take effect after you have clicked on the “Submit” button.

### Multiple languages

#### How it works

This feature was added in Version 4.8.0 and allows you to have up to 3 languages running off the same database and control panel. You can select the number of languages you require and which parts of the store you want to translate from your main admin page. The full set up details are outlined below.

#### How to set it up

The first thing you will need to do is to define how many languages you will be using and which parts of the store you are going to translate. In the main admin settings of the control panel you should see a drop down menu for the number of languages and a box with the different sections. Use Ctrl + Click for multiple selections.
As you will probably want to offer the navigation and information pages in other languages then the next thing you will need to do is upload all the store files and vsadmin folder to a new folder on your server. For example, if you are going to have a Spanish based store then make a folder called /spanish/ on your server and upload all the files there.

The last thing you need to do is to tell the database which language is being used in that particular version. Open vsadmin/includes.asp or vsadmin/includes.php for the new language store you have set up and add this to the list for the ASP version:

```
languageid=2
```

..or for the PHP version:

```
$languageid=2;
```

where the number 2 is the identifier of the language. As an example if you have the main store set up in English and language versions for Spanish and French then you would have the languageid as 1 for English, 2 for Spanish and 3 for French in the respective include pages.

You can now go into your control panel and start adding the information for the alternative languages. As an example if you have chosen to have separate language product names then in the products admin you should see three boxes, the first for the main store language the next two for the alternatives:

```
* Prod Name: Wooden table
* Prod Name 2: Mesa de madera
* Prod Name 3: Table en bois
```

Once that is all set up you can add links from your main store to the two new language stores.
Edit Payment Providers (Main Page)

The Payment Providers Admin page shows a list of the payment processing companies and methods currently supported by Ecommerce Templates.

To access the Payment Provider click on the payment providers link from the left hand menu.

Use this page to update payment provider details.

<table>
<thead>
<tr>
<th>ID</th>
<th>Order</th>
<th>Provider Name</th>
<th>Configure</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>1</td>
<td>Email</td>
<td>Modify</td>
</tr>
<tr>
<td>13</td>
<td>2</td>
<td>Auth.net AIM</td>
<td>Modify</td>
</tr>
<tr>
<td>14</td>
<td>3</td>
<td>Custom</td>
<td>Modify</td>
</tr>
<tr>
<td>16</td>
<td>4</td>
<td>Linkpoint</td>
<td>Modify</td>
</tr>
<tr>
<td>2</td>
<td>-</td>
<td>2Checkout</td>
<td>Modify</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>Auth.net SIM</td>
<td>Modify</td>
</tr>
<tr>
<td>10</td>
<td>-</td>
<td>Capture Card</td>
<td>Modify</td>
</tr>
<tr>
<td>17</td>
<td>-</td>
<td>Email 2</td>
<td>Modify</td>
</tr>
</tbody>
</table>

ID
- The id of the payment provider

Order Column
- This column allows you to define the order that payment options appear on the checkout page of your store.

Provider Name
- The second column is the list of payment companies / methods currently supported.

Configure
- You can set the necessary details of the payment method.

Those shown in bold have been enabled, those in red are enabled but in demo mode.

Supported Payment Providers

Email

The email option will simply email you the order details from a purchase. It will not include any credit card information and can be used if you would like to accept money orders, checks, cash on delivery etc. You can make it clear on your store the payment methods and process you are willing to accept here and it’s possible to change the default text for “Email” in the “Show As” field. You may wish to change this to something like “Check” depending on what you will be using it for.
Use this page to update payment provider details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider Name:</td>
<td>Email</td>
</tr>
<tr>
<td>Show As:</td>
<td>Check / Postal order</td>
</tr>
<tr>
<td>Enabled:</td>
<td>☑</td>
</tr>
<tr>
<td>Email Address for Orders:</td>
<td><a href="mailto:you@yourstoreurl.com">you@yourstoreurl.com</a></td>
</tr>
<tr>
<td>Login Level:</td>
<td>No Restriction</td>
</tr>
<tr>
<td>Handling Charge:</td>
<td>0</td>
</tr>
<tr>
<td>Handling Charge (Percentage):</td>
<td>0</td>
</tr>
<tr>
<td>Email Headers / Footers:</td>
<td>Edit</td>
</tr>
<tr>
<td>Drop Shipper Email Headers / Footers:</td>
<td>Edit</td>
</tr>
</tbody>
</table>

**Login Level:** Only change the value here if this payment method is restricted to logged in customers only.

**Handling charge (percentage):** This is where you can set a handling charge that only applies to this payment type.

**Email headers / footers:** You can add a header and / or footer to the email the customer receives on order using this payment method.

**Drop shipper headers / footers:** You can add a header and / or footer to the email the drip shipper receives if using this feature.

You can have a second email type payment provider by selecting Email2 and a third by downloading the files from [www.ecommercetemplates.com/free_downloads.asp](http://www.ecommercetemplates.com/free_downloads.asp) and uploading these to your vsadmin/inc/ folder. From the payment provider list, this would be listed as “Custom”.
Supported payment providers

Please view our online help pages for help with setting up with the supported payment providers.

Capture card (ASP version)

Some people want to capture their own credit card numbers to run through a terminal as a quick and easy way to get their online store going. For this we provide Capture Card, however please be aware that the fact that you are responsible for your customers' credit card details makes this far from simple and we strongly advise using one of the online credit card processors unless you are fully aware of all security issues involved.

You will need a SSL certificate installed, either your own or shared from your host.

IMPORTANT NOTE
To reduce security risks set the automatic deleting of credit card information to a workable minimum level - we would suggest that 2 days is more than ample time. This setting can be found on the main admin page. You can also manually delete the credit card information from your database by hitting the "delete" button. We strongly advise that you delete the credit card information as quickly as possible to reduce the security risks. It is also imperative to keep up to date with the latest ecommerce template updaters which are released at regular intervals.

Requirements.

· Windows server supporting .asp pages and an Access database
· SSL certificate
· Personal certificate
· ASPEncrypt component installed on your server
· Internet Explorer 5.5+

Setting up the "Capture Card" system with ASPEncrypt installed.

To set up the "Capture Card" system please do the following.

1. To obtain a Personal Certificate, please go to the following URL and follow the onscreen instructions.

   http://support.persits.com/encrypt/demo_cert.asp

2. Once you have installed your Personal Certificate in Internet Explorer, you must now export your Public Key. To do this, in Internet Explorer go
to Tools -> Internet Options and click on the "Content" tab. Now click on "Certificates...".

3. On the "Personal" tab you should see the certificate you have just installed. Click on this and choose "Export..." to bring up the export certificate wizard.

4. The first step of the wizard will ask you if you want to export the private key with the certificate. You MUST select "No, do not export the private
key. This is most important as if you export the private key you will be compromising the security of the system.

5. On the next page of the wizard choose **Base-64 encoded X.509 (.CER)** as the format. Now give the file a filename such as **certificate.cer** and save it on your desktop or somewhere you have easy access to it.

6. **Run notepad** or other text editor and open this **certificate.cer** file.
Remember that as certificate files are automatically created with a .cer extension, to look under "all files" and not just files with a .txt extension.
7. **Open your Ecommerce Plus template online admin section**, click on Payment Providers and then click on modify for Capture Card.

![Payment Providers Modification](image)

8. You want to make sure the processor is "Enabled", select the credit card types that you want to use and in the box at the bottom where it says "Upload New Certificate" you want to copy and paste all the information in your certificate.cer file to the this box, and then click "Submit" to upload the certificate information.

Now try a test transaction. After the first checkout page all information will be taken on a secure connection.

(For instance https://www.yoursite.com/cart.asp.) For this to work you will need to have an SSL certificate installed on your site, and which you can obtain from www.thawte.com or www.geotrust.com.

If you do not have an SSL certificate installed then for testing purposes you can override this by opening the file vsadmin/includes.asp and set the following

```
pathssl = "http://www.yoursite.com/
```

(Obviously you would replace yoursite.com with the actual name of your site.) This will force the system to use an http (unsecure) instead of https (secure) connection.
You can also use this method if you want to use a different URL for your secure connection. Though do remember, both locations must be able to see the database.

Also, the switch to secure server relies on the setting of the store URL in the admin main page, so do remember to set this properly.

To complete a Capture Card transaction you will need a valid test credit card number such as 4111111111111111 and just choose any date.

After completing a test transaction you now want to make sure you can view the credit card number. Log in to your Ecommerce Plus admin section and go to the orders page. Now click on the order you just made. You should see a certificate pop up asking if you want to install Xencrypt by Persits software. This is the object that will "decode" your credit card numbers, so please select Yes to install this if you wish to view the results of credit card transactions. This process only needs to be performed once. Remember to always view the admin orders page on an HTTPS connection.

To reduce security risks set the automatic deleting of credit card information to a workable minimum level - we would suggest that 2 days is ample time. This setting can be found on the main admin page. You can also manually delete the credit card information from your database by hitting the "delete" button.

**Checklist for the ASPEncrypt method**

1. Go to [http://support.persits.com/encrypt/demo_cert.asp](http://support.persits.com/encrypt/demo_cert.asp) and follow the onscreen instructions.
2. In Internet Explorer go to Tools -> Internet Options -> Content -> Certificates
3. Click on the new certificate and choose "Export"
4. Select "No" to export the private key
5. Choose Base-64 encoded X.509 (.CER) as the format
6. Name the file certificate.cer and save it to you desktop
7. Open the file certificate.cer in Notepad or your favorite text editor
8. In your admin section of your ecommerce template open the "payment providers" page
9. Click on "Modify" for the "Capture Card" option
10. Select the credit card types you want to allow
11. **Paste all the code** from the certificate.cer that you have open in Notepad to the box entitled "Upload new certificate"
12. Press submit and test!
F.A.Q.

- What is ASPEncrypt?
- Can I use my host's shared SSL certificate?
- What is a personal certificate?
- Is this system really secure?

What is ASPEncrypt?

ASPEncrypt is a component that resides on your host's server. It provides a client-side ActiveX sub-component, called XEncrypt, which performs all cryptographic operations directly on your machine for better security. In particular, operations involving the user's private key such as digital signing and data decryption can be performed without jeopardizing the security of the private key. More information from www.aspencrypt.com.

Not all hosts have the component installed so it is worth asking - we recommend the Windows hosting at www.servelink.com

Can I use my host's shared SSL certificate?

Yes, you can. Alternatively you can apply for your own through a company like Thawte, Geotrust or InstantSSL.

What is a personal certificate?

This is a data structure that stores someone's personal information such as a name or email address, together with this person's public key. As the credit card details are encrypted, this will be necessary so that only you have access to the credit card information through your control panel.

Is this system really secure?

It's as secure as we can possibly make it. If anyone was to gain access to your database, they wouldn't be able to see any of the sensitive information stored there as it is in an encrypted form. As with any web site, store or application you should always pay particular attention to the security issues. Remember to secure your database so that it cannot be downloaded, make regular back-ups, change your passwords, make them alphanumeric and if you are running your own server, keep your Windows patches updated.

We have provided more information about setting up on a secure server here
Capture Card (PHP Version)

Some people want to capture their own credit card numbers to run through a terminal as a quick and easy way to get their online store going. For this we provide Capture Card, however please be aware that the fact that you are responsible for your customers credit card details makes this far from simple and we strongly advise using one of the online credit card processors unless you are fully aware of all security issues involved.

You will need a SSL certificate installed, either your own or shared from your host.

IMPORTANT NOTE
To reduce security risks set the automatic deleting of credit card information to a workable minimum level - we would suggest that 2 days is more than ample time. This setting can be found on the main admin page. You can also manually delete the credit card information from your database by hitting the "delete" button. We strongly advise that you delete the credit card information as quickly as possible to reduce the security risks. It is also imperative to keep up to date with the latest ecommerce template updaters which are released at regular intervals.

To set up the "Capture Card" system please do the following.

1. Open your Ecommerce Plus template online admin section, and click on modify for Capture Card. You want to make sure the processor is "Enabled", select the credit card types that you want to use.

2. Open the file vsadmin/includes.php and set $encryptmethod=""; to $encryptmethod="mcrypt";.

It does require the mcrypt library 2.4 or above to be compiled with PHP so ask your host. You also need to set a "pass phrase" in the vsadmin/includes.php file. For instance...

$ccencryptkey = "spqncopw this is a good passphrase to use";

Do make it unique. Do add random text. Do make it at least 32 characters long.

Please note that if someone manages to compromise your database AND your site so they gain access to your secret phrase, then it is possible that they can decrypt the credit card numbers. It is not a public / private key type algorithm. However it does add an important extra level of security.

You can also set the encryption cypher used by setting for instance...

$mcryptalg = MCRYPT_RIJNDAEL_128;
...in your includes.php page. A list of cyphers supported in PHP is available here...

Now try a test transaction. After the first checkout page all information will be taken on a secure connection. (For instance https://www.yoursite.com/cart.php.) For this to work you will need to have an SSL certificate installed on your site, and which you can obtain from www.thawte.com or www.verisign.com. If you do not have an SSL certificate installed then for testing purposes you can override this by opening the file vsadmin/includes.php and set the following

```php
$pathtossl = "http://www.yoursite.com/";
```

(Obviously you would replace yoursite.com with the actual name of your site.) This will force the system to use an http (insecure) instead of https (secure) connection.

You can also use this method if you want to use a different URL for your secure connection. Though do remember, both locations must be able to see the database.

Also, the switch to secure server relies on the setting of the store URL in the admin main page, so do remember to set this properly.

To complete a Capture Card transaction you will need a valid test credit card number such as 4111111111111111 and just **choose any date**.

After completing a test transaction you now want to make sure you can view the credit card number. Log in to your Ecommerce Plus admin section and go to the orders page. Now click on the order you just made. Remember to always view the admin orders page on an HTTPS connection.
To reduce security risks set the automatic deleting of credit card information to a workable minimum level - we would suggest that 2 days is ample time. This setting can be found on the main admin page. You can also manually delete the credit card information from your database by hitting the "delete" button. **We strongly advise that you delete the credit card information as quickly as possible to reduce the security risks.**

We have provided more information about setting up on a secure server here

**Custom**

This option is for anyone wanting to add a payment provider that is not currently supported by Ecommerce Templates.

It does require a solid knowledge of coding but this option will make things simpler as the database is already set up to handle an extra processor and any updates that are made in the future will not overwrite the modifications that have been made. If you are not confident about making the changes yourself, then we suggest contacting one of the developers here for a quote.

Do be aware also that not all payment systems will fit into the model we have provided, but the vast majority should.

We do have a lot of Custom payment providers already set up, so please check here for the latest list

Setting up a secure server

Some payment methods like PayPal Payflow Pro, authorize.net (AIM) and Capture Card amongst others require that the checkout portion of the process take place on a secure server. There are two methods of doing this. One is to have a secure certificate installed on your web. (Your host can tell you if this is possible with your hosting plan). This means that you can access your web using both non secure (http) and secure (https) methods. For instance both these URL’s would be valid...

http://www.yoursite.com/products.asp
https://www.yoursite.com/products.asp

If you enable a payment method that does require the checkout on a secure server, then the second stage of checkout will automatically switch to a secure server. As during testing you may not have a secure certificate installed, we have provided a method for you to override this. In your vsadmin/includes.asp/php file set the following...

pathssl = http://www.yoursite.com

By doing this you will force the second stage of checkout to remain on a non secure (http) connection

One thing to note is that if you are on an https connection and then click on say the link to the categories.asp/php page, you will remain on the https connection, which is not really desirable. To overcome this you can make all your links absolute. For instance, don’t link to categories.asp/php but rather link to http://www.yoursite.com/categories.asp

Some hosting providers may provide shared space on their secure server. Generally this is a cheaper option as you don’t have to purchase your own secure certificate, but it is a bit more difficult to set up.

The first thing you must make sure of is that you can access your database from both the secure and the non-secure areas. Your host can tell you if this is possible when you contract the secure space.

You will need to make a copy to your secure area of the thanks.asp/php and cart.asp/php pages. Also, you will need any images from your images directory that are used by these pages and the whole vsadmin directory on the secure space.

Now set the pathssl, for instance...

pathssl = "https://secure.yourhost.com/yourdir/"
pathssl = "https://yoursubdomain.yourhost.com/"
As above, remember to make links in your site absolute to make sure that your customers do not get stuck on the secure portion of your site.
Chapter 3
Categories and Products

Introduction
Accessing the Categories
Adding a new category
Adding products
Product options
Discounts and coupons
Gift certificates
Donations
Introduction

After setting up the main settings, the next step will be to get your own categories and products on your store. The software does come with some sample data for you to work. You can have up to 10 levels of sub-categories.

Accessing the Categories

Select the “categories” link from the left hand menu.

The following screen will appear

<table>
<thead>
<tr>
<th>Order</th>
<th>Category Path</th>
<th>Category Name</th>
<th>Discounts</th>
<th>Modify</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Home Page (12)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Computer Parts (5)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Categories (11)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Peripherals (3)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Printers and Scanners (6)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>New Category (9)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Search page (14)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Cart page (13)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Categories ➤ Computer Parts</td>
<td>Systems (1)</td>
<td>Assign</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Categories ➤ Printers and Scanners</td>
<td>Clothes (6)</td>
<td>Assign</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Categories ➤ Printers and Scanners</td>
<td>Scanners (2)</td>
<td>Assign</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Printers (4)</td>
<td>Assign</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Screen Explained

Order Category Path: This will give you the hierarchy of your category set up. The Home option refers to categories.asp / categories.php. The drop down option on the left allows you to order the categories on your store.

Category Name: This is the working name assigned to your category – it may be different from the name that appears on your store depending on the naming system you have chosen. Text in bold denotes a category that can have products added to it. The number in brackets (15) refers to the category id and is useful when manually setting up links on the store.

Discounts: Option to assign a Discount

Modify: Modify the properties of the Category
**Delete**: Delete a Category (Please note that this won’t delete the products within the category).

**Adding a New Category**

Click on the New Category button

---

**The Screen Explained**

**Category Name**: This is the name of the category that will appear on your store.

**Category Working Name**: This is for internal use only and is useful when you have categories that could have the same name.

**Sub Category Of...**: This drop down allows you to choose the category above the one you are adding. In the example above, “Toshiba” will be a sub-category of “laptop1”.

**Category Function**: There are two options when setting up a new category. The category may have products added to it, in this case select “Products can be added to this category”. If there are to be further sub-categories in the hierarchy then select “Categories can be added to this category”. It will not be possible to add a product to a category that has subsequent sub-categories.

**Category Image**: This is an optional field where you would place the path to the image to accompany the category name.

**Category Description**: Also optional if you would like to describe the category to your users. It is possible to add HTML to this field.

<table>
<thead>
<tr>
<th>Category Name</th>
<th>Category Working Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peripherals</td>
<td>Peripherals</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sub Category Of...</th>
<th>Category Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Categories</td>
<td>No Restriction</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Category URL (Optional)</th>
</tr>
</thead>
<tbody>
<tr>
<td>/images/peripherals.gif</td>
</tr>
</tbody>
</table>
Login level: This is an optional field where you can set the login level to be used in conjunction with the client login feature. It is also possible to disable a category (and all their products) rather than delete it so it can be put back at a later date.

Category URL: Also optional if you would like to specify the static URL of the category which would have been set up using the search engine friendly features. This now means that your menu system won't pick up on the dynamic URLs as the store is browsed. It also works with the DHTML menu and avoids duplicate URLs / content on the store.

Product category root: This is used in conjunction with the content management system and css menus introduced in version 5.9. If you aren't going to use those features, you can ignore this setting. If you want to read more on its use, visit our help page on css menus.
Adding products

Once you have at least one category defined it’s possible to start adding products to the store.

The first screen you will see when clicking on the Edit Products link should look something like this. To view all the products on your store, click on "List Products". If you are using the Stock Management feature then you can view all out of stock products by choosing "Out of Stock", those products you have chosen not to display can be viewed by selecting "Hidden Products". If you want to download a .csv file with a listing of products and stock levels then select "Stock Inventory" and hit the "Go" button. To view the full inventory and full product information then choose "Product Inventory" from the drop down.

If you have a large number of products on your store then you can refine the product listing by using the product search feature. To search via price ranges you can use this kind of set up

-50
. . . for all products up to $50
10-50
. . . for products between $10 and $50
50-
. . . for products above $50

Editing products

Once you have your product listing you should see a screen similar to the one below.

<table>
<thead>
<tr>
<th>Price</th>
<th>Product ID</th>
<th>Product Name</th>
<th>Discounts</th>
<th>Modify</th>
<th>Related</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>1200</td>
<td>pc001</td>
<td>#1 PC multimedia package (10)</td>
<td>Assign</td>
<td>Modify</td>
<td>Related</td>
<td>Delete</td>
</tr>
<tr>
<td>0.01</td>
<td>testproduct</td>
<td>Cheap Test Product (21)</td>
<td>Assign</td>
<td>Modify</td>
<td>Related</td>
<td>Delete</td>
</tr>
<tr>
<td>69</td>
<td>scanner001</td>
<td>Flatbed scanner (10)</td>
<td>Assign</td>
<td>Modify</td>
<td>Related</td>
<td>Delete</td>
</tr>
<tr>
<td>0</td>
<td>hidprod</td>
<td>Hidden Product ()</td>
<td>Assign</td>
<td>Modify</td>
<td>Related</td>
<td>Delete</td>
</tr>
<tr>
<td>95</td>
<td>inkjet001</td>
<td>Inkjet Printer (50)</td>
<td>Assign</td>
<td>Modify</td>
<td>Related</td>
<td>Delete</td>
</tr>
</tbody>
</table>
Products shown in red will denote that they are out of stock (if using stock management). The number in brackets refers to the number of items left in your inventory. Use the quick entry drop down on the left hand side to quickly update the product values. If you want to add the increase all the products by the same value, place the number in the field next to the "Add" button. Changes won't be made until you hit the "update button at the bottom of the list.

If you see a product with a red asterisk next to it (*) then it means that the category the product has been assigned to has been deleted. If you are using any discounts or coupons at product level then these can be assigned here once the discount has been set up in the discount admin page. To modify an existing product, click on the modify button, to clone an existing product hit <Ctrl> + Modify. The related column is used for the upselling features added in version 5.1.

**Adding products**
Below we have laid out some help with the various fields available when setting up a new product. Fields marked with an asterisk (*) are obligatory.
Reference
The product ID must be a unique identifier.

Prod Name
The name of your product.

Section
Choose from the categories you have set up as to where you want to place the product. Use the Additional Sections option below to place your product in more than one category.

Price
The price of the product.

Wholesale Price
This is used in conjunction with the customer login feature and will be the price that logged in customers will see.

**List Price**
This will show a price with a strikethrough like this List Price: $50.00 on the product and product detail pages.

**In Stock**
If you are using the stock management feature then you will see a drop down menu here. Choose in stock to specify the number of items you have in stock. Choose by options if you want set the stock management by product options and then edit the stock level through the product option admin page. If you are not using Stock Management then you will see a box labelled Sell Button, checking that will show a buy button next to the product, unchecking it will show an Out of Stock message. This message can be edited in vsadmin/inc/languagefile.asp / .php

**Display Product**
Checking the box here will display the product on your store. Leaving it unchecked will keep the product information in the database but it won't appear publically.

**Image**
This is the path to the image that appears on the product page. The default location for the product images is the /prodimages/ folder but you can change that. Click on the ... button to browse your hard drive and upload the image you need. For the ASP version you will need to check with your host that the component "ASPupload" is installed on the server and that you have this setting in vsadmin/includes.asp - useaspuploadforimages=TRUE

Click on the "More" button to show up to 5 pictures on the products page

**Large Image**
This is the path to the image that will appear on the product detail page. Click on the "More" button to show up to 5 pictures on the product detail page.

**Giant Image**
This is the path to the image that will be linked from the product detail page. Click on the "More" button to show up to 5 pictures. The linked image can either appear on a new page or in a pop-up window.

**Manufacturer**
Select from the manufacturers set up in the Manufacturers admin page. This can be included on the search page to narrow down search options and be shown on the products page.

**Dimensions**
This option will only appear if you have selected the dimensions box from the main admin settings. If you choose to use dimensions then this will need to be set for all products.

**Product Weight**
The weight of the product that enables the calculation of shipping. This should be expressed as a decimal.

**Product Options**
Select the number of product options that are to be associated to a product.

**Drop shipper**
Select the drop shipper that is associated to the product

**Description**
This is the description that will appear on the product page. You can add HTML here to format the text to your requirements.

**Long Description**
This is the description that will appear on the product detail page. You can add HTML here to format the text to your requirements.

**Exemptions**
Select any exemption that apply to the product. Use <Ctrl> + click for multiple selections.

**Has static page**
Only check this box if you have set up a static product detail page. The product detail page link will take the form of . . .

the_product_name.asp

. . . where the page name will be made of the product name, in lower case with spaces replaced by underscores and non alphanumeric characters removed. You will need to set up the static page previously following our help page on search engine friendly features.

**Recommended**
Tick the box here if you would like this product to be shown as recommended when any other product is added to cart.

**Product Order**
Enter a value here for ordering the products on the publically viewable product pages. These can be in ascending or descending order depending on the setting sortBy=6 / sortBy=7 includes.asp or $sortBy=6; / $sortBy=7; in includes.php.

**Additional sections**
If you would like your product to appear in more than one category then select the number of additional sections here and choose from the available categories.
Once the number is selected you should be presented with the same number of drop downs where it is possible to choose the relevant categories.

**Add. Search Params**
This is where you can place keywords for the product search that don't appear in the product name, id or description. They can be separated by a space and won't appear on the page itself.
Product Options

Product options allow your customers to choose specific attributes or add-ons for each product. This would typically be an item of clothing offered in various colors or a build your own computer system where the buyer can choose the processor, memory, monitor etc. Any price changes are shown in real time - it is also possible to plug-in the weight difference if applicable so shipping can be calculated correctly. Version 4.9.0 saw the introduction of a feature allowing the product option to have its own product id.

Select the “product options” link from the left hand menu of your control panel. Use this page to update your product options.

Setting up a new Product Option

Click on New Option and you should see a screen with this at the top:

The Screen Explained

Option Name: This is the name that is displayed on the products page next to the product it relates to.

Working Name: This is for internal use only and helps identify the product option in the admin section. It may be that you have different product options
for colors depending on the product eg different colors available for socks and shoes.

**Option Style:** Choose to show your product options as a drop down menu, radio buttons or Multiple Purchase.

The Multiple Purchase feature was introduced in Version 5.5.0 and allows customers to select different quantities of product options from the same page before adding them all to cart. It will appear on the product and / or product detail page like this:

```
- Orange (+$5.00)
- Blue (+$3.00)
- Green (+$1.00)
- Mauve (+$4.00)
- Red (+$2.00)
- Yellow
```

**No default:** Select here if there is no default product option to be shown.

**Single line:** Select here if you want the options to appear on the same line rather than one below another.

"**Please Select**" line: If selected this will show the message "Please Select" before the product options.

**Force Selection:** Check this box if you want to force the customer to select a product option for the product they are purchasing.

Below that box, you should see a screen like this:

```
<table>
<thead>
<tr>
<th>Default</th>
<th>Options / Values</th>
<th>Price Diff %</th>
<th>Weight Diff %</th>
<th>Stock Level</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Blue</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

**The Screen Explained**

Click on the Plus button to enter a new product option anywhere in the list.

**Options / Values:** These are the product options that will appear with the product it has been assigned to.

**Price Diff:** If there is a price difference associated to the product option then it can be added here. For example if the option costs $1 more than the base product price then place "1" in the Price Diff box. If the option costs 10% more
than the base product price then check the percentage box and place "10" in the Price Diff box.

Weight Diff: If there is a weight difference associated to the product option then it can be added here. For example if the option weighs 1 kilo over the base product weight then place "1" in the Weight Diff box. If the option weighs 10% more than the base product weight then check the percentage box and place "10" in the Weight Diff box.

Select Options / Alternates to continue configuring the product options

Alt Prod ID: Version 4.9.0 saw the introduction of this feature and version 5.7.0 a complete overhaul to improve functionality. The alt prod id feature allows you to assign a unique product reference to a product option by either creating a completely new id or modifying the existing product id.

This feature can be particularly useful in combination with stock management as you are able to control the inventory of individual items such as a setting stock on long-sleeved blue shirts rather than on the generic shirt product. It also means that each product id can have its own image associated without having to list them separately on the page.

We have set up a separate help page here that gives some background and samples of how this feature can be used.

Alt Image: From version 5.5.0 you can assign different images with the product option choices. This means that as a customer selects a product option the image will change accordingly. In this field you should place the path to the image you want to appear on the products page when an option is selected.

Alt Large Image: This is where you would place the path to the image that would show on the product detail page once an option has been selected.

Checkboxes as Product Options
From version 5.9, product options that are shown as radio buttons will automatically become checkboxes if there is only one option. This enables selecting / deselecting the option and also as a radio button has no sense for a single option as it cannot be deselected. This enables very neat lists of Yes
/ No or Want / Don't want options when set up this way or "Multiple Selection Lists".

Adding a Text Input Option

The text input option is used when you need the customer to add some information regarding the product. This might be a personalized message added to the product or if you are selling domain names, the domain that the customer wishes to buy.

The Screen Explained

Option Name: This is the name of the option that will appear on your store.

Working Name: This is for internal use only and is useful when you have options that could have the same name.

Default Text if any: If you need to populate the field on the store then add the message here. If not then leave blank.

Force Selection: Check this box if you want to force the customer to add some text to the box.

Field Width: The width of the box that will appear on the store.

Field Height: If you set this to a number higher than one then you will create a multiline box, useful when longer input is required.

Assigning a Product Option to a Product

Once you have set up the product options you need you can then assign them to their corresponding products. From the left hand menu select Product Admin and then Modify for the product that needs a new option. On the products admin page you should see a box where you can specify how many different product options (eg color, size) need to be assigned to the product.
Once you assign the number then the corresponding number of drop down choices will appear so you can select the options that need to go with that product.

Frequently asked questions

How can I hide the product options from the products page?
How can I hide the display of the price difference for the product options?

How can I hide the product options from the products page?
For the ASP version add noproductoptions=true to includes.asp
For the PHP version add $noproductoptions=TRUE; to includes.php

How can I hide the display of the price difference for the product options?
For the ASP version add hideoptpricediffs=true to includes.asp
For the PHP version add $hideoptpricediffs=true; to includes.php
Discounts and Coupons

Discounts and coupons are powerful marketing tools that allow you to give your clients special offers on products or categories, allow wholesalers to purchase at special rates, provide incentives through your offline advertising or help clear "difficult to sell" stock amongst many other uses. Once you have set up the discounts and coupons you wish to use on your store you can go back to the product / category admin pages to assign the ones you want to use.

This explains the options you will see when you go to add a new discount or coupon.
Coupon or discount:

The difference between a coupon and a discount is that a coupon will need a special code to be entered during the checkout phase for it to be applicable. A discount however will apply to all of your website visitors, as long as the conditions you can set below are met. Coupons are especially useful therefore for promotions in magazines or through other advertising.

Coupon / Discount Effect:

You can choose between Free Standard Shipping, Flat rate discount or Percentage discount. You can set up more than one coupon or discount at a time to have combinations of these.

- A flat rate discount would be for instance "$20 off if you spend over $150 on our store".
- A percentage discount would be for instance "5% discount on all our goods".

Working Name:

You have to assign a name or phrase to the discount you create. This text will also be shown to your website visitors to inform them of the discounts available so it should be meaningful and short. Examples of "Working Name" would be:

- "Free Standard Shipping on orders of $35 or more"

or

- "10% discount if you buy 3 or more products from our store"

Coupon Code:

If you are creating a coupon, you will need to assign a coupon code. This is the code your website users will need to enter to access the discount. For instance, if your coupon code is GH777733D then in your magazine advertising you could put the following "Special offer for readers of this magazine. Enter the code GH777733D during checkout to receive a 5% discount".

Number Available:

With some promotions you may want to limit the number available. For instance:

- "5% discount to the first 50 people who purchase".

If you do not want to limit the number available, just leave this field blank.
Number Days Available:

Allows you to set a time limit in days. If you do not want to limit the time available, just leave this field blank.

Min Max Purchase Amount:

This allows you to set minimum and maximum purchase limits for discounts to apply and also the ability to include discounts and coupons within a banded range that can be defined here. So for example, spend between $50 and $100 products for a 5% discount - spend between $100 and 150 for a 10% reduction etc.

...or you could have a simple set up like $25 off all orders over $100. If you do not want to use this feature, just leave the fields blank.

Min / Max Quantity:

This allows you to set minimum and maximum limits for discounts to apply and also the ability to include discounts and coupons within a banded range that can be defined here. So for example, buy between 5 and 10 products for a 5% discount - buy between 6 and 10 for a 7% reduction etc.

Also note that if your "banded" discounts have the same name they will only be displayed once which can be advantageous. For instance the case where For every 11 products purchased, get one free.

If you do not want to use this feature, just leave the fields blank.

Repeat every:

This allows you to define how often the discount kicks in

<table>
<thead>
<tr>
<th>Min Purchase Amount:</th>
<th>Repeat Every:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Purchase Amount:</td>
<td></td>
</tr>
<tr>
<td>Min Quantity:</td>
<td>Repeat Every:</td>
</tr>
<tr>
<td></td>
<td>10</td>
</tr>
</tbody>
</table>

In the example above the discount will take effect following the second item purchased and won't be repeated until a further 10 items have been added to the cart ie. a minimum of purchase of 12 items. If you don't require any repetition and just want a flat rate discount then set Repeat Every to 0.

Discount Amount:

The actual amount of the discount. For instance for a Percentage discount of 10%, just enter 10 here. For a flat rate discount of $15, just enter 15 here.

Please note that for Free Standard Shipping, this value is ignored.
Scope:

You may want to have a discount of 5% if your customer buys 5 of a certain product. You may however want to offer a discount of 5% if your customer buys 5 of any product on your website. Likewise if you wanted to offer a discount of 5% if someone spends $50 or more on one particular product, or you may want to offer a discount of 5% if someone spends $50 or more on your website as a whole.

The "Scope" allows you to do both of these types of discount.

You would use the setting "Applies storewide to product totals" for setting up a discount which applies to product totals on total purchase on your store.

Once you have set up a discount of this type it is automatically in effect and you need do no more.

"Assign to cat’s for discounts on category totals" allows you to narrow down the effect of a discount to individual categories. Now go to the categories admin page and you should see a column "Discounts" and click on the "Assign" button.

"Applies storewide but to individual products" would set up a discount that applies to totals of a particular product. Now go to the products admin page and you should see a column "Discounts" and click on the "Assign" button.

"Assign to individual products / cats" allows you to narrow down the effect of a discount to an individual product or category. Once you have created this type of discount, you can then assign it to a particular product or category. To do this, go to your products or categories admin pages and you will see a column "Discounts" with a button

Restrict to certain countries:

This setting only applies to "Free Standard Shipping". It enables you to set free shipping only for orders within a particular country. To set the countries to which free shipping applies, go to your countries admin page and you will see a column "FSA" which stands for "Free Shipping Applies". Only those countries checked will be eligible for free standard shipping. Remember that a rule will have to be set up first in your discount admin page for this to apply.

Quantity Pricing

In version 4.7.0 we introduced the option of quantity pricing. This means you can adjust the price depending on the number of items of a particular product purchased. To access this feature you will need to click on the Quantity Pricing link on your main admin page.
Check the box on the quantity pricing page if you want to show a drop down menu of all product ids you have available when setting up the price breaks. Leaving the box unchecked means that you will have to enter the product id manually.

**Example:**
If you wanted to offer your customers a price break for purchasing multiple quantities enter the details in the boxes provided:
- Purchase 25-49 items for a price of $2.00 each
- Purchase 50-74 items for a price of $1.75 each
- Purchase 75-99 items for a price of $1.50 each
- Purchase 100+ items for a price of $1.25 each

Gift Certificates

In Version 5.6 we introduced the Gift Certificate feature. This allows your customers to purchase a gift certificate on your store for the amount of their choice and send it on to their chosen recipient. The difference between the value of the certificate and the product(s) added to cart is calculated and the difference recorded accordingly. The recipient is notified via an email which includes a personalized message and the code they will need to enter on checkout to redeem the gift certificate.

**Setting up the Gift Certificate page**

**ASP Version:** Save products.asp as giftcertificate.asp and then in code view find the line

```html
<!--#include file="vsadmin/inc/incproducts.asp"
```

and change it to

```html
<!--#include file="vsadmin/inc/incspecials.asp"
```

Upload to your server and make sure it is working as it should.
If you don't want to set up your own gift certificate page then you can just add a link in your menu to proddetail.asp?prod=giftcertificate and that will show the gift certificate page.

**PHP Version**: Save products.php as giftcertificate.php and then in code view find the line

<?php include "vsadmin/inc/incproducts.php" ?>

and change it to

<?php include "vsadmin/inc/incspecials.php" ?>

Upload to your server and make sure it is working as it should. If you don't want to set up your own gift certificate page then you can just add a link in your menu to proddetail.php?prod=giftcertificate and that will show the gift certificate page.

### Purchase Gift Certificates

- **Amount:**
- **To:**
- **From:**
- **Recipients Email:**
- **Confirm Recipients Email:**
- **Message:**

![Submit Button]

### Using the Gift Certificate

Once the customer has filled in the form you can see above they will go through checkout as normal. The store owner will receive notification via email of the purchase as well as the buyer and the recipient.

The recipient can then go on to the store and use their gift certificate to purchase the product of their choice. On checkout they will see a field to enter their unique code.

<table>
<thead>
<tr>
<th>Coupon or Discount Number:</th>
<th>SM176321917A</th>
<th>Apply</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gift Certificate Applied</td>
<td>SM176321917P (Remove)</td>
<td></td>
</tr>
</tbody>
</table>

If the value of the gift certificate is higher than the item purchased then the remaining amount will be saved for use at a later date. If the shopping cart
total is higher than the value of the gift certificate then they can continue with the checkout and pay the difference through the store.

**Gift Certificate admin**

When you click on the Gift Certificate Management link in the home page of your control panel, you should see a screen similar to this

![Gift Certificate Management Screen](image)

From this screen you can view all the active and inactive gift certificates as well as generating new ones if you need to.

Listing the results will show a screen like the one below

<table>
<thead>
<tr>
<th>Certificate #</th>
<th>To</th>
<th>From</th>
<th>Amount</th>
<th>Remaining</th>
<th>Date</th>
<th>Modify</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>UN102656594Y</td>
<td>Vince</td>
<td>Andy</td>
<td>$55.00</td>
<td>$55.00</td>
<td>5/23/2006</td>
<td>Modify</td>
<td>Delete</td>
</tr>
<tr>
<td>NC176564194M</td>
<td>You</td>
<td>Me</td>
<td>$15.99</td>
<td>$15.99</td>
<td>5/30/2008</td>
<td>Modify</td>
<td>Delete</td>
</tr>
<tr>
<td>TN13964466G</td>
<td>Vince</td>
<td>Andy</td>
<td>$55.00</td>
<td>$55.00</td>
<td>6/2/2008</td>
<td>Modify</td>
<td>Delete</td>
</tr>
</tbody>
</table>

This provides a summary of the gift certificates that have been purchased on the store and their current status. Clicking on the Modify button will give you the chance to see the full details as well as the ability to make changes, view the orders and issue a refund.
Gift certificate emails

When a gift certificate is purchased an email is sent to the buyer and the recipient, confirming the order and including the gift certificate code that will be redeemed on checkout. You can edit the contents of the email through the Email Message Admin page.

Gift certificate tweaks
Disable payment types for gift certificate purchase
You may want to disable some payment types if offering gift certificates on your store. For example using Email or Capture Card would mean that the customer receives the certificate before payment. To specify a list of payment providers you want to disable you need to set...

noemailgiftcertorders="4,10" in vsadmin/includes.asp
or
$noemailgiftcertorders="4,10"; in vsadmin/includes.php

...where each number is the id of the payment provider listed in the payment provider admin page. In this case email (4) and capture card (10).

Set minimum value for gift certificates
If you need to set up a minimum purchase value for the gift certificate you will need to set the following...

giftcertificateminimum=10 in vsadmin/includes.asp
or
$giftcertificateminimum=10; in vsadmin/includes.php

Donations
The donations feature introduced in version 5.6.0 allows customers to introduce an amount of their choice and then go through checkout to send the funds on to the store owner. This is typically used if you want accept donations on the store or if you need customers to pay for a service.

Setting up the donations page

ASP Version: Save products.asp as donations.asp and then in code view find the line

<!--#include file="vsadmin/inc/incproducts.asp"-->

and change it to

<% explicitid="donation" %>
< !--#include file="vsadmin/inc/incspecials.asp"-->

Upload to your server and make sure it is working as it should. If you don't want to set up your own donations page then you can just add a link in your menu to proddetail.asp?prod=donation and that will show the donations page.

PHP Version: Save products.php as donations.php and then in code view find the line
<?php include "vsadmin/inc/incproducts.php"; ?>

and change it to

<?php
$explicitid="donation";
?>
<?php include "vsadmin/inc/incspecials.php"; ?>

Upload to your server and make sure it is working as it should. If you don't want to set up your own donation page then you can just add a link in your menu to proddetail.php?prod=donation and that will show the donations page.

Make A Donation

*Amount: 
From:
Message:

Submit

How it works

Once the customer has filled out the form shown above they will be taken to checkout as they would with a regular product. After checking out the customer and the store owner will receive confirmation emails and the payment will be posted to the admin orders page.

<table>
<thead>
<tr>
<th>Product ID</th>
<th>Product Name</th>
<th>Options</th>
<th>Quantity</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>donation</td>
<td>Donation</td>
<td>From: Andy</td>
<td>1</td>
<td>$200.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Message: Here's something for the beer fund</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Order Total</td>
<td></td>
<td></td>
<td></td>
<td>$200.00</td>
</tr>
<tr>
<td>Grand Total</td>
<td></td>
<td></td>
<td></td>
<td>$200.00</td>
</tr>
</tbody>
</table>

Manufacturers

The manufacturers feature allows you to assign products to manufacturers and display in a category format along with their logo and description. Here is a sample of how the page might look.
Clicking on the logo or manufacturer name will take you to the page where all the products you have assigned to the manufacturer will appear.

**Setting up the manufacturers page**

Setting up the page is very simple indeed. Make a copy of of categories.asp or categories.php and save it as manufacturers.asp or manufacturers.php There is nothing more to it than that.

**Setting up a manufacturer through the control panel**

In your admin main page of the store control panel, click on the link entitled "Edit Manufacturers" and the click on the button "Click to Add New".

The only obligatory field is the name of the manufacturer. The address / contact details of the manufacturer will not be displayed publicly on the store.
Only enter an URL for the static page if you plan using the static page feature, otherwise leave it blank.

Once you have set up the Manufacturers you should see them displayed in the admin like this

<table>
<thead>
<tr>
<th>Order</th>
<th>ID</th>
<th>Name</th>
<th>Modify</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Adidas</td>
<td>Modify</td>
<td>Delete</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>Babolat</td>
<td>Modify</td>
<td>Delete</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>Head</td>
<td>Modify</td>
<td>Delete</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>Nike</td>
<td>Modify</td>
<td>Delete</td>
</tr>
</tbody>
</table>

The order column is the order that they will be listed on your public Manufacturers store page. The id is the identifier of the manufacturer in the database and can be used in conjunction with the static page feature.

Assigning a product to a manufacturer
To assign a product to the manufacturer you will need to go to the product admin page and click on Modify for the product you wish to add. Select the Manufacturer from the drop down choices

Click on Submit at the bottom of the products admin page and that's all there should be to it.

Tweaks

Adding the manufacturers link to the main categories page
If you want a link in with your main categories to the manufacturers page you set up then all you need to do is set up a new category and call it "Products by Manufacturer" for example. Then in the Category URL (Optional) field enter the URL of the page ie manufacturers.asp or manufacturers.php. Please note that discounts / coupons cannot be applied to this category, they would need to be applied to the individual products or the main category those products were placed in.

Setting up static pages
If you want your manufacturer product pages to have a static URL then carry out the following:

ASP Version: Save products.asp as yourstaticpage.asp. Find the line
<!-#include file="vsadmin/inc/incproducts.asp"-->
and just before it add
<% explicitmanid=1 %>
...where "1" is the id of the manufacturer.

PHP Version: Save products.php as yourstaticpage.php. Find the line
<?php include "vsadmin/inc/incproducts.php" ?>
and just before it add
<?php
$explicitmanid=1;
?>
...where "1" is the id of the manufacturer.

Finally in your manufacturers admin page, add the static URL to the field labeled "Static URL (optional)".

**Dynamic titles and meta tags**
The manufacturers page will allow for these [search engine friendly](#) features.
Chapter 4
Orders, Affiliates, Email messages and customer login

Orders admin
Order details
Order status types
Affiliates program
Drop shipping
Email message admin
Customer login
Orders admin

Hopefully the Orders Admin page will be the one you will visit most so it is important to know your way around. You will receive a notification email for each order that is placed through your store but it is a good idea to check the page regularly in case the purchaser didn’t make it back to your store after buying and the email notification wasn’t triggered.

Clicking on the View orders link should bring up the orders admin page:

The interface here will provide you with all the information on orders as well as the ability to search your order database, change the order status, download orders etc.

The various options on this screen are outlined below:

To refine the search options you can select one or a combination of parameters:

Orders From / On – Orders Till: This is where you can specify a date range. Clicking on the “DP” button will bring up a calendar for easier date selection:

It is also possible to add single numbers to the From / Till fields. If you need to view orders between the last 2 to 4 days then place 2 in the Orders From box and 4 in the Orders Till. If you need all orders for the previous 4 days then place 4 in the Orders From box and leave the Orders Till field blank.

Order ID: if you know the order id you want to check then placing the number here will bring up the details of that particular order eg. Type “503” to view the details of order number 503.

Search Text: This will allow you to perform a search selecting from the following parameters:

Order ID
Email address
Auth code
Name
Address
Zip
Phone number
Product name
Affiliate id
Invoice number
Extra checkout fields

... and can be further refined by choosing the date selection, payment method, state, country and/or Order Status. This will also come in useful for your marketing when you can make advertising decisions based on where your orders are coming from.

**Dump orders to CSV file:** Clicking here will prompt a download of the orders. This can be opened in Excel. It will give details of the order such as address, price, quantity and shipping.

**Dump details to CSV file:** This will also include the product information.

**New Order:** Click here to manually enter an order. From version 5.9 if you start typing someone's email address that they have used for past orders or have created a client login account with, the system will now look up that email and any addresses that are associated with it. Selecting the email will populate the address fields and also, in the case of a customer account link the account to the order created. If you start typing a new product id in the product id field, or product name in the product name field the system will search for matches and populate a drop down list to select from. When you select from that list (or click the "...") button as before) the product details / prices are retrieved from the server. You will need to make sure you have checked the box "Use Auto Complete Feature" in the top left of the admin orders page.

**Packing slips:** Select the orders using the checkbox next to each order to view multiple packing slips on the same page. When printed they will print on separate sheets.

**Invoices:** Select the orders using the checkbox next to each order to view multiple invoices on the same page. When printed they will print on separate sheets.

**Order details**

When viewing the order admin page or looking at the results of a search you will be presented with a table of results:
Order ID: This is the order number and the first order on your store will be “501”. Click on the order number or on the Name to bring up the full details of that particular order.

Printing the invoice / packing slip
If you select Printable Packing Slip or Printable Invoice from the drop down menu you will be presented with a printable version.
You can add your own header, address and footer to smarten it up – to do this you will need to make the changes in your vsadmin/includes.asp file there are details in our Advanced tweaks chapter and on our parameters page.

Method: This will show how the client has paid. Information in red will indicate an uncompleted order.

Auth code: This is a very important field and particular attention should be paid to the message that appears here. Under normal circumstances, when an order goes through an authorization code will appear here – this means that the order has been received and the purchaser has returned to your store and should have received email notification of their purchase. If you see an “authorize” button, as in the example above, the most likely reason is that the buyer abandoned the cart before going through with checkout. It may be that they changed their mind, suffered a power failure or were simply testing the system, however it may also be possible that they never made it back to your store after purchase. For this reason it’s important to check with your credit card processing admin page before deleting or authorizing. If you find that the order did in fact take place then you can click on the authorize button and add the authorization code given by the payment processor. If there is no record of the order you can delete from the drop down in the “Status” field.

IMPORTANT NOTE
If a customer goes to the checkout page then backs out to the cart again the order totals may be shown as zero. This is an incomplete order and hasn't been paid for. The only reason they are left there is for the user's information, such as if you see a lot of incomplete orders you might want to check why customers are not going through with the purchase.
When the customer makes payment and returns to the site the order is "closed". IF after making payment and returning the order is not closed (you would notice there is still an "authorize" button on the admin orders page) then you should check the setup of your payment processor or ask for help on our support forums.
One thing to note, if you are using the email methods of checkout and set emailorderstatus to less than 3 then the order will not be closed properly as orders with status less than 3 are not authorized.

Modification warning: If you see the message "Modification Warning" it means that the customer has gone back from checkout and modified their order. The order will be unauthorized so check with your payment provider to see if payment was actually made or not. This is particularly important where payment is made on the payment provider site where instead of going on to
the store thanks page, the customer hits the back button to change the items in their cart.

**Status:** This is where you can set the status of your order and the default options are unauthorized, cancelled, deleted, authorized, packing, shipping, shipped, completed. It is possible to change these values in Admin Order Status page to give a clearer message to the public if they choose to view the status of their order.

Using Internet Explorer on a PC there is a quick method for changing lots of order status at once. If you say change an orders status to "Shipped" and hold down the Ctrl key the all the orders on that page will have the status changed to shipped. This is not available on other browsers.

**Purge deleted:** Once an order is deleted, it will remain in the system for 3 days – this is a security measure in case an order is deleted by mistake. Selecting “purge deleted” will remove all trace of deleted orders.

**Referrer:** (Version 5.7.0 required) This is the referring URL that was clicked to reach your site. If an order doesn't show a referring URL, the most likely reason is that the address was typed directly into the browser or the referrer could not be determined.

At the bottom of the page it is possible to quickly flick through date ranges, for example, orders from a month ago, a week ago, yesterday etc.

**Editing order details**

Version 4.9.0 saw the introduction of the ability to edit all the clients’ order details. To use this feature select Edit Order Details from the drop down menu and click on the name of the purchaser.

You will then be presented with the full order details in form fields. All of these can be edited but do remember to click on "recalculate" and "update" after making any changes.

If you need to edit one of the product options click on the box under Product ID and the Options field will appear with a drop down of available choices.

![Options Field](image)

If you need to add more items to the order then click on the "+" button, to remove products click on the "-" button. Remember to recalculate the order after changes have been made.
Order status types

It is possible to configure up to 18 parameters for the order status by clicking on the “Edit Order Status Types” on the main admin page.

The first four options are pre-defined ie. Cancelled, Deleted, Authorized, Unauthorized. It is possible to change the text that the public will see when checking their order status but the meaning will be kept the same. For example changing the wording for “Authorized” will not change it’s meaning for the store software.

Use this page to update order status types.

<table>
<thead>
<tr>
<th>Private Text</th>
<th>Public Text</th>
<th>Send Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status 0:</td>
<td>Cancelled</td>
<td>Order Cancelled</td>
</tr>
<tr>
<td>Status 1:</td>
<td>Deleted</td>
<td>Order Deleted</td>
</tr>
<tr>
<td>Status 2:</td>
<td>Unauthorized</td>
<td>Awaiting Payment</td>
</tr>
<tr>
<td>Status 3:</td>
<td>Authorized</td>
<td>Payment Received</td>
</tr>
</tbody>
</table>

Please note that even though you can change the text of Order Status Types above this line, they will keep the same meaning. For instance a Deleted Order will still be a Deleted Order, no matter what it is called. Order Status types below this line can be freely edited and will mean whatever you want them to mean.

| Status 4:      | Packing             | In Packing       | ✓  |
| Status 5:      | Shipping            | In Shipping      | ✓  |
| Status 6:      | Shipped             | Order Shipped    | ✓  |
| Status 7:      | Completed           | Order Completed  | ✓  |

The following fourteen order types are free to edit as you wish.

The customer can view their order status details through the page www.yourstore.com/orderstatus.asp/php

View Order Status

Please enter your order id and the email address used on the order.

Order ID : 

Email : 

View Order Status

ASP: If you do not have this page on your ASP site then open the page products.asp save it as orderstatus.asp and then in HTML view find the include line:

<!--#include file="vsadmin/inc/incproducts.asp"-->

© Ecommerce Templates
and change it to:

<!--#include file="vsadmin/inc/incorderstatus.asp"-->

Save the page and upload to your server with the other store pages in the root of your web.

**PHP:** If you do not have this page on your PHP site then open the page products.php save it as orderstatus.php and then in HTML view find the include line:

```php
<?php include "vsadmin/inc/incproducts.php"; ?>
```

and change it to:

```php
<?php include "vsadmin/inc/incorderstatus.php"; ?>
```

Save the page and upload to your server with the other store pages in the root of your web.
Affiliates program

This enables you to run a complete affiliate suite from your site - potential affiliates can sign up and enter their information and password, and you can view the orders they generate through the online admin section.

How the affiliate program is run is completely up to you - you decide on the percentage that will be paid out, how often and by what method - all the partner needs to do is place a link on their site including their partner code to earn commission.

By default the affiliate cookie is set to 30 days - this means that if someone visits your site through an affiliate link one day and buys on another the partner will earn the commission as long as 30 days haven't passed since their first visit. You can change how long you want a cookie to stay active in the file vsadmin/includes.asp/php

If you need to specify a default percentage that your referrers will earn, you will need a minimum of version 4.5.0 and add the corresponding parameter in the vsadmin/includes.php / .asp page

How to set it up
Basically everything is in place for you to get started immediately - each template comes with a file called affiliate.asp/php - this will be where the partner can sign up and also log on to their account.

Affiliate Partners Program

Open new affiliate account: Go

For those who already have an affiliate account.

Affiliate ID: 

Password: 

Login to your affiliate account

The partner can choose to be notified by email of each affiliate sale that is made and the store owner can check the status of the account through the online admin. You may want to make a page or two previous to affiliate.asp/php explaining the procedures etc. for earning commissions and also a disclaimer.

Important information
The referring URL will typically be in the form of http://www.ecommerceltemplates.com/default.asp?PARTNER=name - you
can ask affiliates to link to individual pages or sections by changing the URL before the question mark, for example
http://www.ecommercetemplates.com/products.asp?PARTNER=name but it's very important that the page is linked to is a .asp/.php page and includes the following lines of code:

**ASP version:**
```
<!--#include file="vsadmin/db_conn_open.asp"-->
<!--#include file="vsadmin/inc/languagefile.asp"-->
<!--#include file="vsadmin/includes.asp"-->
<!--#include file="vsadmin/inc/incfunctions.asp"-->
```

**PHP version:**
```
<?php include "vsadmin/db_conn_open.php" ?>
<?php include "vsadmin/inc/languagefile.php" ?>
<?php include "vsadmin/includes.php" ?>
<?php include "vsadmin/inc/incfunctions.php" ?>
```

---

**Drop shipping**

**How it works**
This feature was added in Version 4.8.0 and allows you to group products per manufacturer, designer, dropshipper etc., keep track of the sales per group and includes the ability to send an email notification when a particular order is placed through your store. This may be to the drop shipping company, a manufacturer, a contributor or anyone really you need to notify of a sale.

**How to set it up**
The first thing you will need to do is set up an account for each drop shipper / manufacturer so click on the link Dropshipper / Designer / Manufacturers link from your admin home page and you will be presented with a screen like this.
Click on the button "Click to Add New" and you will be able to set up the details.

Fill in all the details. If you want the drop shipper to receive notification of a sale with details of the order then select "Send Email" from the drop menu. Once you have set up the accounts for each entity you can then choose who needs to be notified from the drop down box on the product admin pages.

Sales can then be tracked through the dropshipping admin page.
The email address is clickable so you can contact the person directly and it's also possible to modify their details or delete the entry from the dropshipping admin page.

You can add your own headers and footers to the dropshipper email as well as customizing the subject line. This can be done through vsadmin/includes.asp or .php.

Email Message Admin

Visual editing of email messages was introduced in Version 5.6.0, making it simpler to format the headers, footers and contents of the various emails generated by the store. This means they no longer need to be added to the vsadmin/includes file and that it is possible to take advantage of the FCK HTML Editor for quick and easy formatting.

Accessing the Email message admin

On the admin home page of the control panel there is link entitled Email Message Admin. Clicking on the link will bring you to the page to select the email you would like to edit.

You will see a message here telling you if you have set HTML Emails to on or off. If you want to switch them on and send HTML emails rather than plain text mails then you will need the following addition to vsadmin/includes.asp

htmlemails=TRUE

or vsadmin/includes.php

$htmlemails=TRUE;

If you are going to send HTML enriched emails then you may want to use the FCK HTML Editor which gives you a wysiwyg interface. If you don't already have it installed then it is available for download on our free downloads page.

Editing the order status email

The order status email can be sent out to customers when you change the status of their order through the admin orders page. You may want to inform customers for example that the status has changed from "Order Received" to "Packing" for example. To always send out an order status email you will need the following addition
to vsadmin/includes.asp
alwaysemailstatus=true

or vsadmin/includes.php
$alwaysemailstatus=true;

When you select Order Status Email from the drop down above you should see the following screen

**Subject:** Order status updated

**Replacement Fields:**
- %orderid% - The order number
- %ordernname% - The name the customer used on the order
- %ordernote% - The status note on the order
- %oldstatus% - The previous status of the order
- %newstatus% - The new order status
- %date% - The date the order status was updated
- %statusinfo% - Any information added to the Status Info field of the order.
- %trackingnum% - The tracking number added to the Tracking field on the order.
- %reviewlinks% - The link to the product review feature

Note: Those in {curly brackets} are conditional. Anything inside those curly brackets will not appear if the value itself is not set. For example if the order has no tracking number then it will be ignored.
**Message:** - This is the body of the email sent when the order status is changed.

**Email headers and footers**

This is where you can add a header and footer to the email that is sent out to a customer following a successful purchase. The header and footer will be included on all confirmation emails so if you want to a different combination depending on the payment method chosen then you would need to edit them separately through the payment provider admin pages.

When you select Email headers and footers you should see a screen like this:

### The screen explained

**Replacement Fields:** %ordername% - This is the name the customer used on purchase and can be included in the email subject

**Subject:** - This is the subject line of the email confirmation

**Replacement Fields:**

- %ordername% - This is the name the customer used on purchase and can be included in the email subject
- %orderdate% - The date the order took place.
- %orderid% - The id of the order.
- %reviewlinks% - The link to the product review submittal page

**Message:** - Anything you add here before %emailmessage% will be used for the header of the confirmation mail. Anything added after %emailmessage% will be used as the footer of the confirmation email. You shouldn't remove the instance of %emailmessage%.

You can add HTML to format the header and footer. From version 5.8 the formatting of the email became a lot more flexible. If you would like your email to appear like this:
Add the following to the Message field above.

```html
<div style="border: 1px solid rgb(152, 0, 72); margin: 0pt auto; width: 100%;"
</style>

%emailmessage%

<br />

<p align="center">Thank you for purchasing from Kids Stuff</p>
Receipt header and footer

This is where you can format the thanks page following a successful transaction.

When you select Receipt header you should see a screen like this one here.

Replacement Fields:
- %ordername% - This is the name the customer used on purchase.
- %orderdate% - The date the order took place.
- %messagebody% - This is the main body of the thanks page which contains the summary of the buyers details, items ordered, shipping, tax and grand total etc.

Message: - Anything you add here before %messagebody% will be used for the header of the thanks page. Anything added after %messagebody% will be used as the footer of the page. You shouldn't remove the instance of %messagebody%.

You can add HTML to the header and footer along with some css for styling the layout. If you would like a thanks page layout like this
Add the following to your css file

```css
.receipthr{height: 0;border-width: 1px 0 0 0;border-style: solid;border-color: #F89961;}
.receipthl{background-color:#9FB5FF;}
.receiptheading{background-color:#F89961;color: #FFFFFF;font-weight:bold; }
```

... and this to the admin message receipt header field

```html
<img height="64" width="206"
src="http://www.yourstoreurl.com/images/receipt.gif" alt="receipt" /><br/>
%messagebody%
```

The available css classes are explained at
http://www.ecommercetemplates.com/help/css.asp#emailreceipt

**Dropshipper header and footer**

If you are using the dropshipper feature then you may want to include a header and / or footer in the email that the drop shipper receives when an order is placed on your store for one of their marked items. It is also possible to have different headers and footers depending on the payment method chosen, in this case you would want to make the edits in the payment provider admin page.

When you select Dropshipper headers and footers you should see a screen like this
The screen explained

**Subject:** - This is the subject line of the email that the drop shipper receives

**Replacement Fields:**
- `%emailmessage%` - This is the main body of the email which contains the summary of the order details received by the drop shipper.
- `%ordertdate%` - The date the order took place.

**Message:** - Anything you add here before `%emailmessage%` will be used for the header of the dropshipper mail. Anything added after `%emailmessage%` will be used as the footer of the dropshipper email. You shouldn't remove the instance of `%emailmessage%`. You can add HTML to format the header and footer.

**Gift certificate email**

If you are using the [Gift Certificate](http://example.com) feature you can format the email sent to the recipient of the gift certificate.

When you select Gift certificate email you should see a screen like this
The screen explained

Replacement fields: %fromname% - This is the name of the person who originally purchased the gift certificate and can be added to the subject line of the email.

Subject: - The subject line of the email received by person the gift certificate was purchased for.

Replacement fields: - These are the variables that can be used in the email and will be replaced by the following:-
%toname% - The name of the person who will receive the gift certificate email
%fromname% - The name of the person who originally purchased the gift certificate
%value% - The monetary value of the gift certificate purchased
%certificateid% - The unique code that needs to be entered on checkout to redeem the certificate
%storeurl% - The URL of the store where the certificate can be redeemed
%message% - The message that the buyer entered on purchasing the gift certificate

Note: Those in {curly brackets} are conditional. Anything inside those curly brackets will not appear if the value itself is not set. For example if the email has no message then it will be ignored.

Message: - This is the body of the email sent to the recipient of the gift certificate. This can be formatted with HTML.
Gift Certificate sender

This is the confirmation email that the purchaser of the Gift Certificate will receive.

When you select Gift certificate sender you should see a screen like this

Replacement Fields: %toname%

Subject: You sent a gift certificate to %toname%

Replacement Fields: %toname%

You sent a gift certificate to %toname%. Below is a copy of the email they will receive. You may want to check it was delivered.

Message: You can edit the introduction and this will be followed by a copy of the text received by the recipient of the gift certificate. You can add HTML to the message for formatting.

The screen explained

Replacement fields: %toname% - This is the name of the person who will receive the gift certificate and can be added to the subject line of the email.

Subject: - The subject line of the email received by the person who purchased the gift certificate.

Replacement fields: %toname% - This is the name of the person who will receive the gift certificate and can be added to the body of the email.

Message: - This is the email that the sender of the gift certificate will receive. You can edit the introduction and this will be followed by a copy of the text received by the recipient of the gift certificate. You can add HTML to the message for formatting.

Notify back in stock email

This is the email received when stock has been replenished and the customer has chosen to be contacted.

When you select Notify back in stock email you should see a screen like this
The screen explained

**Replacement fields:**

%pid% - The product reference the customer is enquiring about.
%pname% - The name of the product that the customer wants to be notified about.

**Subject:** - The subject line of the email received by the person who requires notification.

**Replacement fields:**

%pid% - The product reference the customer is enquiring about.
%pname% - The name of the product that the customer wants to be notified about.
%link% - The link to the product requested.
%storeurl% - The link to the home page of the store.

**Message:** - This is the email that the person requesting notification of stock being available will receive. You can add HTML to the message for formatting.

---

**Customer login**

In Version 4.2.0 we introduced the customer login feature. This allows for wholesale pricing / tax / shipping exemption for login customers and page protection. This means it is possible to offer retail and wholesale pricing without the need for a second database as well as offering tax and shipping
exemption to particular users. You can also restrict access to certain pages of your site.

Version 5.3.0 saw the expansion of the customer login system to allow customers to create their own account, view their order history and save billing and shipping addresses.

**ASP Version**

**PHP Version**

**Enabling customer login (ASP Version)**

If you would like to have a login status box on each page you will need to add one line of code where you would like the login box to appear. The code you need is the following:

```html
<!--#include file="vsadmin/inc/incminilogin.asp"-->
```

Paste that into HTML / code view exactly where the login box should appear and make sure that it comes somewhere after the include lines:

```html
<!--#include file="vsadmin/db_conn_open.asp"-->
<!--#include file="vsadmin/inc/languagefile.asp"-->
<!--#include file="vsadmin/includes.asp"-->
<!--#include file="vsadmin/inc/functions.asp"-->
```

To enable the login you will then need to go to vsadmin/includes.asp and add the line (if it’s not already present) `enableclientlogin=true`

Finally you'll need to set up the login page itself. Open your thanks.asp page and save it as clientlogin.asp. Then go in to HTML / code view and locate this line:

```html
<!--#include file="vsadmin/inc/incthanks.asp"-->
```

....and change it to

```html
<!--#include file="vsadmin/inc/incclientlogin.asp"-->
```

Save clientlogin.asp and upload it to your server.

You should now be able to see the login box and the login page on your store.
Login Box after successful login

Login Status
Logged in as Andy
» Logout

Login Box if enableclientlogin=true hasn’t been set in vsadmin/includes.asp

Login Dialogue on clientlogin.asp

Once you click on login you will be taken to a page to enter your email address and password

Login Details

Email: [Field]
Remember login on this computer?
Password: [Field]  Submit  Forgot your password?

Sorry, your shopping cart is empty

Continue Shopping

Once logged in customers can view their account details, edit their shipping and billing addresses as well as look up past orders. To allow customers to sign up for an account you will need this addition to vsadmin/includes.asp allowclientregistration=true

To force customers to login before purchasing add this to vsadmin/includes.asp forceclientlogin=true

Customers will be prompted on checkout if they would like to log in or set up an account
Setting up a client for wholesale pricing, discounts and shipping / tax exemption

In your home admin page there should be a link **client login admin**, click to set up your clients' options.

Click on **new client login** to add the details and parameters available for each particular customer.

Enter the client login name, email address, password, the relevant action (You can use CTRL + Click to select more than one choice) and finally the login level if applicable. When done, click on submit and your client will have been set up with the parameters you have assigned. The promotional email box if checked will write the client's email address to the database and can be used for mail shots.

**Login level**
You can assign different levels of login permissions on any page to say that a particular page is restricted to anyone below the login level assigned in the login admin section. For example, if you set requiredloginlevel=4 then only people who you have set up with a login value of 4 or above can view the page when logged on. Only place the code on the pages where you need to restrict access, for example, it should not go on clientlogin.asp.

To add the level of restriction to individual pages you will need to add the line:

```html
<% requiredloginlevel=4 %>
```

...where 4 is the threshold of permission for that page. This needs to come anywhere before the line

```html
< !--#include file="vsadmin/inc/incfunctions.asp"-->
```

**Enabling customer login (PHP Version)**

If you would like to have a login status box on each page you will need to add one line of code where you would like the login box to appear. The code you need is the following:

```php
<?php include "vsadmin/inc/incminilogin.php"?>
```

Paste that into HTML / code view exactly where the login box should appear and make sure that it comes somewhere **after** the include lines:

```php
<?php include "vsadmin/db_conn_open.php" ?>
<?php include "vsadmin/inc/languagefile.php" ?>
<?php include "vsadmin/includes.php" ?>
<?php include "vsadmin/inc/incfunctions.php" ?>
```

To enable the login you will then need to go to vsadmin/includes.php and add the line (if it's not already present) `$enableclientlogin=true;`

Finally you'll need to set up the login page itself. Open your thanks.php page and save it as clientlogin.php. Then go in to HTML / code view and locate this line:

```php
<?php include "vsadmin/inc/incthanks.php"?>
```

....and change it to

```php
<?php include "vsadmin/inc/incclientlogin.php"?>
```

Save clientlogin.php and upload it to your server.

You should now be able to see the login box and the login page on your store.
Login Box

Login Status
Not logged in
» Login

Login Box after successful login

Login Status
Logged in as Andy
» Logout

Login Box if $enableclientlogin=true; hasn't been set in vsadmin/includes.php

Login Dialogue on clientlogin.php

Once you click on login you will be taken to a page to enter your email address and password

Once logged in customers can view their account details, edit their shipping and billing addresses as well as look up past orders. To allow customers to sign up for an account you will need this addition to vsadmin/includes.php

$allowclientregistration=true;

To force customers to login before purchasing add this to
vsadmin/includes.php
$forceclientlogin=true;

Customers will be prompted on checkout if they would like to log in or set up an account

Setting up a client for wholesale pricing, discounts and shipping / tax exemption

In your home admin page there should be a link **client login admin**, click to set up your clients' options.

Click on **new client login** to add the details and parameters available for each particular customer.

Enter the client login name, email address, password, the relevant action (You can use CTRL + Click to select more than one choice) and finally the login level if applicable. When done, click on submit and your client will have been set up with the parameters you have assigned. The promotional email box if
checked will write the client's email address to the database and can be used for mail shots.

**Login level**

You can assign different levels of login permissions on any page to say that a particular page is restricted to anyone below the login level assigned in the login admin section. For example, if you set requiredloginlevel=4 then only people who you have set up with a login value of 4 or above can view the page when logged on. Only place the code on the pages where you need to restrict access, for example, it should not go on clientlogin.php

To add the level of restriction to individual pages you will need to add the line:

```php
<?php $requiredloginlevel=4;?>
```

...where 4 is the threshold of permission for that page. This needs to come anywhere before the line

```php
<?php include "vsadmin/inc/incfunctions.php"?>
```

The last thing you need to do is find the code at the top of your page that looks like this:

```php
<?php
session_cache_limiter('none');
session_start(); ?><html>
```

...and change it to:

```php
<?php
session_cache_limiter('none');
session_start();
ob_start(); ?><html>
```

..making sure there is no space before the code and you just have the one opening `<html>` tag.
Chapter 5
Shipping Methods

UPS Shipping
USPS Shipping
FedEx Shipping
No Shipping
Flat Rate Shipping
Weight Based Shipping
Price Based Shipping
Canada Post
Free Shipping
Pack Products
Postal Zones
Shipping Countries
Shipping States
Shipping Estimator
Customer Shipping Carrier Selector
Shipping FAQ
UPS Shipping

Setting up your Ecommerce Plus template to automatically use the UPS Online® Tools Rates & Service Selection to automatically calculate your shipping costs is a simple matter. Just follow the steps below.

Firstly, log in to the admin section for your Ecommerce Plus template and click on "main settings" using the menu on the left. From the Shipping Type dropdown menu select UPS Shipping.

On the same page you will see a setting "Shipping Units" where you can define the weight units that are used to define your product weights. Please note that the shipping units are limited in some countries. Notably, the United States is limited to specifying product weights in lbs and ounces.

Now, go to the Shipping Methods admin page and click on "Register with UPS" and follow the steps in the registration wizard.

After completing the UPS Wizard you are now ready to test your system. Try adding a product to your cart where you know the weight of the product. Then in the checkout phase after filling out your customer and shipping information, you should see the available UPS shipping options along with the associated costs. You should do a couple of tests to make sure they match what you would expect from the UPS online shipping calculator at [http://www.ups.com/](http://www.ups.com/).

**NB.** If you receive the following error at this stage . . .

*This measurement system is not valid for the selected country*

. . . then this means that you have to return to the Ecommerce Plus admin section, "main settings" page to change the Shipping units you are using from lbs and ounces to Kilograms or vice-versa.

If you are using the PHP version and receive blank page instead of the UPS Wizard then contact your host and ask them if they have the cURL component installed. This is a free download and is available on the majority of hosting plans.

**Oversize Packages.**

For each OS1 package, set the product weight to be 30 pounds.

For each OS2 package, set the product weight to be 70 pounds

The way that you deliver your packages to UPS for delivery can affect the total cost of delivering the package. You can change the pick up type by
setting the following in your vsadmin/includes.asp or vsadmin/includes.php file

upspickuptype="03"

The code in quotes there would be taken from the following table...

01 - Daily Pickup
03 - Customer Counter
06 - One Time Pickup
07 - On Call Air
19 - Letter Center
20 - Air Service Center

Remember to enclose the code above in double quotes. Also, please note that these options are not exactly the same as you might find on the UPS website but we hear that is something that UPS are working on.

**UPS Order Tracking**
It's possible for customers to track their orders from a page on your site - if you don't have the tracking page, all you need to do to enable it is take a copy of products.asp and call it tracking.asp
Then go to HTML view and change the line

<!--#include file="vsadmin/inc/incproducts.asp"-->

to

<!--#include file="vsadmin/inc/inctracking.asp"-->

For the PHP version take the page products.php and save it as tracking.php
Then go to HTML view and change the line

<?php include "vsadmin/inc/incproducts.php" ?>

to

<?php include "vsadmin/inc/inctracking.php" ?>

**UPS Negotiated Rates**

For high volume shippers it is possible to display your UPS Negotiated Rates as shipping charges if required. In the admin section on the left can you click on "shipping methods" then on "UPS Admin" you should see the dropdown there for selecting Negotiated Rates. Then follow the instructions there. You should use your UPS Shipper Number in the registration process when you "Register with UPS".
It is a requirement when using negotiated rates to include not just the zip but also the state code and this is true for both US and Canadian addresses. All you have to do to enable this is install the US / Canadian updater. This will put the Canadian Provinces in the drop down menu on checkout as well as the US States and enable the system to include the state/province code. After running the script you will need to reset any tax levels and make sure both the US and Canada are set as "Home Countries" in the countries admin page.

**USPS Shipping**

Setting up your Ecommerce Plus template to automatically use USPS shipping is pretty simple as the majority of the integration has been done for you. Just follow the steps below.

US and overseas shipping costs are automatically calculated according to product weight and destination. To activate USPS shipping method you need to register for a username. The process is quite simple and the registration form is available at . . .

https://secure.shippingapis.com/registration/

You will receive a long email from USPS with information regarding testing the system before going live on the production server. We have already done this step for you so that can be ignored. All that is needed is to follow the instructions for going live on the production server.

The final step for using USPS shipping is to enter your ZIP code in the admin main panel along with your USPS username. These are used in determining shipping costs within the USA.

Once you have selected USPS shipping in the admin main page...

...then you should see a link "Edit USPS Shipping Methods" in your admin shipping page and that is where you can select the shipping methods that your package shipment can use.

All that is left to do is to add the weight of each product as they are added through the product admin section. The shipping cost will then be calculated on checkout depending on the origin, destination and weight of the order.

**IMPORTANT NOTE:** After you apply to the USPS, you will receive an email from them with your username. In this email will be a couple of lines about how to switch your profile to allow you access to the production server. Until
you follow this step you will receive an error in checkout about not being authorized on the server.

**USPS Order Tracking**

It's possible for customers to track their orders from a page on your site - if you don't have the tracking page, you can set it up yourself...

- ASP Version:
  Take a copy of products.asp and call it tracking.asp
  Then go to HTML view and change the line

    <!--#include file="vsadmin/inc/incproducts.asp"-->

  to

    <!--#include file="vsadmin/inc/inctracking.asp"-->

- PHP Version
  Take a copy of products.php and call it tracking.php
  Then go to HTML view and change the line

    <?php include "vsadmin/inc/incproducts.php" ?>

  to

    <?php include "vsadmin/inc/inctracking.php" ?>

**FedEx Shipping**

Setting up your Ecommerce Plus template to use FedEx shipping rates to automatically calculate your shipping costs is a simple matter. Just follow the steps below.

Firstly, log in to the admin section for your Ecommerce Plus template and click on "Main Settings" and scroll down the page. From the Shipping Type dropdown menu select FedEx Shipping.

Select which method you wish to use to calculate shipping.

**Shipping Type:** FedEx Shipping

On the same page you will see a setting "Shipping Units" where you can define the weight units that are used to define your product weights. Please note that the shipping units are limited in some countries. Notably, the United States is limited to specifying product weights in lbs and ounces.
Now click on Shipping Methods from the left hand menu and click on Register with FedEx

<table>
<thead>
<tr>
<th>Edit USPS Shipping Methods</th>
<th>Register with UPS</th>
<th>Edit Shipping Methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit UPS Shipping Methods</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Canada Post Shipping Methods</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit FedEx Shipping Methods</td>
<td>Register with FedEx</td>
<td>Edit Shipping Methods</td>
</tr>
</tbody>
</table>

and follow the steps in the registration wizard. Once you are registered you will want to choose the shipping methods you want to accept on your store so click on the Edit Shipping Methods button and check the appropriate choices.

You are now ready to test your system. Try adding a product to your cart where you know the weight of the product. Then in the checkout phase after filling out your customer and shipping information, you should see the available UPS shipping options along with the associated costs. You should do a couple of tests to make sure they match what you would expect from the FedEx online shipping calculator at www.fedex.com.

**FedEx tracking**

It’s possible for customers to track their orders from a page on your site - if you don’t have the tracking page, all you need to do to enable it for the ASP version is take a copy of products.asp and call it tracking.asp Then go to HTML view and change the line

<!--#include file="vsadmin/inc/incproducts.asp"-->

to

<!--#include file="vsadmin/inc/inctracking.asp"-->

For the PHP version save products.php as tracking.php then go into HTML view and change

<?php include "vsadmin/inc/incproducts.php" ?>

to

<?php include "vsadmin/inc/inctracking.php" ?>
Other Shipping Methods

No shipping

As the name suggests, this is the option to choose if there are no shipping costs involved.

If the cost for the first item is $5.00 and the cost for the second and subsequent is zero then total shipping cost will be $5.00 however many of a product is shipped. Second and subsequent is for one particular product only. If you sell one product x and one product y then both will be charged the first shipping cost. These values can be set in your product admin pages.

Flat rate shipping

If you select flat rate shipping you can enter 2 shipping costs in the product admin section. One is for the cost to ship one of an item, and the second is the cost to ship the second and subsequent instance of an item. First select Flat rate Shipping from the main admin settings page.

If you want it so that store wide to ship one of any product is $XX and to ship any second and subsequent product is $YY then you would have to use weight based shipping.

Weight based shipping

Shipping is calculated by product weight according to the shipping zone to easily facilitate national and international shipping. If weight based shipping is
selected, then the country zone can be set in the countries admin panel, and new zones can be edited by following the Edit Postal Zones link in the main admin panel.

The first thing to do is select weight based shipping in your main admin setting page.

Select which method you wish to use to calculate shipping.

**Shipping Type:** Weight Based Shipping

The system works such that you can set a series of weight limits and shipping costs for packages up to those weight limits. The weight limits are set in the admin postal zones page. The weight can be in pounds, kg, ounces, whatever. You give it meaning by what you enter as the product weight in the products admin page.

**Shipping Information**

Product Weight: 2.4

For instance, if you have entered a weight of 2.4 in the products page, and that to you means 2.4 kilos, then if your weight limit is up to 3 then that is up to 3 kilos also. With the price, that will be whatever the currency you use is. If it is 4.5 and you use dollars, then it is $4.50.

After adding your product weight to the products, you'll need to set up your zones and rules in the admin postal zones page. Set up the names of the zones you would like to use.

**World Zone Rules.**

<table>
<thead>
<tr>
<th>Zone Name</th>
<th>Zone Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 : United States</td>
<td>Edit Rules</td>
</tr>
<tr>
<td>2 : Europe</td>
<td>Edit Rules</td>
</tr>
<tr>
<td>3 : Rest of the World</td>
<td>Edit Rules</td>
</tr>
</tbody>
</table>

Now click on the “Edit Rules” link to set up your weight / price ratio.
If your highest weight is 50 and the price for that is $5.00, and you set "For every 5 above the highest weight add an extra 0.5" then at a weight of 55, the price would be $5.50, at a weight of 60 the price would be $6.00 and so on.

The final step is to make the relation between the zones you have set up and the countries corresponding to those zones. Click on your admin countries link and you should see a full list of counties and various options.

Use this page to update country details for the checkout phase.

<table>
<thead>
<tr>
<th>Country Name</th>
<th>Enabled</th>
<th>Tax</th>
<th>FSA</th>
<th>Position</th>
<th>Postal Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States of America</td>
<td>✔️</td>
<td>0%</td>
<td></td>
<td>On Top of Top</td>
<td>United States</td>
</tr>
<tr>
<td>Great Britain and Northern Ireland</td>
<td>✔️</td>
<td>0%</td>
<td></td>
<td>On Top</td>
<td>Zone 3</td>
</tr>
<tr>
<td>Afghanistan</td>
<td></td>
<td>0%</td>
<td></td>
<td>Alphabetical</td>
<td>Zone 4</td>
</tr>
</tbody>
</table>

**Enabled** Tick the boxes next to the country name for the countries you want to ship to. These will appear in a drop down menu on the checkout page. Some countries have worse reputations than others regarding fraud so you might want to bear this in mind when making your selection.

**Tax** If you need to set a particular tax rate for a country, it can be entered here. For example if you are based in the UK you may be obliged to add VAT to all UK orders, in that case you would want to add 17.5 to the tax box.

**FSA** This stands for Free Shipping Available. Tick the box if you want to offer free shipping to certain countries. In addition you will need to set this up as a discount or coupon in your discount admin page.
**Position** This refers to the position of the country in the drop down menu that appears on the checkout page. On Top of Top will be the first country that appears, On Top will override the rest, which can be sorted alphabetically.

**Postal Zone** Indicates the zones you set up in your admin postal zones page. Use the drop down choices to match the country with your zone.

**NOTE**
Products that have a weight of zero are not considered for shipping. If weight is not important set all weights to zero and set a really high "max weight" limit.

Weight based shipping methods can be disabled at a given weight. On the postal zones admin page, just enter an "x" at the point where a given shipping method ceases to be available.

Weight based shipping can be set as a percentage. To do this just add a percentage sign after the value. eg 10% instead of 10 for the cost.
Price based shipping

The idea here is very similar to weight based shipping but you would need to define the price per postal zone rather than weight.

First select Price based Shipping from your main admin page.

Then click on "Postal Zones". As an example fill in Max Price with 1 in the first column and 1 in the second column - that would mean that the shipping cost of items up to a price of $1 would be $1, and in the example below prices up to $5.00 would be charged at $2.00 - continue like that until you have all the prices you require. The highest price option means that over a price of $50, $0.50 will be added to shipping for every increment of $5 in the price of the product. The examples here are in dollars but of course, this would depend on the currency you are using on your store i.e. “5” could mean dollars, pounds, euros etc.

For every 5 above the highest price...
...add an extra 0.5 for standard shipping

<table>
<thead>
<tr>
<th>Max Price</th>
<th>Standard Charge</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
</tr>
<tr>
<td>10</td>
<td>3</td>
</tr>
<tr>
<td>25</td>
<td>4</td>
</tr>
<tr>
<td>50</td>
<td>5</td>
</tr>
</tbody>
</table>

You would then need to set up your postal zones as explained above in Weight Based Shipping.

NOTE
Price based shipping methods can be disabled at a given price.
On the postal zones admin page, just enter an "x" at the point where a given shipping method ceases to be available.

Price based shipping can be set as a percentage. To do this, just add a percentage sign after the value. E.g., 10% instead of 10 for the cost.

Canada Post
You will first need to obtain a Retailer ID from Canada Post. You can then enter that in your main admin page to get started along with the Post Code from where you will be shipping. After receiving the Retailer ID, Canada Post will need to put you into production mode, until then you can set this switch for the ASP or PHP version to have it in test mode. From there you can also opt to use product dimensions. These additions are made to your vsadmin/includes.asp /.php page.

Free shipping

This option is used in conjunction with discounts and coupons. It enables you to set free shipping only for orders within a particular country which match the criteria you stipulate in the discount set up eg. free shipping for all orders over $100. To set the countries to which free shipping applies, go to your countries admin page and you will see a column "FSA" which stands for "Free Shipping Applies". Only those countries checked will be eligible for free standard shipping. Remember that a rule will have to be set up first in your discount admin page for this to work and that it will apply store-wide. This is not available for flat rate shipping.

Pack products

For USPS, UPS, Price and Weight Based shipping there is a choice of packing products together or separately, this can be found on the main admin page.

Postal zones

This option is only shown if you have chosen Weight Based or Price Based shipping. The first screen is a "named" list of the zones you wish to support. The names are for your own purposes only really, and can be anything like "Zone 1", "Europe", "Eastern Europe" or whatever has meaning for you. Once you have added some zone names and clicked submit, go back to this page and you will see that there is a link "Edit Zone Rules" next to the zone names. The first column is a list of weight limits. The second column is a list of costs. The actual scale of the weight limits is irrelevant really and can have any meaning you wish, such as ounces, kilograms, pounds etc.

If you want ALL zones to have multiple shipping methods click on the link on the postal zones page:

Please click here to set all zones to use multi shipping methods, like "Standard" and "Express" shipping.

If you only want certain zones to have multiple shipping methods then click on "Edit Zones" for that postal zone and click on the link:

This zone is set to only use one shipping method. To use multi shipping methods for this zone, like "Standard" and "Express" shipping, please click here.
There are regional updaters here, which will allow you to replace the US States with UK Counties, Canadian Provinces etc. 
Note: From version 4.3.0 up to 5 shipping methods for weight / price based shipping are now available. (Previously 2 were available.) You can also set the shipping method name on the admin zones page per shipping zone.

**Shipping countries**

The store software displays a list of worldwide countries in the checkout phase, and their attributes can be edited here. Firstly you can choose if you wish to ship to the country at all. Be careful when deciding this as it is tempting to support every country to increase sales, but unfortunately some also attract more fraudulent orders than others. Country tax can be set on this page also. The figure is expressed as a percentage, so for instance if a country incurs 16% tax, then just enter 16 in the box provided. 

The position can be used to set the order the countries are displayed in the checkout drop down. "On Top" will put that country on the top of the list. "On Top of Top" will put that country above that even. This means that you can have the "United States" above the "United Kingdom", and then the rest in the usual alphabetical order. 

If you have chosen "Weight based shipping" you are also given the option to set the shipping zone that applies to that country. We have ordered the countries roughly into the United States, the Americas, Europe and the rest of the world, but do examine these carefully for the countries you decide to ship to.

**States**

The store software displays a list of the US states in the checkout phase, and on this page you are given the option of supporting that state, and if shipping to that state incurs any State Taxes.

**Shipping estimator**

This feature was introduced in version 4.9.0 and allows your customers to be presented with an estimate of their shipping costs from the cart and before going through checkout. They need to select the country and / or state where they are purchasing from and they will be presented with the cheapest shipping method available depending on the information you have set up for shipping choices in the admin.
This is an optional feature and can be switched on through includes.asp / includes.php

ASP Version -> Add this line to includes.asp to switch on the feature...
estimateshipping=TRUE

If you are using weight based shipping that is split into state zones then you will need to define the State where you will be shipping from
defaultshipstate="California"

PHP Version -> Add this line to includes.php to switch on the feature...
$estimateshipping=TRUE;

If you are using weight based shipping that is split into state zones then you will need to define the State where you will be shipping from
$defaultshipstate="California";

**Customer shipping carrier selector**

Another feature added in version 4.9.0. This allows customers to choose between shipping carriers on checkout and select the price and method that best suits them. On the final checkout page they will be presented with a drop down list of carriers that you have defined and they can check the cost of each available price option and make their selection.

<table>
<thead>
<tr>
<th>Please select a shipping option from those below.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parcel Post (2-7 days) £4.23</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Or select an alternate shipping carrier to compare rates.</th>
</tr>
</thead>
<tbody>
<tr>
<td>USPS Rates</td>
</tr>
</tbody>
</table>

Checkout
This is an optional feature and can be switched on the main admin settings page.

In version 5.6.0 we added the ability to show the alternate shipping methods with radio buttons instead of the default drop down menu choices.

<table>
<thead>
<tr>
<th>Check totals and proceed to process payment.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Total Goods:</strong> $100.00</td>
</tr>
<tr>
<td><strong>Shipping:</strong></td>
</tr>
<tr>
<td>☑ Parcel Post (2-7 days) $6.67</td>
</tr>
<tr>
<td>☑ Priority Mail (1-2 days) $12.95</td>
</tr>
<tr>
<td>☑ Express Mail (Overnight to most areas) $16.50</td>
</tr>
<tr>
<td><strong>Handling:</strong> $10.00</td>
</tr>
<tr>
<td><strong>Or compare rates with:</strong></td>
</tr>
<tr>
<td>☑ UPS Rates</td>
</tr>
<tr>
<td>☑ USPS Rates</td>
</tr>
<tr>
<td>☑ Weight Based Rates</td>
</tr>
<tr>
<td>☑ FedEx Rates</td>
</tr>
<tr>
<td><strong>Grand Total:</strong> $116.67</td>
</tr>
</tbody>
</table>

You must click below to complete the checkout process.

To achieve the above layout you will need the following:
in vsadmin/includes.asp
shippingoptionsasradios=TRUE

or in vsadmin/includes.php
$shippingoptionsasradios=TRUE;

**Shipping FAQ**

Can I use multiple shipping methods?
I don't need to charge a per item shipping...someone can order 1 product or 20 products and I charge the same amount - I want them to have the option of choosing either standard or express and not be charged per item.
I want to charge $5 for the first item entered into the cart, and then $1 for each additional item. What method should I use?
How do I set up shipping based on a percentage of the final sales price?
How do I add tax to shipping?

Can I use multiple shipping methods?
It’s not possible to mix ‘n’ match domestic shipping methods but you can give your customers a choice of carrier on checkout. From version 5.0 it is also possible to use a different shipping method for domestic and international orders by selecting from the drop down menu in the main admin settings.

I don't need to charge a per item shipping...someone can order 1 product or 20 products and I charge the same amount - I want them to have the option of choosing either standard or express and not be charged per item.

Using weight based shipping, set every product a very low weight, (say 0.1). Then set up your postal zones with only one rule per zone, which has a very high max weight, (say 9999) and the cost as your shipping cost. On the admin main page make sure "pack products together" is set.

I want to charge $5 for the first item entered into the cart, and then $1 for each additional item. What method should I use?

Use weight based shipping and set every weight to 1 to make things easy. Then in the postal zones section, set the rules so that a weight of 1 is $5, a weight of 2 is $6 and for each 1 above the highest weight add an extra $1.

How do I set up shipping based on a percentage of the final sales price?

In the admin main page set up the shipping type to price based shipping. Then for the postal zones admin page click on edit rules, and then just set something like...

for every 1 above the highest weight add an extra 0.2 which would charge shipping at 20%.
for every 1 above the highest weight add and extra 0.35 ..which would add shipping at 35%.

The first example for instance would round to the nearest 20 cents of course, but you could say

for every 0.5 above the highest weight add an extra 0.1

How do I add tax to shipping?

Open the file vsadmin/includes.asp or php and change taxShipping=0 to taxShipping=1.
Chapter 6
Design Issues

Introduction
Using Fireworks
   Editing text
   Editing graphic colors
   Batch processing
Frontpage Issues
   Frontpage includes
   Frontpage includes (ASP)
   Frontpage navigation (ASP)
   Frontpage includes (PHP)
   Configuring Frontpage for PHP
Dreamweaver issues
GoLive Issues
Cascading Style Sheets (CSS)
DHTML menus
Dynamic CSS menus
Content Management System
Dynamic Spry Tabs
Introduction

The great thing about working from templates is the simplicity of setting up the design of your store to reflect your products and needs. The hard work of preparing the layout of the store is already done for you – from there you can change color schemes, add your own graphics and modify the existing ones.

All the templates come with .png files. These can be edited in Fireworks from Adobe – they have a 30 day free trial available if you don’t already have the program.

Graphics and sections, which are repeated on many pages, are usually set up as include pages for Frontpage, components for GoLive or form part of the Dreamweaver .dwt file or library items.
Using Fireworks

You don’t have to own a copy of Fireworks to work with our templates but it does make graphic editing simpler. The .png files are found in the images/extras folder. There are blank gifs which you can use in other graphics programs to add your own text to.

Editing text

File>Open and browse to the image you need to edit and click on the text tool, the icon is an “A”

Place your cursor on the text and type your wording.

Save your graphic by going to File>Export Preview
Choose the format (usually as a GIF) and settings you want for the graphic, paying particular attention to file size / quality.
You can change the color of the text by choosing the select tool (the white arrow).

Click on the graphic and select the color from the properties window.

You can also change the font by selecting from the drop down list in the same window.

If you need to change the background color choose Modify>Canvas>Canvas Color.
Effects such as drop shadow, bevel etc. can be added by clicking on the plus sign next to the word "effect" in the properties window and selecting the options until you get the look that best suits your needs.
Editing graphic colors

Most of the templates have small rounded corner graphics, menu tops or bottoms etc., which are easily changed. These usually consist of a background color, which can be changed as above and a rounded image which is modified by selecting it and changing the color in the properties window.

Often a graphic is made up of different layers – in Fireworks you can see them in the Layers Window.

Click on the name and you’ll see the layer highlighted and the properties window will show the color and any effects that have been applied.

You can change the color of the individual elements (layers) by clicking on the color next to the paint icon and selecting the color of your choice.
NB There are quite a few windows available in Fireworks, probably the most important being the tools and properties – if you don’t see these, select them from the “window” menu at the top of the screen.

Always export your graphic by going to File>Export Preview and choosing the format (usually as a GIF) – it’s best not to use .png files on your site as not all browsers recognize the format and the file size will be much larger too.
Batch processing

A very useful feature of most graphics programs is the ability to change a large number of graphics to the same specifications. This is really useful for the ecommerce templates when preparing the product images for the product and product detail pages.

The first thing to do is place all your images in a folder on your hard drive. Then open Fireworks and choose File > Batch Process from the top menu.

Browse to the folder where you saved your images and select the ones you want to change or choose to select them all.
Now you can set up the rules for the changes you want to make to the images. For photos you will probably want to export the picture as a .jpg file. And you’ll probably want to set a uniform size. To avoid distorting the graphic it’s best to set the width (in the example at 150 pixels) and allow the height to scale accordingly by choosing variable...
The Rename and Commands options probably won’t be needed. Click on next and you will be given the option of where you would like to save your newly modified files and the option of saving the script so it can be used again at a later date.

Clicking batch will modify all the files you selected to the specifications you set up.
Frontpage issues

The majority of the colors on the templates are cell backgrounds, which can be changed by right clicking on the cell in normal view and choosing “cell properties”.

You can then select the color of your choice.
Frontpage includes

All the Frontpage ecommerce templates use include files. These allow you to update the whole site by making changes on a single page. They are typically used for news items, header and footer sections - anything really that appears the same on all or most of the pages on a site. The include pages are kept in a folder called /includes/. We've added a brief explanation below on how to use them with the ASP and PHP templates.

The ASP templates use Frontpage includes - they're very simple to use and can be added to and deleted at will.

Modifying an include page (ASP Version)

In Frontpage folder view, open the includes folder and double click on the file you want to change. Make the modifications and on saving, all the pages that are linked to that include file will be automatically updated. There are only a couple of things to be wary of. If the include file uses graphics, make sure that your new graphics will fit into the space provided for them. Some include files, typically ones used for news sections, use smaller text. This is achieved through .css class - take a look at the code and you'll probably see something like this: <td class="smaller"> or <p class="smaller"> - if this is the case, and you want to maintain the look, you may need to manually add the class to the
<p> tag when adding a new paragraph. Speaking of <p> tags, be careful as sometimes Frontpage will add them to your code, both on the include page and the main page which contains the include - this may cause some extra spacing to occur and will mess up your design, particularly in Netscape 7. To delete them open the page in HTML view, delete and save, making sure you have the "Preserve existing HTML" box checked in Page Options. There is further help on using CSS in this chapter.

**NB.** Only code that is between the opening and closing <BODY> tags will be read in include files, so if you have to put some script into the <HEAD> section, it will have to be moved to the <BODY> section.
Modifying an include page (PHP Version)

There are a couple of issues with the Frontpage version when using the PHP templates. Frontpage extensions do not work with pages with the .php extension, so this means that FrontPage Includes and FrontPage Navigation do not work. We have found a neat way around these issues, but there are a couple of things to bear in mind.

First, for include pages, we have just used PHP includes. It's already set up for you, and you will find the included pages in the includes folder. Unlike FrontPage includes however, all links will be relative to the file that is doing the including. So, for this reason we recommend you use links relative to the site root if you want to use the same include files in folders and sub folders.

Examples of different ways to link pages are . . .

This is a relative link: mypage.php
This is a link relative to the site root: /mypage.php
This is an absolute link: http://www.mysite.com/mypage.php

The include page will not show up when you preview in a browser, so you'll need to upload the site to your server to view your modifications. There is a utility that will allow you to view your changes in Frontpage and they have a 30 day free trial available.

You can also work "live" on the server:

How to work "live" on the server

Open Frontpage
Select File > Open Web

In the box that appears type your full URL eg. http://www.yourdomain.com/
You'll now be prompted for your Frontpage user name and password

Once verified, your site will be open and live, any changes you make on "saving" will be made to your live site

**PHP includes and navigation**

Because FrontPage Navigation is not available, you will have to make up and over buttons for the navigation. (This does not apply to templates which use DHTML PopOut menus as navigation or text based menus.) To change navigation, open the page which contains the navigation. (Normally includes/leftnavigation.htm.) You will see some lines of code such as . . .

```
// Add your rollovers here.
// First the link, second the normal button image, third the "over" button image
addrollover('about.php','images/menu/about.gif','images/menu/aboutov.gif');
addrollover('services.php','images/menu/services.gif','images/menu/servicesov.gif');
addrollover('links.php','images/menu/links.gif','images/menu/linksov.gif');
addrollover('support.php','images/menu/support.gif','images/menu/supportov.gif');
addrollover('emailtoandy@lizwebdesign.com','images/menu/email.gif','images/menu/emailov.gif');
```
To add buttons to the navigation, just add extra lines here, or edit the existing ones. The parameters are:

The link.
This can be relative: about.php
or relative to the site root: /about.php
or absolute: http://www.mysite.com/about.php
The "normal" state of the image: images/menu/about.gif
The "mouseover" state of the image: images/menu/aboutov.gif

The same rules apply about relative links as for the FrontPage Includes however.
Configuring Frontpage for PHP

If Frontpage doesn't recognize the .PHP pages, you'll need to configure it like this:

In Frontpage go to Tools>Options>Configure Editors

Choose "Add"

Put PHP for file type
Put the same information as you have for htm, html etc. - this is usually:
Editor Name: FrontPage
Command: frontpg.exe
Adding a new page
The simplest way to add new pages to your site is to open an existing page, such as about.htm and save it under a new name, such as new.htm. If the template uses Frontpage navigation then remember to drag the page into navigation view so that the menu shows up correctly.

Frontpage tip: Be careful not to drag the borders of your cells and tables in an attempt to change the layout – always work with cell and table properties.
Dreamweaver Issues

Remember that before making any changes to a Dreamweaver template you will first need to define your site by selecting Site > New Site from the Dreamweaver top menu. There are full details in our introductory chapter.

Main.dwt
Global changes should be made in the file Templates/Main.dwt. These will typically be the header, menu and footer sections. On making a change to the file Main.dwt you will be asked if you want to update all the files using the template

Agree to the prompt and all the pages will be updated. If you are not prompted then it probably means that your site hasn’t been defined.

News.lbi
The news section will typically be a library file and if present will be found in the Library folder. This file can be used to update all the pages that are linked to it. If you need different news sections on different pages, save New.lbi under a new name, make the text changes and drag it into the place on the page where the original library item was located.

Editable Regions
Content which is unique to each page will be set up as an Editable Region. The main body of content will be typically called “Body” and is represented by a light blue box around the area that can be edited.

The cursor will show as an arrow within an editable region and as a circle with a line through it in the locked region of the page.

To change the background colors in Dreamweaver, click in the cell in design view and then select the bg color from the Properties Window.
Adding a new page
The simplest way to add new pages to your site is to open an existing page, such as about.htm and save it under a new name, such as new.htm.
GoLive Issues

The first thing to do when you’ve opened up Adobe GoLive is to go to File > Open from the top menu.

Browse to the folder where you extracted the template to and locate the .site file.
You should then see the listing of all the files and folders that make up your GoLive shopping cart.

![Image of a file directory with various files and folders]

You'll find the package has some sample pages, the store .asp/php pages and a number of folders. To make site-wide changes to the design, adding your company name, changing the menu etc. you'll need to work from the components. These can be opened by double clicking on the various components that make up a page.

![Image of a company name highlighted in blue]

Once you've made the changes, save the file and you'll be prompted if you want to update all the files using this template - agree to the prompt and you should be able to see the modifications you've made.
Adding a new page
The simplest way to add new pages to your site is to open an existing page, such as about.htm and save it under a new name, such as new.htm.
Cascading Style Sheets (CSS)

On the ecommerce templates we use cascading style sheets (css) to allow you to easily manage the font and hyperlink properties. In the root of your web you will have a file typically called style.css and on each page a link to it like this `<LINK REL=STYLESHEET TYPE="text/css" HREF="style.css">`. This can be edited in Frontpage, GoLive or Dreamweaver by double clicking on it or can be opened and modified in a text editor like Notepad.

**Editing the hyperlink properties with CSS**

After opening the file you should see some lines like this:

```css
A:link {
    color: #3366FF;
    text-decoration: none;
}

A:visited {
    color: #3366FF;
    text-decoration: none;
}

A:active {
    color: #3366FF;
    text-decoration: none;
}

A:hover {
    color: #FF9966;
    text-decoration: none;
}
```

The parameters are pretty clear, any hex value will suffice for the color and if you require an underline when the cursor passes over a link, change "none" to "underline". Note that some browsers, notably Netscape 4x will ignore the hover option.

**Editing the font properties with CSS**

The font type and size is also set in the css file, here's an example:

```css
TD {
    font-size: 12px;
    font-family: Verdana,Arial;
}

P {
    font-size: 12px;
}
This means that all text that is between <TD> or <P> tags will be Verdana, size12 - if Verdana is not installed on the user's machine then it will revert to Arial. If you want to change the color of the text from the default then add a line like this for red text:

```css
TD {
font-size: 12px;
font-family : Verdana,Arial;
color: #CC0000;
}

P {
font-size: 12px;
font-family : Verdana,Arial;
color: #CC0000;
}
```

Editing the horizontal rule properties with CSS

This line of code will give you a blue horizontal rule, one pixel in height:

```css
HR {
height: 0;
border-width: 1px 0 0 0;
border-style: solid;
border-color: #006AC8;
}
```

**Using CSS classes**

CSS classes allow you to vary your styles on a page, for example giving a section smaller text or different link properties - this can be really handy when for example you have light and dark backgrounds and you need your links to show up well on both. Here's an example of using a class for hyperlink properties:

```css
A.dark:link {
color: #FFFFFF;
text-decoration: none;
}

A.dark:visited {
color: #FFFFFF;
text-decoration: none;
}
```
This will give you white links with an orange mouseover. To apply it to individual links you'll need to add the class like this:

```html
<a class="dark" href="mylink.html">link text</a>
```

To change text size or color between `<TD>` or `<P>` tags you might have something like this:

```css
TD.smaller {
  font-size: 11px;
  font-family: Verdana;
  color: #CC0000;
}

P.smaller {
  font-size: 11px;
  font-family: Verdana;
  color: #CC0000;
}
```

This will give you red 11 pixel size text when you add a class like this for a paragraph:

```html
<p class="smaller">
...or for the cell
</p>
```

### Editing the category layout

In version 4.1.0 we added the possibility of showing the categories in multiple columns rather than in one vertical list. As people will want to align the text and images in different formats, we added CSS classes to make the modifications as simple as possible.
The first thing you will want to do is set up the category format that best suits your site, this involves adding a parameter to your vsadmin/includes.asp or vsadmin/includes.php files, depending on your version.

Next thing to do is open your CSS file, this is found in the root of your store and is typically called style.css or stylesheet.css

Copy and paste these lines into the CSS file:

```css
P.catname {
    text-align: center;
    margin-top: 0px;
    margin-bottom: 4px;
    vertical-align:top;
    text-align: center;
}

P.catdesc {
    margin-top: 0px;
    margin-bottom: 4px;
    vertical-align:top;
}

IMG.catimage {
    border:1px;
    border-thickness: 1px;
    border-color: #000;
    border-style: solid;
    vertical-align:top;
}

TD.catimage {
    vertical-align:top;
}

TD.catname {
    vertical-align:top;
    text-align: center;
}

TD.catnavigation {
    vertical-align:middle;
    text-align: left;
}

The classes explained

P.catname: The alignment of the category name
P.catdesc: The alignment of the category description
IMG.catimage: The properties of the category image
TD.catimage: The alignment of the category image
TD.catname: The alignment of the category name
TD.catnavigation: the alignment of the top category navigation

Some examples

Using the settings as listed above would show the category page as in the example here:

*Home » Printers and Scanners » All Products*

View all products in all categories.

**Scanners.**
RGB color scanners and scanner based systems for everything from digital snaps to professional prints.

**Printers.**
Inkjet and laser printers for the very best in home and small office printing systems.

**Digital camera.**
Great digital camera for all your imaging needs.

**Printer paper.**
Top quality paper for your printer, office and home use.

If you would like the titles and text left aligned and without an image border, the CSS would need to be changed like this:

```
P.catname {
text-align: center;
margin-top: 0px;
margin-bottom: 4px;
vertical-align:top;
text-align: left;
}

P.catdesc {
margin-top: 0px;
margin-bottom: 4px;
vertical-align:top;
}

IMG.catimage {
border:0px;
border-thickness: 1px;
border-color: #000;
border-style: solid;
vertical-align:top;
}
TD.catimage {
  vertical-align:top;
}

TD.catname {
  vertical-align:top;
  text-align: left;
}

TD.catnavigation {
  vertical-align:middle;
  text-align: left;
}

...and the layout would look like this:

[Image]

To move the top navigation to the right, change

TD.catnavigation {
  vertical-align:middle;
  text-align: left;
}

to

TD.catnavigation {
  vertical-align:middle;
  text-align: right;
}

The best thing is to play around with the settings until you find the one that best suits your site. You can always come back here to get the default settings if you run into difficulty.
Editing the mini cart and mini login

There are two CSS classes that can be used in conjunction with the mini cart and mini login. If you purchased a template with the mini cart incorporated then these classes should already be present in style.css, if not you can add these (Please note the class is called mincart, not minicart:

```
TD.mincart {
  font-size: 10px;
  font-family: Verdana;
}

P.mincart {
  font-size: 10px;
  font-family: Verdana;
}
```

This will make the text size 10px and the font Verdana.

If you want different link properties from the rest of your main links, use something like this

```
a.mincart:link {
  color: #006699;
  text-decoration: none;
  font: 11px Tahoma, Arial, Helvetica, sans-serif;
}

a.mincart:visited {
  color: #006699;
  text-decoration: none;
  font: 11px Tahoma, Arial, Helvetica, sans-serif;
}
  a.mincart:active {
    color: #FFFFFF;
    text-decoration: none;
    font: 11px Tahoma, Arial, Helvetica, sans-serif;
  }
  a.rightlinks:hover {
    color: #FFFFFF;
    text-decoration: none;
    font: 11px Tahoma, Arial, Helvetica, sans-serif;
  }
```

Editing the price color
In version 4.1.6 we added the possibility of changing the color of the price from the style sheet. All you need to do is add the following to style.css, this example would make the price show as red:

```css
SPAN.price {
COLOR: #FF0000;
}
```

**Editing the product options properties**

In version 4.2.0 we added the possibility of changing the format of the product options from the style sheet. All you need to do is add the following to style.css, this example would make the text show as red with Verdana 11px font:

```css
SELECT.prodoption {
font-size: 11px;
font-family : Verdana;
color : #FF0000;
}
```

If you are using stock management with the product options, introduced in version 4.4.0, it's possible to "grey out" the options which are no longer in stock by adding the following to your main style.css file

```css
OPTION.oostock {
color : #A0A0A0;
}
```

If you want to edit the text that introduces the product option then you need these classes (Version 5.2.2 required)

```css
SPAN.prodoption {
font-size: 11px;
font-family : Verdana;
color : #FF0000;
}
```

```css
SPAN.detailoption {
font-size: 11px;
font-family : Verdana;
color : #FF0000;
}
```

To format the multi-options introduced in version 5.5.0, use the following class

```css
SPAN.multioption {
font-size: 11px;
font-family : Verdana;
}
```
color : #FF0000;
}
This will change the text to red that accompanies the quantity boxes in the multi option feature on the product and product detail pages.

Editing the top product navigation

In version 4.6.0 we added the possibility of changing the format of the top product navigation eg. Home >> Product from the style sheet. All you need to do is add the following to style.css, this example would make the text show as red with Verdana 11px font:

td.prodnavigation {
  font-size: 11px;
  font-family: Verdana;
  color: #A0A0A0;
}

P.prodnavigation {
  font-size: 11px;
  font-family: Verdana;
  color: #A0A0A0;
}

Editing the table backgrounds

Version 4.7.0 allows you to set the table and cell background properties in the files search / tracking / order status / checkout via CSS classes. From version 5.7.0 this was extended to include emailfriend.asp / .php.

The new classes are:
TABLE.cobtbl for the table.
TD.cobhl for the cell highlights
TD.cobll for the cell lowlights

For example the following addition to your style.css file would give you a search table looking like this:

<table>
<thead>
<tr>
<th>Search For:</th>
<th>Max Price:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Search Products" /></td>
<td></td>
</tr>
</tbody>
</table>

TABLE.cobtbl{
  background-color: #FF0000;
}

Editing the page numbers

In version 4.7.0 we added the possibility of changing the format of the page numbers from the style sheet. All you need to do is add the following to style.css, this example would make the page numbers show as Verdana size 12:

```css
P.pagenums {
  font-size: 12px;
  font-family: Verdana;
}
```

In version 5.1 you can also change the appearance of the page number currently being viewed for example:

```css
SPAN.currpage {
  color: #FF0000;
  font-weight: bold;
}
```

...would show a page number bold and in red like this:

```
<1234567890>
```

Editing the currency format

In version 4.7.0 we also included the possibility of changing the format of the alternative currencies. All you need to do is add the following to style.css, this example would make the currencies show in Verdana, size 10 and gray:

```css
SPAN.extracurr {
  font-size: 10px;
  font-family: Verdana;
  color: 666666
}
```
In version 4.9.0 we added some new classes which are specific to the product detail page:

- div.detailid: The properties of the text "Product ID"
- div.detailname: The properties of the product name on the product detail page
- div.detaildiscounts: The properties of the discounts text for the product detail page
- td.detailimage: The alignment of the product image on the product detail page
- img.prodimage: The properties of the product image
- div.detaildescription: The properties of the text in the long product description
- div.detailoptions: The properties of the product options on the product detail page
- div.detailprice: The properties of the price on the product detail page
- div.detailcurrency: The properties of the alternative currencies on the product detail page

The product page

In version 4.9.0 we added some new classes which are specific to the product page:

- div.prodid: The properties of the text "Product ID"
- div.prodname: The properties of the product name on the product page
- div.proddiscounts: The properties of the discounts text for the product page
- td.prodimage: The alignment of the product image on the product page
- img.prodimage: The properties of the product image
- div.proddescription: The properties of the text in the short product description
- div.prodoptions: The properties of the product options on the product page
- div.prodprice: The properties of the price on the product page
- div.prodcurrency: The properties of the alternative currencies on the product page

Editing the number of items in stock message

In version 5.0.0 we added the ability to show the number of items in stock in the products page. This is the class that governs the look of the entry.

```
div.prodinstock {
  font-size: 10px;
  font-family : Verdana;
  color: 666666
}
```

Editing the productbody3 display

In version 5.0.0 we added a new product layout, which by default should look something like this
The set up of this layout requires the productbody3 setting in includes.asp or includes.php

These are the classes associated with the display:

- `table.cpd`: outer table background color which forms the outlines of the cells.
- `td.cpdll`: cell background.
- `td.cpdhl`: header background.
- `div.cpdhlide`: product id header.
- `div.cpdhlimage`: product image header.
- `div.cpdhlname`: product name header.
- `div.cpdhldescription`: product description header.
- `div.cpdhldiscounts`: discounts header.
- `div.cpdhllistprice`: list price header.
- `div.cpdhprice`: price header.
- `div.cpdhpricetaxinc`: price including tax header.
- `div.cpdhlinstock`: number in stock header.
- `div.cpdholoptions`: product options header.
- `div.cpdhlnumber`: quantity box header.
- `div.cpdhbuy`: buy button header.
- `div.prod3id`: product id properties.
- `div.prod3name`: product name properties.
- `div.prod3discounts`: discounts properties.
- `div.prod3description`: product description properties.
- `div.prod3listprice`: list price properties.
- `div.prod3price`: price properties.
- `div.prod3pricetaxinc`: price including tax properties.
- `div.prod3instock`: number in stock properties.
- `div.prod3quantity`: quantity box properties.
- `div.prod3buy`: buy button properties.

For example to have a table looking like this:

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Price</th>
<th>Quantity</th>
<th>Purchase</th>
</tr>
</thead>
<tbody>
<tr>
<td>pc002</td>
<td>#1 PC multimedia package</td>
<td>$50.00</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>pc001</td>
<td>#1 PC multimedia package</td>
<td>$1,200.00</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>testproduct</td>
<td>Cheap Test Product</td>
<td>$0.01</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>scanner001</td>
<td>Flatbed scanner</td>
<td>$89.00</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>inkjet001</td>
<td>Inkjet Printer</td>
<td>$0.00</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>lprinter001</td>
<td>Laser Printer</td>
<td>$499.00</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
Editing the list price display

In version 5.1.3 we added the possibility of editing the list price display, typically people would want to center the text like this:

```html
div.listprice {
  text-align: center;
}
```

Please note that the strikethrough and font color are set in vsadmin/inc/languagefile.asp / .php

For the product detail page the class would be `div.detaillistprice` and was added in version 5.2.6

Editing the cart thumbnail image

Version 5.4 saw the introduction of adding a thumbnail image to the cart. This has its own class:

```html
img.cartimage {
  width: 100px;
}
```
Editing the link properties in the store pages

Version 5.4 also saw the addition of a new class for all links in the store and they can be set like this:

```
A.ectlink:link {
    color: #333;
    text-decoration: none;
}
A.ectlink:visited {
    color: #333;
    text-decoration: none;
}
A.ectlink:active {
    color: #333;
    text-decoration: none;
}
A.ectlink:hover {
    color: #8D2800;
    text-decoration: none;
}
```

Editing the sku properties

The SKU display introduced in Version 5.4 can be formatted like this for the product page:

```
div.prodsku {
    color: #333;
}
```

... and for the product detail page:

```
div.detailsku {
    color: #333;
}
```

Editing the manufacturer properties

The Manufacturer display was introduced in Version 5.5 and can be formatted like this for the product page:

```
div.prodmanufacturer {
    color: #333;
}```
... and for the detail page

```css
div.detailmanufacturer {
color: #333;
}
```

If you want the same formatting on both the product and product detail page then just set the div.prodmanufacturer class.

**Editing the product reviews and ratings format**

These are the classes available for the product reviews and rating features introduced in Version 5.5.0:

- `span.review reviewheader` (the title of the review)
- `span.review numreviews` (the number of reviews and average rating)
- `span.review showallreview` (the text properties for the "Show all")
- `hr.review` (the horizontal rule)
- `span.review clickreview` (the text properties of the "Click review")
- `span.review reviewname` (the name of the person and date of review)
- `span.review reviewcomments` (the comments left for the review of the product)

To achieve the following layout:

```
1 Product Reviews - Average rating 10 (Show All)
Click to review this product

Good Product

Click to review this product

Andy - 2/20/2008
This is a very good product
```

... add the following to your css file

```css
.review {
color: #000;
font-weight: bold;
}

.showallreview, .reviewcomments {
color: #000;
font-weight: normal;
```
In version 5.6.0 we introduced the ability to show the rating on the products page. The two new classes are

- `div.prodrating` - the text of the rating
- `img.prodrating` - the ratings image properties

**Extra image classes**

There are two classes associated with the extra images. This for example will control the formatting of the text "1 of 5"

- `span.extraimage` { color: #CC0000; }
- `span.extramagenum` { color: #000; }

**Giant images**

The text associated with the giant image has two classes

- `.giantimgname` { background-color:blue; }
- `.giantimgback` { background-color:yellow; }

- will give the product name a blue background
- will give the "Back to product page" text a yellow background.

**The add to cart button**
From version 5.7.0 there is a new class that can be applied to the cart button. One simple tweak would be to make the cart button line up nicely with the quantity box like this

```
.buybutton{
  vertical-align:bottom;
}
```

You could also look to style the button through css.

**Gift registry and Wish lists**

The Gift Registry feature has the following css classes

- `span.cartloginname` - the name of the person logged in
- `p.cartloggedin` - the text for "Logged in as" and "Logout"
- `span.cartwishlists` - the text for "View Gift Registries" on the cart page

The List screen uses the same classes as the cart and other table backgrounds.

**Product search filter**

To show the product filter text and input box like this

```
Search within these products:<input type="text">
```

... use the following css

```
td.prodfilter {
  color: #44BA04;
  font-weight:bold;
}
```

```
input.prodfilter {
  border: 1px solid #44BA04;
  background-color: #EDEDED;
}
```

**Email and thanks page receipts**

These are the classes associated with the email receipt

- `.receiptbody` - the background color of the email receipt
- `.receiptoption` - the background color of the product option row
- `.receipthr` - the horizontal rule
For an email layout like this

![Email Layout Example](image)

Use the following css

```css
.receiptbody{background-color:#FFF6F2;}
.receiptoption{background-color:#FFE6E6;}
.receipthr{height: 0;border-width: 1px 0 0 0;border-style: solid;border-color: #9EBE25;}
.receipthl{background-color:#FDD6E8;}
.receiptheading{background-color:#980048;color: #FFFFFF;font-weight:bold; }
```

For the thanks page to get a layout like this
<table>
<thead>
<tr>
<th>Details</th>
<th>Name</th>
<th>Unit Price</th>
<th>Quantity</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>pc#01</td>
<td>#1 PC multimedia package</td>
<td>$0.00</td>
<td>1</td>
<td>$0.00</td>
</tr>
<tr>
<td>Monitor</td>
<td>- 15&quot; Flatron</td>
<td>$75.00</td>
<td></td>
<td>$75.00</td>
</tr>
<tr>
<td>Network Card</td>
<td>- No</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hard Disk</td>
<td>- 20 Giga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Processor</td>
<td>- Intel Pentium III 1.30Hz</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Sub Total $75.00
Shipping $22.88
Handling $10.00
State Tax $7.50
Country Tax $15.00
Grand Total $100.00

Use the following css

```
.receiptoption{background-color:#FFEDB7;}
.receipthr{height: 0;border-width: 1px 0 0 0;border-style: solid;border-color: #F89961;}
.receipthl{background-color:#9FB5FF;}
.recepiptheading{background-color:#F89961;color: #FFFFFF;font-weight:bold; }
```

**Product filter bar**

The class associated with the products filter bar is td.prodfilter

Use the following css

```
td.prodfilter{
background-color:#ececec;
border: 1px dotted #42619a;
padding:4px;
font-weight:bold;
color: #42619a;
}
```

... to style the bar as in the example here
CSS Menus

In version 5.9 we included three new css menus for you to add to your store. These menus are dynamically populated by the categories added through the online control panel so once set up they require no further maintenance. As they are css based you have total control over their appearance. They are also very search engine friendly.

Setting the category root

The first thing you will probably want to do before setting up any of the css menus is to define the hierarchy of categories and products so the system can differentiate between those pages and regular store pages you might add to the menu like the cart or search pages.

Go into the categories admin page and set up a new category as in the example below, checking the box for (Optional) Check to make this category the product catalog root.

On saving the page and viewing the category listing, you should see the entry like this Categories (24) - this indicates the product catalog root.

Next you will want to move all your main categories (not sub-categories) so they hang-off the new category root you have just defined. On those main categories, change Sub Category Of...from Home Category to Categories.
The hierarchy for the sub-categories will be updated automatically so they will look something like this:

<table>
<thead>
<tr>
<th></th>
<th>Categories » Printers and Scanners</th>
<th>Scanners (2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Categories » Printers and Scanners</td>
<td>New Category (22)</td>
</tr>
<tr>
<td>9</td>
<td>Categories » Printers and Scanners</td>
<td>Printers (4)</td>
</tr>
</tbody>
</table>

This setup allows you to differentiate between category / product pages and the general stores pages in the menu like cart and search. It also means you can decide how you would like to display the category links in your menu. If you want to show all the root categories at the same level in the menu set the following:

in vsadmin/includes.asp
menucategoriesatroot=TRUE

or in vsadmin/includes.php
$menucategoriesatroot=TRUE;

If you want all the category pages do be linked off one category link in the menu, set that to FALSE.

**CSS Drop down menu**
The drop down menu is a horizontal menu which displays the home categories horizontally with the sub menus appearing on mouse over as in the image below:

<table>
<thead>
<tr>
<th>Computer Parts</th>
<th>Test</th>
<th>Printers and Scanners</th>
<th>Clothes and Things</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Category</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Second category</td>
<td>Newer Category</td>
<td>Newest Category</td>
<td></td>
</tr>
</tbody>
</table>

To enable the horizontal menu, add the following where you want it to appear...

**ASP Version**
<% menustyle="horizontalmenu1" %>
<!--#include file="vsadmin/inc/incmenu.asp"-->

**PHP Version**
<?php $menustyle='horizontalmenu1'; ?>
<?php include "vsadmin/inc/incmenu.php"?>
... making sure that those lines come somewhere after the 4 main ASP / PHP include lines.

You will now want to change the appearance of the menu so it fits into your existing design. The menu above uses the following css that can be added to your main css file, in most templates this is called style.css.

```css
ul.ectmenu1 {
  list-style: none;
  border:0px solid;
  color:#ffffff;font:bold 14px Arial, Helvetica, sans-serif;
  padding:0px;
}
li.ectmenu1 {
  border:1px solid;
  padding:4px;
  background-color: #e69d01;
  text-align:left;
}
li.ectmenu1 a{
  color: #fff;
  padding:4px;
}
li.ectmenu1 a:hover{
  color: #333;
  padding:4px;
}

The classes explained
ul.ectmenu1 - The properties of the horizontal home categories
li.ectmenu1 - The properties of the drop down choices
li.ectmenu1 a - The link properties
li.ectmenu1 a:hover - The mouse over properties

CSS Pop out menu
The pop out menu is a vertical menu which displays the home categories vertically with the sub menus appearing on mouse over as in the image below

To enable the pop out menu, add the following where you want it to appear...

ASP Version
PHP Version

You will now want to change the appearance of the menu so it fits into your existing design. The menu above uses the following css that can be added to your main css file, in most templates this is called style.css.

ul.ectmenu1 {
    list-style: none;
    border:0px solid;
    font-size:10px;
    padding:0px;
    background-color: #fdedc9;
}
li.ectmenu1 {
    border: 1px dotted #e69d01;
    padding:0px;
    background-color:#fdedc9;
}
li.ectmenuhassub1 a{
    display:block;
    padding:4px;
    background-image:url(images/arrow.gif);
}
li.ectmenuhassub1 a:hover{
    display:block;
    padding:4px;
    background-image:url(images/arrowov.gif);
    background-color: #e69d01;
    color: #fff;
}
li.ectmenu1 a{
    display:block;
    padding:4px;
}
li.ectmenu1 a:hover{
    background-color: #e69d01;
    color: #fff;
}

The classes explained
ul.ectmenu1 - The properties of the vertical home categories
li.ectmenu1 - The properties of the categories without sub categories
li.ectmenu1 a - The link properties
li.ectmenu1 a:hover - The mouse over properties
li.ectmenuhassub1 a - The properties of the category links which spawn sub-categories
li.ectmenuhassub1 a:hover - The mouse over properties of the category links which spawn sub-categories

CSS Acordion menu
The accordion menu is a vertical menu which displays the home categories vertically with the sub menus appearing below on mouse click as in the image below

<table>
<thead>
<tr>
<th>Computer Parts</th>
<th>V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test</td>
<td>V</td>
</tr>
<tr>
<td>&gt; New Category</td>
<td>V</td>
</tr>
<tr>
<td>&gt; Third level category</td>
<td></td>
</tr>
<tr>
<td>&gt; Second category</td>
<td>V</td>
</tr>
<tr>
<td>&gt; Never Category</td>
<td>V</td>
</tr>
<tr>
<td>&gt; &gt; Newest Category</td>
<td></td>
</tr>
<tr>
<td>Printers and Scanners</td>
<td>V</td>
</tr>
<tr>
<td>Clothes and Things</td>
<td></td>
</tr>
</tbody>
</table>

To enable the accordion menu, add the following where you want it to appear...

**ASP Version**
```asp
<% menustyle="verticalmenu2" %>
<!--#include file="vsadmin/inc/incmenu.asp"-->
```

**PHP Version**
```php
<stdio $menustyle='verticalmenu2' ?>
<stdio include "vsadmin/inc/incmenu.php"?>
```

... making sure that those lines come somewhere after the 4 main ASP / PHP include lines.

You will now want to change the appearance of the menu so it fits into your existing design. The menu above uses the following css that can be added to your main css file, in most templates this is called style.css.

```css
ul.ectmenu1 {
list-style: none;
border:0px solid;
font-size:10px;
padding:0px;
```
The classes explained

ul.ectmenu1 - The properties of the vertical home categories
li.ectmenu1 - The properties of the categories without sub categories
li.ectmenu1 a - The link properties
li.ectmenu1 a:hover - The mouse over properties
li.ectmenuhassub1 a - The properties of the category links which spawn sub-categories
li.ectmenuhassub1 a:hover - The mouse over properties of the category links which spawn sub-categories
li.ectsubmenu1 - The properties of the category which contains products

Adding links to your css menus

You will probably want to add links to non-product and category pages to the menu such as a home page link or a link to your cart. To do this all you need to do is set up a category, and call it "Home" for example. In the field "Category URL (Optional)" enter the page name, typically in this case
default.asp or index.php. Make sure you select "Home Category" when choosing from the drop down, Sub Category Of...

You can adjust where the new page appears on the menu by using the sort order drop down choices on the main category page. These non-product pages can also have their own drop-downs and pop-outs, just select "Sub Category Of..." when defining the new page.

**Multiple CSS menus**

You may want more than one menu on a page, for example a horizontal drop down menu in the top navigation bar and a vertical accordion menu in the left navigation.

**ASP Version**

Add the following where you want the horizontal menu to appear

```asp
<% menustyle="horizontalmenu1" %>
```

```html
<!--#include file="vsadmin/inc/incmenu.asp"-->
```

and then where the accordion menu should appear

```asp
<% displayectmenu("verticalmenu2") %>
```

...or for the pop-out menu

```asp
<% displayectmenu("verticalmenu3") %>
```

**PHP Version**

Add the following where you want the horizontal menu to appear

```php
$menustyle='horizontalmenu1';
```

```php
<?php include "vsadmin/inc/incmenu.php"; ?>
```

and then where the accordion menu should appear

```php
displayectmenu('verticalmenu2');
```

...or for the pop-out menu

```php
displayectmenu('verticalmenu3');
```
You will probably want to style each menu differently and that can be done by changing the number on each of the css classes. For example the properties of the home categories for the horizontal menu would be
ul.ectmenu1
... for the accordion menu that would be
ul.ectmenu2
...and for the pop out menu that would be
ul.ectmenu3
You would change all the css classes accordingly.

Troubleshooting the css menus

I have added the code but the menus are not appearing.

You will need a minimum store version of 5.9. You can check your version number in your control panel, and it should display on all pages. Also make sure you have uploaded all the files from the updater to the server. If you are using two vsadmin folders for security / ssl reasons, both will need updating.

I get an error like "Data source name not found and no default driver specified" or the content of the page doesn't appear.

It's important that the 4 main ASP or PHP lines come somewhere before the incmenu include line. You can move the 4 ASP / PHP include lines further up the code, just after the opening <body> tag for example.

The menu appears but with no design showing.

The css classes above should be added to your main css file, not the one in the vsadmin folder. Make sure the css file has been uploaded to the server and that the page has a line like this that calls that css file
<link rel="stylesheet" type="text/css" href="style.css" />
Content Management System (CMS)

The content management system built in to Ecommerce Template shopping cart software allows you to dynamically add content to your site through the online control panel. You can choose to add the content to existing pages, this might be in the form of news sections or special offers for example or you can set up a whole page content in a dynamic way - this will prove useful if you want to add articles about your products and services or want to control your home page content through the admin for example. The content management system has an optional built-in HTML editor with preview which makes formatting the content a breeze.

Adding dynamic content to existing pages

You will probably want to enable the HTML editor for the content regions as it makes formatting so much simpler. It provides a wysiwyg interface so adding tables, new paragraphs, colors etc can be made with a click or two. It also allows you to preview your work before submitting.

**Maximized editing**

![Maximized editing interface](image)

We offer a 30 day money back guarantee on all our stock.

If you want to use the HTML editor with the content management system, it can be downloaded [here](#). Upload the files to your server and then set the following in vsadmin/includes.asp for the ASP version

```html
htmlEditor="fckeditor"
```

or vsadmin/includes.php for the PHP version

```html
$htmleditor="fckeditor";
```
Now log into your store control panel and click on the link for Content Management, then choose "New Content Region".

**Region Name** [Content name goes here]

[---] [Content Data] [+][++]

```
Content goes here.
```

The field for Region Name is for internal use only so enter a descriptive title there like "Right News Section".

The [---] and [+][++] buttons allow you to control the visual width of the content field. This won't affect the content as it is displayed on your pages but will make it easier to visualize narrow content in the admin.

In the content field, add the details you would like to appear on your pages. If you are using the FCK HTML Editor click on the downward arrow to view the available formatting choices.

Click on "Submit" to save your changes.

You should now see the content region(s) you have set up

<table>
<thead>
<tr>
<th>Region ID</th>
<th>Region Name</th>
<th>Example URL</th>
<th>Modify</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Article - About Us</td>
<td>default.asp?region=2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Article - Contact Details</td>
<td>default.asp?region=3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Footer</td>
<td>default.asp?region=4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>News</td>
<td>default.asp?region=1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Region ID is the identifier you are going to use to add the new content to your page. Open the store page and find the location where you want to add the new content. In code / HTML view add the following ...

**ASP Version**

```
<% regionid=1 %>
<!--#include file="vsadmin/inc/inccontentregion.asp"-->
```

**PHP Version**

```
<?php $regionid=1; ?>
<?php include "vsadmin/inc/inccontentregion.php" ?>
```
... where the regionid number corresponds to the identifier from the admin page shown above. In this example we would be adding the "News" content but if we were adding the "Footer" content, the regionid would be set to 4. That's all there is to it. Now upload your page to the server and check the content is showing correctly. From now on, any modifications made to that region can be carried out through the store control panel.

**NOTE:** Make sure that those lines come somewhere after the 4 main ASP / PHP include lines on your page. If necessary you can move the other 4 lines further up the code to just after the opening <body> tag.

**Setting up content pages**

You may want to set up pages where the whole main content of a page is administered through the store control panel. In this example we are going to set up an articles section and use the content management system to populate the main body of the page.

First of all take an existing page on your site and save it as articles.asp or articles.php depending on which version you are using. Clear out the main body content so you are left with white space in the center of the page. In HTML / code view copy and paste the following:

**ASP Version**

```
<!--#include file="vsadmin/inc/inccontentregion.asp"-->
```

**PHP Version**

```
<?php include "vsadmin/inc/inccontentregion.php" ?>
```

Now go into your store control panel and follow the steps above for setting up a new content region like the "Article - About Us" example in the screenshot. Once you have added your text, and noted the regionid (in this case region 2), save your work and open the following page on your site

```
http://www.yourstoreurl.com/articles.asp?region=2
```

or

```
```

You should see the content you have just added through the control panel within your design. You can now go on setting up more articles through the control panel and changing the "region=2" in the URL depending on the regionid associated to it in the content management admin page.

Using articles.asp or articles.php is just an example and you can name the page whatever you like as long as it is followed by the correct regionid number. For example you may end up with pages on your site like...

```
http://www.yourstoreurl.com/articles.asp?region=2
```
... or whatever you would like to call them.

**Tips and Tweaks**

Although it's not possible to put database driven content like the minicart or recently viewed items within the content regions, there is a very simple workaround. All you need to do is set up two regions and place the minicart or recently reviewed items box between the two.

In the ASP version the set up would be like this on your page if you wanted to have the recently reviewed box in the middle of the content regions:

```asp
<% regionid=6 %>
<!--#include file="vsadmin/inc/inccontentregion.asp"-->
<!--#include file="vsadmin/inc/increcentview.asp"-->
<% regionid=7 %>
<!--#include file="vsadmin/inc/inccontentregion.asp"-->
```

for the PHP version, that would be

```php
<?php $regionid=6; ?>
<?php include "vsadmin/inc/inccontentregion.php" ?>
<?php include "vsadmin/inc/increcentview.php" ?>
<?php $regionid=7; ?>
<?php include "vsadmin/inc/inccontentregion.php" ?>
```

**Troubleshooting the content management system**

I get an error like "Data source name not found and no default driver specified" or the content of the page doesn't appear.

It's important that the 4 main ASP or PHP lines come somewhere before the inccontentregion include line. You can move the 4 ASP / PHP include lines further up the code, just after the opening <body> tag for example.

I can see the content management fields but there's no HTML editor.

If you are using two vsadmin folders for security or ssl reasons the htmleditor="fckeditor" or $htmleditor="fckeditor"; will need to be added to each includes file. Make sure the files have been uploaded to the correct location on the server by uploading the vsadmin folder that comes with the fckeditor download to the root of your store. Check the files have made it over to the vsadmin folder correctly so you should see a partial listing like this...
... with the fckeditor files amongst the store vsadmin files. If you are using two vsadmin folders for security or ssl reasons, make sure you have uploaded the fckeditor files to both.

**Dynamic Spry Tabs**

The dynamic spry tabs allow you to add dynamic content to the product detail page by showing off your product descriptions in tabbed content that you users can access as they choose.

**Getting started with a static tabbed panel**

To use the spry tabs you will need to download the static-tabs.zip file available from our free downloads page and then upload the content of the zip file to your server.

Now open proddetail.asp or proddetail.php in your HTML editor and somewhere before the closing </head> tag, add the following:

```html
<link href="SpryAssets/SpryTabbedPanels.css" rel="stylesheet" type="text/css" />
<script src="SpryAssets/SpryTabbedPanels.js" type="text/javascript"></script>
```

If you want to get started quickly and add one just tab labeled "description", set the following in vsadmin/includes.asp
defaultdescriptiontab="<ecttab title=""Description"">"

or in includes.php

$defaultdescriptiontab='<ecttab title="Description">';

This will give you a one tab layout like this

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet ready PC package. Just choose your monitor, hard disk size, processor speed and network card. As well as a larger image, you can use this “Long Description” to add extra detail or information about your products. You can also include HTML Markup in the short and long product descriptions.</td>
</tr>
</tbody>
</table>

If you want to add reviews and related products tabs to that, go on to the dynamic tabs help section.

If you want to set up your own tabs manually, log into your control panel and open the product admin page to select the product you want to add the spry tab to. In the long description field copy and paste the following

<ecttab title="Tab One">
Tab One
<p>Tab one content.</p>
<ecttab title="Tab Two">
Tab Two
<p>Tab two content.</p>
<ecttab title="Tab Three">
Tab Three
<p>Tab three content.</p>
<ecttab title="Tab Four">
Tab Four
<p>Tab four content.</p>

That will give you a panel with 4 tabs, which should look something like this

<table>
<thead>
<tr>
<th>Tab One</th>
<th>Tab Two</th>
<th>Tab Three</th>
<th>Tab Four</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab Two</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tab two content</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If you want more tabs, you can be adding more lines, for example
<ecttab title="Tab Five">
Tab Five
<p>Tab five content.</p>
The color and dimensions of the tabbed panel is governed by the css file, SpryTabbedPanels.css

Setting up a sliding content panel

If you would prefer a panel where the content slides in, the set up is slightly different.

Download the sliding-tabs.zip file available from our free downloads page and then upload the content of the zip file to your server.

Now open proddetail.asp or proddetail.php in your HTML editor and somewhere before the closing </head> tag, add the following

<link href="SpryAssets/spry_home_image.css" rel="stylesheet" type="text/css" />
<script type="text/javascript" src="SpryAssets/SpryDOMUtils.js"></script>
<script type="text/javascript" src="SpryAssets/SpryEffects.js"></script>
<script type="text/javascript" src="SpryAssets/SprySlidingPanels.js"></script>

There are 3 css files available in the download, depending on the type of tabs you are going to use

If you are going to use images for the tabs (View Demo) - use the following
<link href="SpryAssets/spry_home_image.css" rel="stylesheet" type="text/css" />

If you are going to use css background tabs (View Demo) - use the following
<link href="SpryAssets/spry_home_bgtabs.css" rel="stylesheet" type="text/css" />

If you are going to use css colored tabs (View Demo) - use the following
<link href="SpryAssets/spry_home_colors.css" rel="stylesheet" type="text/css" />
You will now need to add the following to vsadmin/includes.asp

ecttabs="slidingpanel"

or to vsadmin/includes.php

$ecttabs="slidingpanel";

Now log into your control panel and open the product admin page to select
the product you want to add the spry tab to. In the long description field copy
and paste the following

<ecttab title="Tab One">
Tab One
<p>Tab one content.</p>
<ecttab title="Tab Two">
Tab Two
<p>Tab two content.</p>
<ecttab title="Tab Three">
Tab Three
<p>Tab three content.</p>
<ecttab title="Tab Four">
Tab Four
<p>Tab four content.</p>

The color and dimensions of the tabbed panel is governed by the css file,
which contains comments relating to each available class.

Adding dynamic content to the panels

It is possible to add the dynamic product reviews and related items features to
the tabbed panels.

If you would like to add products reviews and related items, you'll need the
following addition to vsadmin/includes.asp

ecttabsspecials="<ecttab title=""Reviews"" special=""reviews"">"<ecttab
title=""Related"" special=""related"">"

or to vsadmin/includes.php

$ecttabsspecials='<ecttab title="Reviews" special="reviews"><ecttab
title="Related" special="related">';

You can format the related items to suit your needs with this addition to
vsadmin/includes.asp
relatedtabtemplate="<tr><td class="reltabimage" rowspan="2">%img%</td><td class="reltabname">%name% <br />%price%</td></tr><tr><td class="reltabdescription">%description%</td></tr>"

or to vsadmin/includes.php

$relatedtabtemplate='<tr><td class="reltabimage" rowspan="2">%img%</td><td class="reltabname">%name% <br />%price%</td></tr><tr><td class="reltabdescription">%description%</td></tr>';

...which will give you a related layout like this

![Related Layout Example](image)

The following parameters are available

%img%
%name%
%id%
%price%
%description%

By default the related and reviews will come after the other tabs but you can place them at the beginning by adding the %tabs% parameter for where the other tabs should be, for example

ecttabsspecials="<ecttab title=""Reviews"" special=""reviews"">"ecttab title=""Related"" special=""related"">%tabs%"

...or the other tabs can come between them

ecttabsspecials="<ecttab title=""Reviews"" special=""reviews"">%tabs%<ecttab title=""Related"" special=""related""">"

If the product has no related items, the related tab will not be shown.

**Replace tabs with icons or images**
In the example above we have used text based tabs but you can replace those with images.

You will need to prepare two images for each of the tabs, one that you view and one that will change on mouse over.

All you need to do then is to change

<ecttab title="Tab One">

to

<ecttab title="Tab One" imgov="images/tab1_ov.png" img="images/tab1.png">

... where tab1.png is the tab that shows when first viewed and tab1.ov.png is the mouse over state.
Chapter 7

Tweaks

Introduction
How to add a buy button to your home page
Adding HTML to your product descriptions
Cross selling
Product reviews and ratings
Gift registry and wish lists
Recently viewed items
How to add a search box to each of your pages
Minimum and maximum price search
Introduction

This chapter deals with some of the tweaking you can employ in the ecommerce templates to get even more functionality out of your store.
How to add a buy button to your home page.

This is pretty simple, and of course your buy button can be added to other pages, it doesn’t have to be the home page.

The first thing you need to do is to get the products on your store as you will need to copy and paste some code.

Where you need the button to appear place this code:

```html
<form method="post" action="cart.asp">
<input type="hidden" name="id" value="XXXXXX">
<input type="hidden" name="mode" value="add">
<input type="image" src="images/buy.gif" border="0">
</form>
```

Where xxxxxx is the id of your product.

For the PHP version, change cart.asp to cart.php
Adding HTML to product descriptions

This is a great way of formatting your product pages and product detail pages, sometimes simply spacing out text rather than using blocks can make reading the information much easier. You can use any valid HTML in the product description field. Here are some examples:

<p>To make a double space between lines, put them between opening and closing <p> tags</p>

To add colour to your text put them between font tags like this <font color="#CC0000">This is red text</font>

This is <b>Bold text</b>

Here’s an example of adding an image to the description, for example you might want to add a heading for “special offers” or add extra product photos.

<img src="images/specialoffers.gif" width="350" height="30">

Or you might want to link to another page, manufacturer’s site or wherever:

<a href="anotherpage.htm">Another Page</a>

<a href="http://www.ecommercetemplates.com">Another Site</a>

Also check out the CSS help file for CSS classes that can be used in the product description field. You can also use the tinymce or FCKeditor plug-in available from www.ecommercetemplates.com/free_downloads.asp
Cross Selling

In Version 5.1.0 we introduced the cross selling feature. This allows you to show recommended, best selling and related products as well as the items also purchased by previous customers on the cart page. This feature is particularly useful for upselling products and is extremely flexible and configurable.

**ASP Version**

Initial set up

The first thing you will need to do is open the file cart.asp and find the line

<!--#include file="vsadmin/inc/inccart.asp"-->

...and just after that add the line

<!--#include file="vsadmin/inc/inccrosssell.asp"-->

Save cart.asp

Now you need to define the features you want to appear on the cart page so open includes.asp and add this to the list

crosssellaction="recommended,related,alsobought,bestsellers"

This will show the four features in the order shown there. If for example you only wanted to show bestsellers and related products in that order then you would change the line to

crosssellaction="bestsellers,related"

Save the file includes.asp and then you can start configuring the four features.

**PHP version**

Initial set up

The first thing you will need to do is open the file cart.php and find the line

<?php include "vsadmin/inc/inccart.php" ?>

...and just after that add the line

<?php include "vsadmin/inc/inccrosssell.php" ?>
Save cart.php

Now you need to define the features you want to appear on the cart page so
open includes.php and add this to the list

$crosssellaction='recommended,related,alsobought,bestsellers';

This will show the four features in the order shown there. If for example you
only wanted to show bestsellers and related products in that order then you
would change the line to

$crosssellaction='bestsellers,related';

Save the file includes.php and then you can start configuring the four features.

Configuring recommended products

This will add a row of recommended products that you have chosen from your
inventory to display on the cart page once any item has been added to cart.
The number of recommended products you choose to show is completely up
to as each one you check in the products admin page will appear here.

To configure a recommended product, in your Ecommerce Template control
panel click on products admin and then click "Modify" for the product you want
to show as recommended. At the bottom of the page there is a checkbox like
this:

Recommended: ☑

Check the box if you want it to appear as a recommended product when any
other product is added to the cart.

Configuring related products

Related products are ones that you configure through the product admin
page. They will typically be products that customers who have added a similar
/ complimentary item to cart would be interested in. That may be something
like batteries for an electronic device, a superior model to the one already in
the cart or simply an extra item that you think would be of interest to
somebody who is planning on purchasing. Each related product will be
displayed in rows below the cart.

In your Ecommerce Template control panel click on products admin and then
for the product you want to create relations for click on the "related" button. If
this is the first time you are setting up a relation then you will see a message
there are no related product so then click on "List Products" and you should
see a screen like this where you can select the product which can be related to the item you have selected.

<table>
<thead>
<tr>
<th>Product ID</th>
<th>Product Name</th>
<th>Discounts</th>
<th>Modify</th>
<th>Related</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>fscanner001</td>
<td>Professional Scanner</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>fscanner002</td>
<td>Rubbish Scanner</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>inkjet001</td>
<td>Inkjet Printer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>lprinter001</td>
<td>Laser Printer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>monitor001</td>
<td>PC Monitor</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>mouse001</td>
<td>PC Mouse</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>painttop001</td>
<td>Painttop Computer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>pc001</td>
<td>#1 PC multimedia package</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>portable001</td>
<td>Portable PC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>serialcable001</td>
<td>PC Serial Cable</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>testproduct</td>
<td>Cheap Test Product</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Check the boxes which you want to relate to the original product and then click on "Update Relations". Now click on "Back to Listing" and the "Related" button should now show with red text to indicate that it has related products configured.

Now when somebody adds the product to cart (the Professional scanner in the example above), products you have configured as related will be shown on the cart page.

**Configuring also bought products**

This handy feature will show products that were bought by previous customers in conjunction with the item(s) already added to the cart.

There is no configuration necessary for this feature as any products previously purchased by customers who also bought the item added to the cart will be shown on the cart page.

**Configuring best selling products**

These are simply the best selling items in your inventory.
There is no configuration necessary for this feature as the best selling products are dynamically pulled from the database and will be shown on the cart page.

**Tweaking the display (ASP Version)**

Now the features have been set, you will probably want to tweak how they show on your cart page. Open the files includes.asp and add the parameters below depending on the display you require...

- `csnobuyorcheckout=TRUE`  
  This will remove the buy and checkout buttons from the display

- `csnoshowdiscounts=TRUE`  
  This will remove the red discount text from the display

- `csnoproductoptions=TRUE`  
  This will remove the product options from the display

You can also tweak the CSS if you need to make changes that are specific to the layout here and not effect the main product page display. The easiest way to do this is with an inline style, which can be added just before the cart include line like this for example

```html
<style type="text/css">
  .prodname,.prodprice,.prodcurrency {
    text-align:center;
  }
</style>
<!--#include file="vsadmin/inc/inccart.asp"-->
```

This would center the product name, price and currency display even if on your main products page they were left aligned for example.

**Tweaking the display (PHP Version)**

Now the features have been set, you will probably want to tweak how they show on your cart page. Open the files includes.php and add the parameters below depending on the display you require...

- `$_csnobuyorcheckout=TRUE;`  
  This will remove the buy and checkout buttons from the display

- `$_csnoshowdiscounts=TRUE;`  
  This will remove the red discount text from the display

- `$_csnoproductoptions=TRUE;`  
  This will remove the product options from the display
You can also tweak the CSS if you need to make changes that are specific to the layout here and not effect the main product page display. The easiest way to do this is with an inline style, which can be added just before the cart include line like this for example

```php
<?php include "vsadmin/inc/inccart.php" ?>
```

This would center the product name, price and currency display even if on your main products page they were left aligned for example.
Product reviews and ratings

Product reviews are a great way of providing on-topic content, useful to both customers and search engines alike. As they are provided by visitors and reviewed by the store owner before publishing you can be guaranteed fresh and relevant copy for your store.

Version 5.5.0 saw the addition of product reviews and ratings to Ecommerce Templates and the set up details are outlined below.

To enable the review and rating feature you will need to add one line to vsadmin/includes.asp or vsadmin/includes.php depending on the version of the store you are running.

ASP Version: enablecustomerratings=TRUE
PHP Version: $enablecustomerratings=TRUE;

You can now visit any of your product detail pages and you should see something like this

Product Reviews
No Reviews For This Product.
Click to review this product

Clicking on the link will allow your customers to give the product a rating and a review

You are reviewing the product - Professional Scanner

* Rating: 10 star(s)
* Posted By: Andy
* Heading:

Comments:

Submit
All customer reviews are sent to the store control panel for approval before publication. This allows you to weed out any unwanted additions if you need to. Constructive criticism of a product may not be such a bad thing and glowing reports on everything on the store may appear quite contrived so it's good to achieve a balance.

<table>
<thead>
<tr>
<th>Product ID</th>
<th>Posted By</th>
<th>IP Address</th>
<th>Date Added</th>
<th>Heading</th>
<th>Approve</th>
<th>View</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>fscanner001</td>
<td>Andy</td>
<td>99.999.999.999</td>
<td>2008-02-12</td>
<td>Great Product</td>
<td>Approve</td>
<td>View</td>
<td>Delete</td>
</tr>
</tbody>
</table>

New reviews will appear in red in your ratings admin page, and this is where you can view, approve or delete the review. On approval the review will be sent to your product detail page.

You can specify the number of product reviews you want to appear on the product detail page with the a one line addition to vsadmin/includes.asp or vsadmin/includes.php

ASP Version: numcustomerratings=2
PHP Version: $numcustomerratings=2;

Clicking on the "Show All" link will take you to the main product review page.
The customer can sort the reviews by rating or date submitted. You can specify the number of reviews you want per page on the main ratings listing with this line in vsadmin/includes.asp or vsadmin/includes.php

ASP Version: allreviewspagesize=30
PHP Version: $allreviewspagesize = 30;

You can restrict the product review feature to logged in customers only. All users will be able to see the reviews and ratings but only those who are logged into your site will be allowed to submit a review or rating. To activate this feature you will need to add a line to vsadmin/includes.asp or vsadmin/includes.php

ASP Version: onlyclientratings=TRUE
PHP Version: $onlyclientratings=TRUE;

**Product review tweaks**

**Limit reviews per day**

It is possible to limit the number of reviews allowed in a 24 hour period with this addition to vsadmin/includes.asp or vsadmin/includes.php

ASP Version: dailyratinglimit=10
PHP Version: $dailyratinglimit=10;

**Change the ratings graphics**
The default graphics are shown in the screenshot above but we have some extra sets of graphics on our free downloads page that you can upload to your main images folder.

You can make your own graphics. You will need three and they should be called reviewcart.gif, reviewcarthg and reviewcartg.gif for the full image, half image and dimmed image.

**Change the separator between reviews**

If you want to use a cross browser horizontal line color between the product reviews then add this to your .css file

```css
hr.review {
    height: 0;
    border-width: 1px 0 0 0;
    border-style: dashed;
    border-color: #006AC8;
}
```

This will give you a blue dashed line.

---

**Gift Registry and Wish Lists**

The wish list and gift registry feature was introduced in Version 5.8. It will allow customers to create their own list of items in their account which can be purchased at a later date. It also allows for the creation of lists which can be sent to friends and family for occasions such as birthdays, weddings etc. so they can purchase the items which the list owner has requested.

The set up for the wish list program is really simple. It does require the use of the customer login feature so if you are not currently using that, it will need to be enabled.

Once you have the customer login set up, you will need to enable the wish list feature. This is done with the following entry in vsadmin/includes.asp

```plaintext``enablewishlists=TRUE``
```

or in vsadmin/includes.php

```plaintext``$enablewishlists=TRUE;``
```

Once you have logged in, you should see the following screen where you can manage all the details of you account, including the new gift registry feature.
Clicking on the link to "Create gift registry" will take you to the relevant section in the client login page where you can view and manage your wish lists.

This is where your wish lists will be shown along with the number of items in each list and the URL that can be sent to friends so they can purchase from your list.

Items can added to list from the products and / or product detail pages. A link will be added below the buy button which will give a drop down menu of the lists available.

If you want the "Add to List" link on both the product and product detail pages, add the following to vsadmin/includes.asp

```plaintext
wishlistonproducts=TRUE
```
or vsadmin/includes.php

$wishlistonproducts=TRUE;

If you only want the "Add to List" link on the product detail pages, add the following to vsadmin/includes.asp

wishlistondetail=TRUE

or vsadmin/includes.php

$wishlistondetail=TRUE;

**My Wish List vs Gift Registry**

As you can see from the screen shot above, you have the choice to add an item to a gift registry (in this example one we set up called Andy's birthday list) or to My Wish List.

My Wish List is your own personal list that you can add items to for purchasing at a later date. It's not a public list and can only be viewed once you are logged into the store. You can move items between lists, move them to cart or delete them.

You can have as many Gift Registries as you need and one personal list under "My Wish List".

**Editing the look**
As with all the Ecommerce Templates features, text changes can be made in vsadmin/inc/languagefile.asp or .php. The list uses the same css classes as the shopping cart, search etc and the classes are available here. There are also some extra classes available

span.cartloginname - the name of the person logged in
p.cartloggedin - the text for "Logged in as" and "Logout"
span.cartwishlists - the text for "View Gift Registries" on the cart page

**Recently Viewed Items**

The Recently Viewed feature was introduced in Version 5.8. It will show customers the items they have viewed on your store with a link to that product and a note of the category it belongs to. Items should remain in the list for three days, making it a powerful tool for return visitors.

To enable the feature you will need to add the following to vsadmin/includes.asp recentlyviewed=TRUE or vsadmin/includes.php

```
$recentlyviewed=TRUE;
```

On the ASP page where you want the box to appear, copy and paste the following

```
<!--#include file="vsadmin/inc/increcentview.asp"-->
```

For the PHP version

```
<?php include "vsadmin/inc/increcentview.php" ?>
```

Make sure the line comes somewhere after the other ASP or PHP include lines. Also note that the box won’t appear until you have visted more than one product detail page.
How to add a search box to each of your pages

As well as the all signing, all dancing search page, you may want to have just a little search box in the left or right navigation column, or at the top of every page for instance. You can do this by copying and pasting the following code.

```html
<form method="post" action="search.asp">
    <input type="hidden" name="posted" value="1"/>
    <input type="text" name="stext" size="16"/>
    <input type="submit" name="Search"/>
</form>
```

If you want to include your own graphic (search.gif) for the search button then change

```html
<input type="submit" name="Search"/>
```

to

```html
<input type="image" name="Submit" src="images/search.gif" border="0"/>
```

This is the most basic search, searching for "All Words" in all categories. But you could also use any of the parameters outlined in the tweak below as hidden fields to create a really powerful custom search or to search specific categories.

Minimum and Maximum Price Search

Version 4.8.4 saw the introduction of the minimum price parameter, which now means it is possible to search by price ranges, either by simple links or from a drop down menu. The code below uses the Dreamweaver Jump Menu - Dreamweaver > Forms > Jump menu but the code can be copied into other HTML editors.

Place this code before the closing </HEAD> tag

```html
<script language="JavaScript" type="text/JavaScript">
<!--
function MM_jumpMenu(targ,selObj,restore){ //v3.0
    eval(targ+'.location="'+selObj.options[selObj.selectedIndex].value+'"');
    if (restore) selObj.selectedIndex=0;
}
//-->
</script>
```

Place this where you want the drop down menu to appear:

```html
<form name="form1">
```

© Ecommerce Templates

Page 203 of 236
That will give a drop down menu with the options of searching ranges of

Under 10
10 - 100
100 - 200

Change search.php to search.asp for the ASP version.

If you want to set up a simple link then to search products priced between 100 and 200 you would need something like this:

```html
<a href="search.php?pg=1&sminprice=101&sprice=200&nobox=true">100 - 200</a>
```
Advanced parameters (ASP version)

In the folder vsadmin there's a file called includes.asp - this is where you can specify some important options regarding mail, shipping, tax, and the display options for your product pages. A full list of parameters is available at http://www.ecommercetemplates.com/help/ecommplus/parameters.asp

Advanced parameters (PHP version)

In the folder vsadmin there's a file called includes.php - this is where you can specify some important options regarding mail, shipping, tax, and the display options for your product pages. A full list of parameters is available at http://www.ecommercetemplates.com/phphelp/ecommplus/parameters.asp
Chapter 8
F.A.Q and Troubleshooting

General F.A.Q.
ASP Plus version for Windows
PHP Plus version for Unix/Linux
Dreamweaver issues
Frontpage issues
GoLive issues
Final checklist
General F.A.Q.

How do I add links to individual products and categories?
Once you have your products and categories added through the online admin section, browse your store and copy the URL of the product/category page from your address bar and paste it into the link box you have in your HTML editor. This should look something like this /proddetail.asp?prod=ref001 or /categories.asp?cat=1

I need to change hosts - any recommendations?
We don't do hosting ourselves but you can find a number of recommendations here on our hosting page http://www.ecommercetemplates.com/hosting.asp.

Where can I get the updaters?
The updates are available from http://www.ecommercetemplates.com/updaters.asp. Free for the first 6 months and $29.95 for a further 6 months, please email us if you have a change of address.

Can I resell your shopping cart software?
For the time being, the only avenue is through our affiliates program or reseller program, which will give you a 20% return on each purchase made through your affiliate link.

How do I edit the default text on my store?
All the default language generated by the store can be edited in the file /vsadmin/inc/languagefile.asp/php - the most recent additions are always
added to the top for people who have already made changes and are updating their store version.

**I add a product to my cart but it shows as empty, why's that?**

There are 2 known reasons for this happening:

Your cart page is in a frameset -> Remove the page from frames.
You don't have cookies enabled in your browser -> In Internet Explorer go to Tools > Internet Options > Privacy
If that doesn't solve your problem, please post on our support forum.

**What is the function of the "Authorize" button in my orders admin page?**

You'll see this button if someone has gone through checkout but hasn't made it back to your store, this may be because they're just playing around with the cart, have decided at the last moment not to purchase or there was a glitch on the Processor's site. Only hit the authorize button after you've checked with your Payment Provider and are sure the payment has been made correctly. You can set the amount of time that unauthorized orders appear on your store in the admin section.

**Why don’t all my categories show up after I've added them through the online admin?**

This is probably because you haven't added any products to the categories - once you associate a product with a category, they should show up.

**Why can't I see the product images on my store? I just get a red “x”.**

The default folder for the product images is called prodimages and the graphics should be uploaded there and the path set in your product admin page. If you see a red “x” in place of the graphic, make sure the file name is spelled correctly, that it is lowercase with no spaces in the name and has the correct .jpg or .gif extension.

**How can I download my complete product inventory?**

You will need to be using the Stock Management program. This can be switched on in your main admin setting page. Then go into the main products admin page and click on the “Dump Inventory” button. This will download your inventory to a .csv file, which can be opened in Excel. From Version 5.0.0 you can download the product inventory without having Stock Management selected.
How can I match the fonts used on the graphics in my template?

All the font information is included in the file instructions.txt that accompanies the download. The fonts are just used as a suggestion so if you don't have a particular font installed you can use a different one or perform a search on Google to see if it is available.
ASP Plus version for Windows servers

I'm not receiving email confirmation of orders - what's up?
Why do my orders disappear in the orders admin page?
How do I make my database secure and non-downloadable?
Why does the log-in page reappear every time when trying to access the admin section?
I've forgotten / lost my admin password - how can I retrieve it?

I'm not receiving email confirmation of orders - what's up?

From version 3.6.6 and upwards the system for choosing the email object (the component your ASP Ecommerce Plus template uses to send email) has become a lot more powerful. Most people won't require the information here and emails will be sent automatically. However if you are having problems, this is what you need to do.

Firstly, log in to your admin section and go to the Admin Main page. The email address you set in the "Email address:" section is very important. It has to be an address on the same domain as your website as this is a security feature for most hosts to avoid SPAM. For instance if your website is www.yourwebsite.com then an email address on that domain would be say info@yourwebsite.com.

You should see a section "Email Object". In the drop down list you will see a list of the available email objects that are installed on your server. If you don't see any available email objects in the list, then you need to ask your host if they can install an email object for sending email from an ASP page like for instance CDONTS CDO ASP Email (PERSITS) ASP Mail (ServerObjects) JMail (Dimac) Some of these are free, so there shouldn't really be a problem. From version 4.0.1 SMTPMail (SoftArtisans) is also supported.

Ok, so now you can choose an email object in your admin main page. The best one to try first is CDONTS, as it doesn't require any further configuration. Set the email object to CDONTS and then press submit at the bottom of the admin main page, and try an "email friend" to yourself. If you receive the email you are all set.
If you still can't get email to work, please ask your host if they have a test script for sending email from an ASP page. Once you have tried the test script using one of the email objects that we support (listed above), send us an email with your FTP login details and URL of the test script and we will have a look at why emails are not working from your Ecommerce Plus template.

One other important note. You need a properly configured mailserver to send emails from an ASP page. For this reason, don't worry about emails if you are testing on your local machine. It will come together when you publish to your host.

**Why do my orders disappear in the orders admin page?**
If a payment is not authorized then it will be automatically deleted after the time you specify in your admin main page.

**How do I make my database secure and non-downloadable?**

**SECURITY TIP**
The best place for your database is outside the web root. Most hosts provide a special folder for this with the database permissions already set. Using a folder outside the web root will make it difficult for anyone to download your database and gain access to your username and password. Otherwise you must set the permissions on your database folder so that your database cannot be downloaded. More information is available [here](#).

**SECURITY TIP**
Rename your database from vsproducts.mdb to a name of your choice, (keeping the .mdb extension of course).
Examples would be (though don't use ours)
yourstore591.mdb or database2221.mdb
This will make it harder for anyone to find your database if your database folder permissions are set incorrectly.

**Why does the log-in page reappear every time when trying to access the admin section?**
The usual reason is that your store is hosted on a Unix / Linux server and the host is using something like chilisoft.asp which doesn't support an Access
database. We do have Plus versions available for Unix / Linux servers so please contact us if this is the case.

I've forgotten / lost my admin password - how can I retrieve it?

If you've forgotten the password to your admin section, then the easiest thing to do is to download your database and have a quick look in the admin table in Access.
PHP Plus version for Unix / Linux servers

I'm not receiving email confirmation of orders - what's up?
Why do my orders disappear in the orders admin page?
Why can't I run the createdb.php file?
I've forgotten / lost my admin password - how can I retrieve it?

I'm not receiving email confirmation of orders - what's up?
Make sure that the email address in the admin main page is a valid email address on the server. Sometimes emails cannot be sent to an address outside of the domain if the "From" address is not on the domain and valid.

- Hosts that support non-standard email headers

You can set the parameter $customheaders in your vsadmin/includes.php file for hosts that require non-standard email headers. Instances of "%from%" will be replaced by the "From:" address and instances of "%to%" (not normally needed) will be replaced by the "To:" address. For example . . .

```
$customheaders = "MIME-Version: 1.0\nFrom: %from%\nContent-type: text/plain; charset=iso-8859-1\n"
```

or for HTML emails

```
$customheaders = "MIME-Version: 1.0\nFrom: %from%\nContent-type: text/html; charset=iso-8859-1\n"
```

Why do my orders disappear in the orders admin page?
If a payment is not authorized then it will be automatically deleted after the time you specify in your admin main page.

Why can't I run the createdb.php file?
This usually happens when either the database connection hasn't been set correctly in vsadmin/db_open_conn.php or if that has been done then check with your host that your server is running a minimum of PHP4.1.
I've forgotten / lost my admin password - how can I retrieve it?

If you have phpMyAdmin or something like that installed you can check in the admin table. If you don't have that, or don't know how to use it, try creating a new file called t.php and add the following to it:

```php
<?php
    include "vsadmin/db_conn_open.php";
    $sSQL = "SELECT adminUser,adminPassword FROM admin WHERE adminID=1";
    $result = mysql_query($sSQL) or print(mysql_error());
    $rs = mysql_fetch_assoc($result);
    print "The username is : " . $rs["adminUser"] . "<BR>";
    print "The password is : " . $rs["adminPassword"];
    mysql_free_result($result);
?>
```

Then, upload this to your web, and put it in the root directory of the store, then open in your browser. The most important thing to do is to remember to delete the file from your web after using it, as otherwise anyone can get your password.
Dreamweaver F.A.Q.

**Why do my images not show up when I preview my page locally?**
Why can I see the site correctly on my PC but on a friend’s there are no images?
How do I define my site?

**Why do my images not show up when I preview my page locally?**
It could be that you have your image paths set to "Relative to Root" - this probably wouldn't be a problem on your server, but locally it'll more than likely stop the images from showing and the paths not working. A path which is relative to the root would look like this /images/mygif.gif - if it's relative to the document it would be in the form of ../images/mygif.gif - you can choose the form you want by selecting from the drop down in the window that appears when you add an image.

**Why can I see the site correctly on my PC but on a friend’s there are no images?**
This is probably because the path to your image files is pointing to your hard drive rather than the images on your server, the most likely cause is that the site hasn't been defined...(see below)

**How do I define my site?**
Open Dreamweaver, and go to Site>New Site. Give your site a name and then browse to where you extracted the template to. If you want to upload your files via Dreamweaver then you'll need to add the FTP information that was given to you by your host.
Frontpage F.A.Q.

Why can't I add pages in Navigation View?

Why are parts of the pages missing, like the navigation and news sections?

How do I change the wording of "home" on the nav bar?

Why is all the formatting missing when I upload my site?

How do I make a back-up of my site?

How do I stop Frontpage overwriting my database and database connection files?

Why can't I add pages in Navigation View?

First of all remember that the PHP version doesn't use Frontpage navigation and that some templates rely solely on include files rather than a Frontpage theme. For the ASP version, for some reason you can't add child pages below a .asp page but you can get round this Frontpage quirk by renaming the page with a .html termination, dragging in the new page to Navigation View and then name the parent page with the .asp extension again.

Why are parts of the pages missing, like the navigation and news sections?

This is probably because you have the PHP version and unfortunately PHP and Frontpage don't mix too well, but we have found a way around this.

The first thing is to get the page open in Frontpage :-

In Frontpage go to Tools>Options>Configure Editors

Choose "Add"

Put PHP for file type

Put the same information as you have for htm, html etc. - this is usually Editor Name: FrontPage

Command: frontpg.exe

Save

Now you can get the pages open you'll see that the include files are "missing" - this is because they are PHP includes not Frontpage includes but you can work on them directly from the files in the includes folder - to view your changes locally you can download this utility http://www.totalpconline.com/phprocketaddin/?page=orders.html or work live on the server and on saving your page you can check it in your browser.

There's more information in the first chapter as well as in our PHP help section.
How do I change the wording of "home" on the nav bar?
In Frontpage go to Tools > Web Settings > Navigation and change the wording there.

Why is all the formatting missing when I upload my site?
This usually happens when for some reason the theme gets detached from the site. Connect live to your site through Frontpage and go to Theme in the top menu and go through the themes until you find the one that matches the name of your template. If that doesn’t work, try Tools > Recalculate Hyperlinks

How do I make a back-up of my site?
Open your site live on the server by going to File>New>Web from the top Frontpage menu and typing in the URL of your site, and then giving your name and password. Your site will now open up on the server so you can publish back to your hard drive by hitting the publish icon and choosing a back-up location on your hard drive

How do I stop Frontpage overwriting my database and database connection files?
The simplest method is to take them out of your Frontpage web on your computer and save them somewhere else on your hard drive. Alternatively you can right click on the file and Select Properties > Workgroup and select "Exclude this file when publishing the rest of the web".
GoLive F.A.Q.

Why do I get a little green bug icon in my site file list?

Why do I get a little green bug icon in my site file list?
This means there is an error on the page - usually an incorrect path - if it's showing on all pages it's probably located in one of the components. You may find that some files in the vsadmin folder show a green bug and due to the include structure, these can be safely ignored.

Final checklist

Once you have your store ready and think it's time to unleash it to the world, it may be a good idea to go through our checklist to make sure everything is as it should be.

General Issues

• Make sure that each page of your site has unique TITLE and META DESCRIPTION tags.
• Check your site on a different computer, preferably in Internet Explorer and Firefox. Pay particular attention to any broken links, screen resolution problems or slow loading pages.
• Ask a friend or colleague to browse your store and make a purchase.
• Make sure that you have carried out demo transactions for your payment provider and that emails are received as well as that orders show correctly in the order admin page of the control panel.
• Be sure that all your graphics are optimized and contain ALT information.
• Include a site map, linked from all your pages with text links to the most important pages on the store.
• Include your main keywords in a natural way on your home page blurb.
• Make sure you have changed the default password and user name for the control panel.
• Ask for a site critique.

ASP Version

• Make sure your database is not downloadable. You can test this yourself by typing in the address eg www.yourstore.com/fpdb/vsproducts.mdb. If you receive an option to download the .mdb file then it may mean that people can access your database. Please check with your host if you have any doubts at all.
Most hosts will provide you with a directory below the root of your web with the correct permissions already set.

**PHP Version**

- Be sure that each of the cart related pages at the very top in HTML view and before the opening HTML tag there is a little bit of code that goes like this . . .
  ```php
  <?php
  session_cache_limiter('none');
  session_start(); ?></html>
  ```

  This needs to be on each of the cart related PHP pages like cart.php, search.php, products.php, categories.php and so on.

- Don't have spaces in your file names so use a pattern like my-page.php rather than my page.php - remember they are also case sensitive.
Chapter 9
Search Engine Optimization

Introduction
Creating dynamic title and meta tags
Creating static URLs
ALT information
Optimizing your store for the search engines
Search engine information
Introduction

We believe we have most angles covered when it comes to offering search engine friendly shopping cart software. Ecommerce templates offers the ability to use static pages which are easy to spider by visiting search engines as well as unique titles and meta tags for category, product and product detail pages and ALT information for all the product images. We have also outlined some general information on optimizing your pages for search engines as well as an overview of the main players.
Dynamic title and meta description tags

From version 4.1.1 it is possible to dynamically generate the title and meta description tags for your categories, product and product detail pages. Not only are they dynamically generated but you can also add your own unique information such as company name to the title tag. The set up details are outlined below:

**ASP Version**

The pages you are going to want to change are...
categories.asp
products.asp
proddetail.asp

Open each of these in turn and go to HTML view. About halfway down the page you should see a bunch of "include" files, something like this...

```html
<!--#include file="vsadmin/db_conn_open.asp"-->
<!--#include file="vsadmin/inc/languagefile.asp"-->
<!--#include file="vsadmin/includes.asp"-->
<!--#include file="vsadmin/inc/incfunctions.asp"-->
<!--#include file="vsadmin/inc/incproducts.asp"-->
```

If your template uses a DHTML pop-out menu or Mini Cart there is no need to delete the line
```
<!--#include file="vsadmin/db_conn_open.asp"-->
```
Just open vsadmin/db_conn_open.asp in Notepad and make sure you don't have a line

```
DIM sDSN
```

If you have that, just delete that line.

You can then follow the instructions below as normal.

Then, at the very top of the file before the first `<html>` tag add that `db_conn_open` line along with the `metainfo.asp` include line like this...

```html
<!--#include file="vsadmin/db_conn_open.asp"-->
<!--#include file="vsadmin/inc/metainfo.asp"-->
<html>
```
Now repeat this with each of the 3 files categories.asp, products.asp and proddetail.asp

Now, on your categories.asp AND the products.asp pages you can change the page title tag to something like this...

<title>Bob's widget store: <% if toppsection<>"" then response.write toppsection & ", " response.write sectionname%></title>

Also on the categories page, if you use a category description you might want to set the meta description tag to this...

<META NAME="Description" CONTENT="<%=Replace(sectiondescription,"","&quot;")%>">

The information available to the proddetail.asp page is slightly different. On that page you can change your page title to...

<title>Bob's widget store: <%= productname & ", " & sectionname & ", " & productid %></title>

You might not want to include the product ID, in which case you can use...

<title>Bob's widget store: <%= productname & ", " & sectionname %></title>

For the meta description on the proddetail.asp page you can use...

<META NAME="Description" CONTENT="<%=Replace(productdescription,"","&quot;")%>">

### Multiple language set up

If you are using the multiple language set up then you will need these include lines before the <html> tag:

<!--#include file="vsadmin/db_conn_open.asp"-->
<!--#include file="vsadmin/inc/languagefile.asp"-->
<!--#include file="vsadmin/includes.asp"-->
<!--#include file="vsadmin/inc/incfunctions.asp"-->
<!--#include file="vsadmin/inc/metainfo.asp"-->

...making sure they are not duplicated later in the code.
PHP Version

The pages you are going to want to change are...

categories.php
products.php
proddetail.php

Open each of these in turn and go to HTML view. About halfway down the page you should see a bunch of "include" files, something like this...

```php
<?php include "vsadmin/db_conn_open.php" ?>
<?php include "vsadmin/inc/languagefile.php" ?>
<?php include "vsadmin/includes.php" ?>
<?php include "vsadmin/inc/incfunctions.php" ?>
<?php include "vsadmin/inc/incproducts.php" ?>
```

You will want to delete the first one, the db_conn_open.php line.

If your template uses a DHTML pop-out menu or Mini Cart there is no need to delete the line
```
<?php include "vsadmin/db_conn_open.php" ?>
```

You can now follow the instructions below as normal

Then, at the very top of the file before the first `<html>` tag you should already have a couple of lines of code. Now add the db_conn_open line along with the metainfo.php include line like this...

```php
<?php
session_cache_limiter('none');
session_start();
include "vsadmin/db_conn_open.php";
include "vsadmin/inc/metainfo.php";?><html>
```

Now repeat this with each of the 3 files categories.php, products.php and proddetail.php

Now, on your categories.php AND the products.php pages you can change the page title tag to something like this...

```php
<title>Bob's widget store: <?php if($topsection != "") print $topsection . ", ";
print $sectionname??></title>
```
Also on the categories page, if you use a category description you might want to set the meta description tag to this...

```php
<META NAME="Description" CONTENT="<?php print str_replace('', '&quot;', $sectiondescription)?>">
```

The information available to the proddetail.php page is slightly different. On that page you can change your page title to...

```php
```

You might not want to include the product ID, in which case you can use...

```php
```

For the meta description on the proddetail.php page you can use...

```php
<META NAME="Description" CONTENT="<?php print str_replace('', '&quot;', $productdescription)?>">
```

**Multiple language set up**

If you are using the multiple language set up then you will need these include lines before the `<html>` tag:

```php
<?php include "vsadmin/db_conn_open.php" ?>
<?php include "vsadmin/inc/languagefile.php" ?>
<?php include "vsadmin/includes.php" ?>
<?php include "vsadmin/inc/incfunctions.php" ?>
<?php include "vsadmin/inc/metainfo.php" ?>
```

...making sure they are not duplicated later in the code.
Converting dynamic to static URLs

The default URL for a products page would be something like www.yoursite.com/products.asp?id=2 but it is possible to change this to something even more search engine friendly like www.yoursite.com/productname.asp. You can also do the same for the category pages and the product detail, the information is outlined below.

**ASP version**

Make a copy of products.asp and call it say bobswidgets.asp
Now, open this page in notepad or your web editor and go to HTML view.
Now, you should see a set of include files like this:

```html
<!--#include file="vsadmin/db_conn_open.asp"-->
<!--#include file="vsadmin/inc/languagefile.asp"-->
<!--#include file="vsadmin/includes.asp"-->
<!--#include file="vsadmin/inc/incfunctions.asp"-->
<!--#include file="vsadmin/inc/incproducts.asp"-->
```

Now just add the variable to specify the category before the incproducts include like this for ASP

```html
<% explicitid=2 %>
<!--#include file="vsadmin/inc/incproducts.asp"-->
```

If your template uses a DHTML pop-out menu or Mini Cart then you will only find one of the ASP includes in the main body of your site. The explicitid will still need to precede the include line eg.

```html
<% explicitid=8 %>
<!--#include file="vsadmin/inc/incproducts.asp"-->
```

You can now do the same for categories.asp and proddetail.asp by adding the explicitid before:
As the explicit id for a product detail page is a product reference, you have to enclose this in quotes like this:
explicitid="yourprodref"

You can get the variable you need by browsing your site and checking the particular page URL. For example if your URL for a widget looks like this:

www.yoursite.com/products.asp?id=14

...then you would want to set

<%
explicitid=14
%>

If you don't want to change all your pages to static URLs then the URL can be in the form of http://www.yoursite.com/products.asp?cat=14 due to the fact that Google may not give as much weight to links which contain this generic "id" parameter.

In version 4.8.4 we added the possibility to define the static URL in the categories admin page after following the instructions above. This is an optional feature and if you want to use it just place the name of the static page you have created.

This now means that your menu system won’t pick up on the dynamic URLs as the store is browsed. It also works with the DHTML menu and avoids duplicate URLs / content on the store.

In version 4.9.6 we added linked product detail static pages where there is now an option in the product admin page "Has static page" which if checked will cause the product detail page link to take the form. . .
the_product_name.asp

. . . where the page name will be made of the product name, in lower case with spaces replaced by underscores and non alphanumeric characters removed. It will be your responsibility to create the static detail page of that name using the method above.
In version 5.1 we added the ability to change the underscore to the character of your choice so if you prefer the layout of the-product-name.asp then you will need to add this to includes.asp

urlfillerchar="-"

**PHP version**

Make a copy of products.php and call it say bobswidgets.php

Now, open this page in notepad or your web editor and go to HTML view. Now, you should see a set of include files like this:

```php
<?php include "vsadmin/db_conn_open.php" ?>
<?php include "vsadmin/inc/languagefile.php" ?>
<?php include "vsadmin/includes.php" ?>
<?php include "vsadmin/inc/incfunctions.php" ?>
<?php include "vsadmin/inc/incproducts.php"?>
```

Now just add the variable to specify the category before the incproducts include like this for PHP

```php
<?php include "vsadmin/db_conn_open.php" ?>
<?php include "vsadmin/inc/languagefile.php" ?>
<?php include "vsadmin/includes.php" ?>
<?php include "vsadmin/inc/incfunctions.php" ?>
<?php
$explicitid=2;
?>
<?php include "vsadmin/inc/incproducts.php"?>
```

If your template uses a DHTML pop-out menu or Mini Cart then you will only find one of the PHP includes in the main body of your site. The explicitid will still need to precede the include line eg.

```php
<?php
$explicitid=8;
?>
<?php include "vsadmin/inc/incproducts.php"?>
```

You can now do the same for categories.php and proddetail.php by adding the explicitid before:

```php
<?php include "vsadmin/inc/inccategories.php"?>
```

and

```php
<?php include "vsadmin/inc/incproddetail.php"?>
```
As the explicit id for a product detail page is a product reference, you have to enclose this in quotes like this:
$explicitid="yourprodref";

You can get the variable you need by browsing your site and checking the particular page URL. For example if your URL for a widget looks like this:

www.yoursite.com/products.php?id=14

...then you would want to set

```php
$explicitid=14;
?>
```

If you don't want to change all your pages to static URLs then the URL can be in the form of http://www.yoursite.com/products.php?cat=14 due to the fact that Google may not give as much weight to links which contain this generic "id" parameter.

In version 4.8.4 we added the possibility to define the static URL in the categories admin page after following the instructions above. This is an optional feature and if you want to use it just place the name of the static page you have created.

<table>
<thead>
<tr>
<th>Category URL (Optional)</th>
</tr>
</thead>
<tbody>
<tr>
<td>category.asp</td>
</tr>
</tbody>
</table>

This now means that your menu system won't pick up on the dynamic URLs as the store is browsed. It also works with the DHTML menu and avoids duplicate URLs / content on the store.

In version 4.9.6 we added linked product detail static pages where there is now an option in the product admin page "Has static page" which if checked will cause the product detail page link to take the form. . .

```
the_product_name.php
```

. . . where the page name will be made of the product name, in lower case with spaces replaced by underscores and non alphanumeric characters removed. It will be your responsibility to create the static detail page of that name using the method above.

In version 5.1 we added the ability to change the underscore to the character of you choice so if you prefer the layout of the-product-name.php then you will need to add this to includes.php

```
$urlfillerchar='-';
```
ALT Information

By default all the product pictures and product detail pictures will have the ALT information dynamically generated by the value you have added for the product name. So if your product name is "Blue Widget" then when your mouse passes over the picture the name "Blue Widget" will appear.

Category identifiers

In Version 5.7.0 it is possible to change the category identifier from a number to text, for example from products.asp?cat=29 to products.asp?cat=Laser+Printers

To add this feature you will need the following in vsadmin/includes.asp
usecategoryname=TRUE

or in vsadmin/includes.php for the PHP version
$usecategoryname=TRUE;

If you are using the dynamic title and meta tags feature you will need to make sure that the includes.asp / includes.php line comes before the metainfo.asp / metainfo.php line at the top of the code, like this

ASP Version
<!--#include file="vsadmin/db_conn_open.asp"-->
<!--#include file="vsadmin/includes.asp"-->
<!--#include file="vsadmin/inc/metainfo.asp"-->

PHP Version
<?php
session_cache_limiter('none');
session_start();
ob_start();
include "vsadmin/db_conn_open.php";
include "vsadmin/includes.php";
include "vsadmin/inc/metainfo.php";?><html>

...and then make sure you have removed the includes line from further down the code.
Optimizing your store

Once you’ve got your store set up the next step is getting people to find it. Preparing your site for search engines and directories is worth the time and effort and pretty simple to do with the templates. We’ve prepared a very brief introduction and guide below that is worth following.

Title tag

If you look at your HTML code, you'll find something like this near the top of your page <TITLE>Untitled document</TITLE>. It's crucial to have a good title, around 10 words that clearly explain what the page / site is about and including words and phrases you think people will search on, so if you're selling widgets for example you might have something like this

<TITLE>Online sales of professional manual and mechanical widgets. My Company</TITLE>

It's a good idea to use different titles for different section/pages of your site, so on a help page you might have:

<TITLE>How to install mechanical widgets</TITLE>

Meta tags

Far less important than the <TITLE> tag but still useful for some search engines. The description tag is particularly handy for controlling how your link will appear. Here you want to use 12 to 15 words that describe the content of your page, preferably using the same collection of words and phrases that can be found in your main body of text. This again could and should change from page to page depending on content. For example:

<META NAME="description" content="Quality widgets and fidgets for sale. Buy online at low prices at My Store">

The other main meta tag is the keywords. It seems their usefulness has all but disappeared but they won't harm your site so it's best to include a few. Choose words and phrases that people will search on, are relevant to your site and appear in your main body of text. For example:

<META NAME="keywords" content="widgets,mechanical widgets,manual widgets, widget sales">

So with this information the top of your code should look something like this:

<html>
<head>
Many of the major search engines will pick up the text from your site and use it, amongst other factors, as a test of relevancy for the search. So having keyword rich text is extremely important for giving the search engine something to pick up on. You shouldn't go overboard here but certainly having your keywords near the top of the page is going to be an advantage. Don't try fooling the search engines by hiding text, or listing your keywords 50 times to improve ranking.

Be careful of using manufacturer supplied product information as your page content should not be identical to others on the web selling the same product line. This can lead to duplicate content issues and lack of ranking. Be sure your content is unique!

Each graphic on your site should have accompanying alt information - that's the text in a box you see when you pass your cursor over a graphic. Apart from aiding the disabled viewers, you can also help with your search engine optimization by using concise keyword rich descriptions. For example:

```
<img border="0" src="images/manual_widget.gif" width="140" height="113" alt="Manual Widget">
```

Help a search engine index your site, and a person navigate, by having a clear navigation structure, text link alternatives to javascript and Flash, and a text based site map.

It appears that particularly for Google, the importance of quality links to your site will improve your ranking. You may want to spend some time asking to have links placed on related sites, preferably text and with your keyword(s) incorporated. You can start off by adding your store to our directory [here](#). Beware of "link farms" however. If you want to find out what a quality link would be in the eyes of Google, download their toolbar [here](#) and check the page rank - anything above 5 is good.
Also consider how you are going to treat deleted products. Once you have deleted a product, the product detail page will be lost from your site but the URL still may be available in the search engines, causing people to find broken links and go elsewhere. One solution would be to set up Custom 404 pages (your host can help with that), another would be to mark the product as out of stock rather than completely deleting it from your store.

Other considerations

A good domain name can help so you might want to look for something like manual-widgets.com or mechanicalwidgets.com. Use your keywords in your page names where possible and without going over the top eg.
widgethelp.htm
Search engine information

It's getting more and more difficult to keep up with how search engines work and interact, we've outlined below the information in a brief guide to what we believe to be correct and will be updating the details as and when we find things have changed.

Google

Google is undoubtedly the top dog of search engines and a decent listing here is without doubt, at the time of writing, one of the keys to the success of a site. Listings in Google are free, although you can pay for AdWords to get immediate traffic. Google will usually take up to a month to get your site listed, and it appears the best way to do so is through the Google bot (spider) picking up on your link from another site, spidering (indexing) your site content and adding it to their database. The Google database is updated at irregular intervals, commonly known as the "Google Dance" as this is when the major shake up of the database occurs. You can add your URL to Google but as it's important to get links in it's advisable to add your site to dmoz.org and even our own store listing. We recommend avoiding link farms and be wary of companies guaranteeing instant search engine success.

Google appears to rate sites on a number of aspects, one of the important ones being the "quality" of in-bound links eg. a link from Microsoft.com being far more interesting than one from your neighbor (unless you live next to Bill Gates). Your importance in Google is measured as "page rank" - to find out the page rank of a site you'll need to download Google's tool bar. Here is a very general and unordered list of what Google is believed to look for on your page:

- Quality incoming links (preferably using your keywords in the text)
- Keywords in the title
- Keywords in the meta description
- Keywords in the main body of text
- Keywords in the ALT information
- Keywords in the URL
- Descriptive text links within the site
- Text in <H1> tags

It's important not to overdo things, avoid trying to trick Google, study high ranking competitor sites without ripping them off and above all have patience.

Google adwords

You can get into Google immediately through their adword program, rather than trying to explain it here, you're best getting the information from the horse's mouth. The great thing about adwords is that they will get your site advertised on Google immediately, you can also pay for keywords that your
site is not showing up on, but keep a close eye on what they are costing you and read the information on optimizing your ads.

Yahoo
There's some debate now on the worth of submitting to yahoo. At the time of writing the cost of inclusion is $299 - this should get you into the yahoo directory, and in turn a link for Google to pick up on - all in all, probably worth it for an ecommerce site but not as important as it was in the past.

To add your site to Yahoo, find the category that best suits your needs and click on the “Suggest a Site” link at the bottom of the page - make sure you read Yahoo's guidelines before submitting.

Yahoo search marketing
Yahoo is one of the major players in pay per click - like Google adwords it's a great way to target your audience and in the same vein it can work out expensive so it's important to do your research and check out the competition. With Yahoo you bid on the price of your keywords and a well targeted campaign can prove very successful - remember that a top three listing is beneficial.

Other search engines and directories
Here's a list of other places to submit your site, some are free and some are paid inclusions - it's also worth doing a search to find directories of sites that are industry related or regional, but again avoid using free for all link farms - you are likely to get more spam than trade, and may even be penalised by the major players.

All the web (free + paid)
Teoma / Ask Jeeves (paid)
Open Directory (free)
© Copyright Ecommerce Templates July 2010

This package must not be photocopied, reproduced, transmitted in any form or by any means without the prior written permission of the copyright owner. All requests for permission should be sent to Ecommerce Templates.